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The World Plugin Guide provides details about settings available through its configuration user 
interface within Viz Artist. 

Related Documents

• Viz Artist User Guide: Contains information on how to install Viz Engine and create graphics 
scenes in Viz Artist.

• Viz World Classic User Guide: Contains information on creating 2D maps and geographic 
animations.

• Viz World User Guide: Contains information on creating real-time 3D maps and using the 
client-server solution.

Note: This plug-in package is released separately from the Viz World Client. Some of the 
functionality of these plug-ins are still intended to be used with the Viz World Client.



http://documentation.vizrt.com/viz-artist
http://docs.vizrt.internal/viz-world
http://docs.vizrt.internal/viz-world
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1 Feedback And Suggestions
We encourage suggestions and feedback about our products and documentation. To give feedback 
and/or suggestions, please contact your local Vizrt customer support team at www.vizrt.com.

http://www.vizrt.com/
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2 Introduction
The World Plugin Guide provides details about settings available through its configuration user 
interface within Viz Artist. 

Related Documents
• Viz Artist User Guide: Contains information on how to install Viz Engine and create graphics 

scenes in Viz Artist.
• Viz World Classic User Guide: Contains information on creating 2D maps and geographic 

animations.
• Viz World User Guide: Contains information on creating real-time 3D maps and using the 

client-server solution.

2.1 Feedback And Suggestions
We encourage suggestions and feedback about our products and documentation. To give feedback 
and/or suggestions, please contact your local Vizrt customer support team at www.vizrt.com.

Note: This plug-in package is released separately from the Viz World Client. Some of the 
functionality of these plug-ins are still intended to be used with the Viz World Client.



http://documentation.vizrt.com/viz-artist
http://docs.vizrt.internal/viz-world
http://docs.vizrt.internal/viz-world
http://www.vizrt.com/
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3 Geometry Plug-Ins
This chapter describes geometry plug-ins. The geometry plug-ins are found in three plug-in 
folders:

• Maps: Contains standard plug-ins.
• Maps-Adv: Contains advanced plug-ins.
• Maps-Lab: Contains experimental plug-ins. Since these plug-ins are experimental and not 

supported, they are not documented here.
• Maps-Obs: Contains obsolete plug-ins, installed only for backward compatibility. These plug-

ins should not be used when designing new scenes. Since these plug-ins are obsolete and 
not supported, they are not documented here.

See the following sections for more information:

• 2D Label
• 3D Border Control
• 3D Border
• 3D Line Control
• 3D Line
• 3D Models
• 3D Region Control
• 3D Region
• 3D Roads
• Atlas
• C3D Terrain
• GeoChart
• GeoImage
• Globe
• Label and Go
• Pyramid Control
• MapScale
• Shadow Agent
• WindFlows

3.1 2D Label

The 2D Label plug-in creates two dimensional labels on the map, based on labels received from 
the selected map or automatically generated labels generated by the Label Manager according to 
the map information received from the Navigator plug-in. It must have a container with text 
content as a child to work properly.
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3.1.1 2D Label Properties

Label
The Label tab contains general geometric properties for label such as margins (geometry length or 
width around the bounding box of the text), outline width and colors.

• Margin Options

Note: When adding a 2D Label plug-in to a container, a World Position plug-in and an Alpha 
plug-in is added automatically to the same container. The Label Manager scene plug-in has 
to be added manually to the scene when using the 2D Label plug-in without a Navigator
plug-in.



Note: This plug-in is located in: Built Ins -> Geometry plug-ins -> Maps
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• Equal Spaced: Uses equal spacing for the side margins and top/bottom margins.
• Separate: Uses different margins for each side of the labels.

• Width Margins, Left/Right Margins: Sets the margin between the sides of the text and the 
label background edges.

• Height Margins, Top/Bottom Margins: Sets the margin between the top and bottom of the 
text and the label background edges.

• Outline Width: Sets the width of the label’s background outline.
• Label Color: Sets the color of the label’s background fill.
• Outline Color: Sets the color of the label’s background outline.

Bevel
The Bevel tab contains options dealing with rounding of corners.

• Bevel: Defines the bevel value of the label’s background corners.
• Roundness: Defines whether the background corners is rounded.
• Detail: Defines the quality of the label object (when a higher value is selected, more 

polygons are used to build the label object).
• Lock Aspect: Applies the bevel and roundness parameters to the corners of the label object 

equally when set to On. When set to Off, the bevel and roundness parameters are applied to 

the corners using the object’s height and width ratio.

Caption
The Caption tab defines the position of the label.

Note: The numeric values next to the color parameters are the alpha values of the 
label and the label outline.



Note: The color palette effects only the selected color parameter (label or outline), 
and it appears when one of the color parameter is selected (Viz 3).
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• Pivot: Defines the label’s object shape and location in relation to the label’s geographic 
location:

• Pointer: Includes a pointer going out of the label background in the label object and 
points at the label’s geographical position. When selected, additional parameters are 
enabled: Width and Connection Bevel.

• Outline: Gives the label object a rectangular shape and the outline of the shape is on 
the label’s geographical position.

• Center: Places the center of the label over the label’s geographical position.
• Offset: Places the label at the defined offset from the label’s geographical position.
• Position: Suggests a few possible locations to Auto Street Labels for the label 

(positions along the street) so that Label Manager can pick one of them.
• Width Type: Defines whether the (strap) width should change as the caption is moving away 

from the tip or stay fixed.
• Width: Defines the width of the pointer’s base overlapping the label background. This 

parameter is only enabled when Pointer is selected.
• Connection Bevel: Defines whether the area connecting between the pointer and the label 

background is to be rounded or sharp. This parameter is only enabled when Pointer is 
selected.

• Rotate Labels: Defines whether labels, created in Viz (3D labels), are rotated like the labels 
in World Map Editor or Map Editor Classic (WME). If set to Off, all labels display horizontally. 

If set to On, labels that were rotated in Map Editor are rotated in Viz.

Caption Source
The options Default Position, WME Directions and Label Manager Presets include the properties 
described below.

Default Position

Default Position is used when adding labels in WME when no direction is selected.

• Direction (deg): Sets the angle of the label in relation to its geographic position.
• Distance (cm): Sets the distance of the label from its geographical position.
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• WME Offsets Distance: Enables the WME to offset the distance (default On). When disabled 

(Off) only the direction offsets from WME is used and the distance ignored.

WME Compass Rose

This allows you to set and fine tune offsets for every direction available in WME. When selected, the 
labels are placed as they were placed on the map in the Map Editor. When manually set inside WME 
they always take priority over the presets and Default Position settings.

• Presets: Corresponds to the available directions inside the WME.
• Direction Offset (Degrees): Defines values for fine-tuning the position of the label.
• Distance (Viz units): Defines the distance offset for fine-tuning the position of the label.

Label Manger Presets

When this is selected, the Label Manager plug-in uses the defined presets to place the labels over 
the map. The Label Manager plug-in optimizes the label position such that the labels do not 
overlap.

• Number of Presets: Defines the number of label position presets available to the user (one to 
four presets).

• Current Preset: Selects the preset number to be configured, using the Direction and Distance 
parameters. Each preset should be selected and the label position should be adjusted.

• Direction (deg): Sets the angle of the label in relation to its geographic position.
• Distance (cm): Sets the distance of the label from its geographical position.

Special
The Special tab defines special options for the pointer.
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• Shape: Defines the pointer shape:
• None: Gives the pointer a sharp point shape.
• Circle: Gives the pointer a circle at the tip of the pointer.
• Square: Gives the pointer a circle at the tip of the pointer.
• Straight: Gives the pointer straight lines at the tip of the pointer.

• Size: Defines the size of the shape at the tip of the pointer. The parameter is only enabled if 
the pointer is selected and a tip shape is set.
Navigator Overlay: Defines how the label is displayed over the map. Available options are 
Disabled, Fixed, Scaling, Near Scale and Far Scale.

• Disabled: Places the label on the map using its geographical referencing.
• Fixed: Places the label by keeping its geographical referencing but using a different 

camera (either with dynamic image or with a front layer). The label size remains fixed.
• Scaling: Places the label by keeping its geographical referencing but using a different 

camera (either with dynamic image or with a front layer). The Label scales trying to 
imitate the camera movement.

• Near Scale: Defines the maximum size of the label on the screen (the final size of the 
label when zooming in).

• Far Scale: Defines the minimum size of the label on the screen (the final size of the 
label when zooming out).

Static Map Scale: Defines whether scaling of the label is performed over a static map (no 
Navigator plug-in used). When disabled (Off), no scaling is applied to the labels. When 

enabled (On), an additional parameter is enabled:

• Scale: Sets the scaling factor of the labels when used over a static map (no Navigator 
plug-in).

Collision Mode: Defines how the labels are placed when an overlap or collision between two 
labels occur.

• Tip Based: Allows the pointers of overlapping labels can cross or touch, but no overlap 
of label bodies are allowed.

• BBox Based: Calculates a bounding box around the entire label (label body and 
pointer). Overlap between a label’s bounding box is not allowed.

• Hide if Empty: Hides the container of the label if the Label text is empty.
• Enable Overlay: Renders label geometry on different camera.

Fade
The Fade tab defines the fade effect parameters to be used with the duplicated labels. Fade has 
two fade modes: Stand Alone and Controlled.
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• Stand Alone: Defines the label appearance manually with the additionally enabled 
parameters:

• Fade On Time: Defines a label fade effect, beginning at a relative point to the defined 
hop duration. An additional parameter is enabled, Time To Hop, defining when the 
fade occurs.

• Fade On Distance: Defines a label fade effect, beginning at a relative distance from the 
hop final location.

• Fade On Lat/Long: Defines a label fade effect, beginning at a Longitude and Latitude 
offset from the hop final location. An additional parameter is enabled, Lat/Long, 
defining the offset from in degrees.

• Controlled: Sets label appearance automatically with the 2D Label plug-in. It can also be 
based on the Label Manager plug-in settings and the Navigator plug-in animation (hops). 

• Step: Controls when the label fades in and out in relation to an animation. In general, 
the fade can be based on the camera distance (For example: Capitals are in view when 
distance is below 1000 kilometers) or on timing in relation to the hop:

• Auto: Fades in and out based on distance to hop when a label is of type point 
(added by the user). If the label is of type place/region it fades in and out based 
on the distance set in Label Manager plug-in. If the hop is not close enough for 
the label to show and the label was added by the user, it fades in based on hop 
timing and not distance.

• On Hop: Links the fade to the hop timing.
• Point 1/Point 2: These are reserved for labels where the distance is configured 

by the Label Manager plug-in.
• Hop and Above: Turns on at the hop and stays on thereafter.

• Selected Label Timing: Sets the time in relation to the hop time if the label’s fading is 
based on hop timing. It is disabled if Step is set to Point 1 or Point 2. Since the label 
appearance is automatically calculated, this timing offset is used in the calculation. 
Select one of the options:

• • At End: Places labels at the end of the animation.

Note: The Fade On Distance parameter is only enabled if Navigator Overlay is 
set to Scaling. See the plug-in section Special.
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• Close to End: Places labels just before the end of the animation.
• Ahead: Places labels before the end of the animation.
• Well Ahead: Places labels well before the end of the animation.

• Label Priority: Defines the priority of the currently edited label in relation to other 
labels when a conflict between label positions occurs. The highest priority is preferred 
when displaying the labels.

• Auto: Sets the label priority using the Label Manager plug-in.
• Normal, High: Allows the Label Manager plug-in decides which label to show 

when there is a conflict between two normal (or high) priority labels.
• Always: Displays the label even if it conflicts with another label (with any 

priority).

3.2 3D Border Control

The 3D Border Control plug-in controls the attributes of a group of 3D Border objects. The plug-in 
controls the applied material, border width, edge softness and visibility.

The 3D Border Control plug-in has two modes:

• Control for defining the control mode.
• Width for setting the border parameters.

3.2.1 3D Border Control Properties

Control
• Container: Contains the placeholder for the top container of the 3D Border objects. All 

controlled 3D Border objects must reside directly under the top container. Any lower level 
containers are not effected.

• Control Mode: Defines how the objects are grouped when controlled by the 3D Border 
Control plug-in. When set to Level, the 3D Border objects are grouped by their data type 
(that is country, region and sub-region).

Note: This plug-in is located in: Built Ins -> Geometry plug-ins -> Maps_Obs

Note: The 3D Border Control plug-in does not build the 3D Border objects. The controlled 
3D Border objects should be built before the 3D Border Control is used.
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Control Mode Level

• Draw: Defines what data types are drawn. 3D Border objects with other data types are not 
switched off:

• Country: Shows 3D Border objects displaying country borders only.
• Region: Shows 3D Border objects displaying region and sub region borders only, 

according to the user selection. Available options are; Region (draws region 
borders), Sub-Region (draws sub-region borders) and Both (draws both region and 
sub-region borders).

• All: Draws all border types (that is country, region and sub-region).

Control Mode Group

• Group: Defines the group number that is visible and controlled by the 3D Border Control 
plug-in. Groups are defined in the 3D Border plug-in in the Advanced tab’s Set 
Groups parameter.

Width
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• Fixed (px): Uses a fixed width when drawing the line. This parameter causes the line to 
maintain the same width regardless of camera position/distance. Available parameters are 
Width and Fade Edge.

• Width (px): Sets the line width in pixels.
• Fade Edge (%): Sets the percentage of softness added to the edges of the line. When 

set to 0%, the line edges are sharp and when set to 100%, the edges are soft.

• Scaling: Varies line width according to the camera distance from the map when selected. 
Available parameters that allow the user to set the line attributes are Width, Minimum Width, 
Maximum Width, Minimum Draw Width and Fade Edge.

• Width (km): Sets the line width in meters on the map. The closer the camera to the 
map, the wider the line drawn.

• Minimum Width (px): Sets the minimum line width in pixels. If the calculated line width 
(according to the Width parameter) is smaller than the Minimum Width value, then the 
Minimum Width value is used.

• Maximum Width (px): Sets the maximum line width in pixels. This value is used when 
the camera distance is small and the line width should have been larger than the 
Maximum Width value (in pixels).

• Minimum Draw Width (px): Sets the minimum line width in pixels. If the calculated line 
width (according to the Width parameter) is smaller than the Minimum Draw Width 
value, and larger than the Minimum Width parameter, then the line is not drawn.

• Fade Edge (%): Sets the percentage of softness added to the edges of the line. When 
set to 0%, the line edges are sharp and when set to 100%, the edges are soft.

• Fixed (mm): Uses a fixed width, in Viz units, when drawing the line. This parameter causes 
the line to maintain the same width regardless of camera position/distance. Available 
parameters are Width and Fade Edge.

• Width: Sets the line width in pixels.
• Fade Edge (%): Sets the percentage of softness added to the edges of the line. When 

set to 0%, the line edges are sharp and when set to 100%, the edges are soft.

3.3 3D Border

The 3D Border plug-in draws the borders with fixed/scaling width options. Controlled mode refers 
to the 3D BorderControl plug-in, turn on this option to allow 3D BorderControl to take effect.
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This plug-in is used for applying graphic designs to the border data retrieved by the 3D Map 
Setting scene plug-in. Each 3D Border plug-in is used to filter and define which borders are drawn.

The Data tab is used for defining which borders are displayed by the plug-in. The Width tab is used 
for defining the border width and other graphical related attributes. The Outline tab is used for 
adding an outline to the borders. The Effect tab is used for defining an animation of the border. 
The Advanced tab is used for defining general parameters of the border.

3.3.1 3D Border Properties

Data

• Draw: Sets the border type drawn by the plug-in. Available options are Country, Region and 
All.

Note: When adding a 3D Border plug-in to a container, a 3D Line Shader plug-in is added 
automatically to the same container. The 3D Map Setting plug-in must be manually added 
when using the 3D Border plug-in.



Note: This plug-in is located in: Built Ins -> Geometry plug-ins -> Maps
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• Country: Draws country borders only. When Country is selected, additional options are 
made available: Country, Coastline and Both (see Select).

• Region: Draws region borders only. When Region is selected, additional options are 
made available: Region, Sub Region and Both (see Select).

• All: Draws all available borders retrieved by the 3D Map Setting plug-in.
• Select: Displays the available Country or Region options when either of those two options is 

selected.
• Country: Draws inland country borders only.
• Coastline: Draws country coastline borders only.
• Both (Country & Coastline): Draws both inland and country coastline borders.
• Region: Draws region borders only.
• Sub Region: Draws sub region borders only.
• Both (Region & Sub Region): Draw both region and sub region borders.

• Selection: Defines whether the plug-in uses the selected regions in the map (received from 
the CWMClient plug-in). If enabled, only the borders of the selected regions in the map are 
drawn. If disabled, all borders are drawn according to the plug-in settings (country, region, 
and so on).

Width

• Fixed (Pixels)– Uses a fixed width when drawing the line. This parameter causes the line to 
maintain the same width regardless of camera position/distance. Available parameters are 
Width and Fade Edge.

• Width (Pixels): Sets the line width in pixels.
• Fade Edge (%): Sets the percentage of softness added to the edges of the line. When 

set to 0%, the line edges are sharp and when set to 100%, the edges are soft.

• Scaling: Varies the line width according to the camera distance from the map when selected. 
Available parameters that allow the user to set the line attributes are Width, Minimum Width, 
Maximum Width, Minimum Draw Width and Fade Edge.

• Width (km): Sets the line width in meters on the map. The closer the camera to the 
map, the wider the line drawn.
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• Minimum Width (px): Sets the minimum line width in pixels. If the calculated line width 
(according to the Width parameter) is smaller than the Minimum Width value, then the 
Minimum Width value is used.

• Maximum Width (px): Sets the maximum line width in pixels. This value is used when 
the camera distance is small and the line width should have been larger than the 
Maximum Width value (in pixels).

• Minimum Draw Width (px): Sets the minimum line width in pixels. If the calculated line 
width (according to the Width parameter) is smaller than the Minimum Draw Width 
value, and larger than the Minimum Width parameter, then the line is not drawn.

• Fade Edge (%): Sets the percentage of softness added to the edges of the line. When 
set to 0%, the line edges are sharp and when set to 100%, the edges are soft.

• Fixed (Mm)– Uses a fixed width, in Viz units, when drawing the line. This parameter causes 
the line to maintain the same width regardless of camera position/distance. Available 
parameters are Width and Fade Edge.

• Width: Sets the line width in pixels.
• Fade Edge (%): Sets the percentage of softness added to the edges of the line. When 

set to 0%, the line edges are sharp and when set to 100%, the edges are soft.

• See Me Now: Calculates (when width is set to scaling) the width needed for the line to be 
visible at a given distance.

Outline

• None: Does not draw an outline to the borders.
• Master: Acts as the master plug-in for outline behavior. Other 3D Border plug-ins can be set 

as clients of this plug-in. The same outline attributes are applied to borders drawn by the 
master plug-in and by all other slave plug-ins. When selected, the Outline Width (%), Outline 
Fade (%) and Outline Color parameters are also available.

• Slave: Draws the outline according to the defined outline in the master plug-in above it in 
the scene hierarchy. All other parameters are disabled, displaying the master’s values.

• Stand Alone: Defines the outline parameters for the borders drawn by this 2D Label plug-in 
only. When selected, the Outline Width (%), Outline Fade (%) and Outline Color fields are also 
available.

• Outline Width (%): Sets the width of the outline, as a percentage of the border width, where 
0% is the border width.
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• Outline Fade (%): Sets the percentage of softness applied to the outline edges.
• Outline Color: Sets the color of the outline and the alpha value of the outline.

Effect
The Effect tab is used for creating an animation on the line size. After the line object is created, it 
can be animated by setting keyframes of the length parameter.

• Border Length: Sets the line length, where the value 100 represents 100% of the line length.

• Fade: Defines the softness that is added to the line edge as the length animation advances. 
When the length is 100, the end of the line is not affected by the Fade parameter.

Advanced
The Advanced tab is used for defining general parameters for the 3D Border object.

Note: The hierarchy structure is important when using the master/slave outline 
configuration. The master plug-in should always reside as the first container in the 
group of 3D Border containers. An Expert plug-in should be added to the map (above 
the 3D Roads containers) and Z-Buffer Draw should be set to Off.
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• Height Offset: Offsets the borders from the map (on the fly).
• Border Quality: Selects the quality of the border line:

• Controlled: Calculates border quality by the navigator distance from the border object.
• High: Uses high quality when drawing the border line (performance is slower).
• Medium: Uses medium quality when drawing the border line.
• Low: Uses low quality when drawing the border line. The border line looks pixelized 

when zooming into the map.
• Add Level Down (Shape File): Defines whether the sub region borders are drawn with the 

region borders, or if regions are drawn with countries.
• Control Mode: Defines whether the 3D Border object is externally controlled by the 3D 

Border Control plug-in or not. Border objects are controlled by groups.
• Set Groups: Set the group number for the object.
• Line Shader: Line shader has two variants. The first is Simple with less options (and better 

performance), while the second is more Advanced and allows for more options (but at the 
cost of performance).

• Update Texture Mapping: Determines whether the texture coordinates should be updated 
based on line width.

• Low Angle Compensation: Compensates for perspective distortion. Lines become too thin at 
low camera angles as a result of the perspective distortion. When that happens, there are 
not enough pixels to support a smooth, anti-aliased line, and the lines look jagged and 
aliased. This mode compensates for that by both widening the lines and applying 
transparency when they are viewed at too low angles.

• Debug: Enables debug messages in the console.
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• Min Angle: Does not change line width and transparency if the angle between the camera 
and the ground below the line is lower than Min Angle.

• Max Angle: Increases the line width by the Width Factor and scales the transparency by 
the Alpha Factor if the angle between the camera and the ground below the line is higher 
than Max Angle. If the angle is between Min Angle and Max Angle then the width and 
transparency are interpolated.

• Outline Angle Offset: Applies an offset to the angle calculation for outline width in order to 
make the outlines affected at higher angles than the lines themselves.

• Width Factor (%): Determines the factor for modifying line width when applicable.
• Alpha Factor (%): Determines the factor for modifying line alpha when applicable.
• Wireframe: Shows the border object as a wireframe.
• Print Sub Area Data: Prints to the console all the sub regions in the plug-in (used for 

elections).

Rebuild

 
The Rebuild button triggers the plug-in to redraw the borders according to the plug-in parameters. 
Some parameters are updated as the parameters are changed and do not require a rebuild 
command, but it is good practice to rebuild the borders after setting the parameters.

3.4 3D Line Control

The 3D Line Control plug-in controls 3D Line object groups. The Groups are then controlled in 
terms of width and color. The groups are derived from the settings in the 3D Line objects.

3.4.1 3D Line Control Properties

Control

Note: This plug-in is located in: Built Ins -> Geometry plug-ins -> Maps_Adv
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• Container: Sets the top container above the controlled 3D Line objects.
• Group: Defines the controlled group number. A group is defined in every 3D Line object.

Width

• Width: Selects options to control the line width, Fixed (in pixels or in mm), or Scaling.
• Width: Sets the width value when fixed width is selected (pixels or mm). Fixed width 

the line maintains the width value through all camera zoom range. When Scaling is 
selected, width is set in actual kilometers and the line width is calculated according to 
the camera zoom.

• Minimum Width (px): Sets the minimum value of line width in pixels. this value is used 
if the calculated width according to the width parameter is smaller than the minimum 
width value (when zooming far out).

• Maximum Width (px): Sets the maximum value of line width in pixels. this value is 
used if the calculated width according to the width parameter is larger than the 
maximum width value (when zooming in).

• Minimum Draw Width (px): Defines the minimum line width drawn.
• Fade Edge (%): Defines the edge fade width as a percentage of the line width.

3.5 3D Line

The 3D Line plug-in has several graphic uses for drawing lines:

• Drawing shape lines created in the Map Editor (WME) when selecting a map. A line design is 
created in the hierarchy and defined in the CWMClient plug-in (see 3D Objects and Shapes).

• Drawing a line between label locations, defined in the WME, from the first label in the list to 
the last label in the list. Labels in the CWMClient plug-in must be enabled when using this 
mode.
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• Drawing a line along hop points defined in a Navigator scene. The line follows the path of 
the Navigator animation between the hops.

• Drawing a line using a Long/Lat coordinates list. The line is drawn from the first Long/Lat 
pair to the last.

This plug-in also works together with plug-ins such as: Trace It.

This section contains information on the following topics:

• 3D Line Properties
• Width
• Outline
• Effect
• Control
• Advanced
• Rebuild

Note: When adding a 3D Line plug-in to a container, a 3D Line Shader plug-in is 
added automatically to the same container. The 3D Map Setting plug-in has to be 
added manually when using the 3D Line plug-in with the Navigator plug-in. The 3D 
Line Manager plug-in is used for controlling and creating 3D Line objects.



Note: Some of the uses of 3D Line plug-in as described above requires the use of the 
Label Manager plug-in in the scene.



Note: This plug-in is located in: Built Ins -> Geometry plug-ins -> Maps
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3.5.1 3D Line Properties

Width

• Fixed (px): Uses a fixed width when drawing the line. This parameter causes the line to 
maintain the same width regardless of camera position/distance. Available parameters are 
Width and Fade Edge.

• Width (px): Sets the line width in pixels.
• Fade Edge (%): Sets the percentage of softness added to the edges of the line. When 

set to 0%, the line edges are sharp. When set to 100%, the edges are soft.

• Scaling: Varies line width according to the camera distance from the map when selected. 
Available parameters that allow the user to set the line attributes are Width, Minimum Width, 
Maximum Width, Minimum Draw Width and Fade Edge.

• Width (m): Sets the line width in meters on the map. The closer the camera to the 
map, the wider the line drawn.

• Minimum Width (px): Sets the minimum line width in pixels. If the calculated line width 
(according to the Width parameter) is smaller than the Minimum Width value, then the 
Minimum Width value is used.

• Maximum Width (px): Sets the maximum line width in pixels. This value is used when 
the camera distance is small and the line width should have been larger than the 
Maximum Width value (in pixels).

• Minimum Draw Width (px): Sets the minimum line width in pixels. If the calculated line 
width (according to the Width parameter) is smaller than the Minimum Draw Width 
value, and larger than the Minimum Width parameter, then the line is not drawn.

Note: Width parameters, Fixed (px) and Scaling, affects the line object only if the scene 
uses a Navigator plug-in. In case of a static map, use the Fixed (mm) to set the line width.
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• Fade Edge (%): Sets the percentage of softness added to the edges of the line. When 
set to 0%, the line edges are sharp. When set to 100%, the edges are soft.

• Fixed (mm)– Uses a fixed width, in viz units, when drawing the line. This parameter causes 
the line to maintain the same width regardless of camera position/distance. Available 
parameters are Width and Fade Edge.

• Width: Sets the line width in pixels.
• Fade Edge (%): Sets the percentage of softness added to the edges of the line. When 

set to 0%, the line edges are sharp. When set to 100%, the edges are soft.

• See Me Now: Calculates (when width is set to scaling) the width needed for the line to be 
visible at a given distance.

Outline

• Outline: Enables (On) or disables (Off) outline.

• Outline Width (%): Sets the width of the outline, as a percentage of the border width.
• Outline Fade (%): Sets the percentage of softness applied to the outline edges.
• Outline Color: Sets the color of the outline and the alpha value of the outline.

Effect
The Effect tab is used for creating an animation on the line size. After the line object is created it 
can be animated by setting keyframes on the length parameter.

Note: The color palette is visible in all tabs of the editor, but it only affects the 
outline color.





Viz World Plug-ins Guide - 17.0

Copyright © 2019  Vizrt                                                          Page  31

• Length: Sets line length, where 100 is 100% of the line length.

• Fade: Defines the softness added to the line edge as the length animation advances. When 
length is 100, the end of the line is not affected by the Fade parameter.

• Animation Length (frames): Sets the default length of the reveal animation in frames (relates 
to the Run Animation option) and allows you to run a simple reveal animation by pressing 
the Run Animation button (used by 3D Map Telestrator).

• Lock To Navigator: Animates the line with the Navigator animation when using the 3D 
Line plug-in with a Navigator plug-in. The starting point of the line is the first hop location 
and the ending point of the line is the last hop position. The line animates as the hop 
animations are playing.

• Run Animation button: Plays the animation of that particular line.

Control
The Control tab is used for defining external control parameters. External control is done by the 
3D Line Control plug-in.
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• Control Mode: Defines whether the object is externally controlled or not.
• Set Groups: Defines the groups that the current 3D Line object is a member of. The same 

group names should be used in the 3D Line Control.
• Shared Memory: Determines the type of shared memory (Viz 3 only) that can be used to 

control the lines.
• Identifier: Determines the shared memory name and general purpose identifier for this line. 

Can be used to control the line or to share a display list data between scenes.

Advanced

• Cap Edges: Sets the line’s cap shape.
• None: Does not change the line edges.
• Round: Adds a filled round shape to the line caps.
• Square: Adds a filled square shape to the line caps.
• Feather: Adds a feather shape to the line caps. An additional parameter is enabled 

when Feather is selected: Cap Fade Size.
• Length Effect: Determines whether the separate polygons in the line animate at the same 

time (Per Polygon) or one after another (Continuous).
• Wireframe: Draws the 3D Line object as a wireframe when enabled (On).

• Height Offset: Sets the height offset for the 3D Line object on the map (on the fly).
• Line Offset: Sets the line offset for the 3D Line object on the map (on the fly).
• Enable World Periodicity: Determines how line objects that cross the date line act. When 

enabled (On), a line object that crosses the date line continues from the other side of the 

map. When disabled (Off), it continues across the date line.
• Update Texture Mapping: Determines if the texture coordinates are updated based on line 

width. You have the following options: Disabled, Always or Stationary. Stationary only 
updates the texture mapping when navigator is moving.
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• Low Angle Compensation: Compensates for perspective distortion. Lines become too thin at 
low camera angles as a result of the perspective distortion. When that happens, there are 
not enough pixels to support a smooth, anti-aliased line, and the lines look jagged and 
aliased. This mode compensates for that by both widening the lines and applying 
transparency when they are viewed at too low angles. When set to Advanced, the following 
additional parameters are available:

• Debug: Enables debug messages in the console.
• Min Angle: Does not change line width and transparency if the angle between the 

camera and the ground below the line is lower than Min Angle.
• Max Angle: Increases the line width by the Width Factor and scales the transparency 

by the Alpha Factor if the angle between the camera and the ground below the line is 
higher than Max Angle. If the angle is between Min Angle and Max Angle then the 
width and transparency are interpolated. 

• Outline Angle Offset: Applies an offset to the angle calculation for outline width to 
make the outlines affected at higher angles than the lines themselves.

• Width Factor (%): Determines the factor for modifying line width when applicable.
• Alpha Factor (%): Determines the factor for modifying line alpha when applicable.

Rebuild

The Rebuild   button triggers the plug-in to redraw the lines according to the plug-in 
parameters. Some parameters are updated as the parameters are changed and do not require a 
rebuild command, but it is good practice to rebuild the lines after setting the parameters.

3.6 3D Models

The 3D Models plug-in adds 3D models to a graphics scene. As the models also contain 
geographical referencing, you may also place the model on a map.

Note: When enabled, symbols are easier to control, but as line width changes the 
cause texture changes which might be disturbing.
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The images above show a 3D model of Mont Saint-Michel in Normandy, France. The model was 
downloaded from http://sketchup.google.com/3dwarehouse and then placed on a satellite image 
from Digital Globe.

3.6.1 3D Models Properties

General

• File: Selects the file to load. Capable of loading files in Collada format with the *.dae 
extension or *.kml/*.kmz extension (which has geographic information for the model and a 
link to a *.dae file inside).

• Fill Mode: Selects the rendering mode; solid, wireframe or dotted.
• One Size: Recalls the loaded model to a fixed size. Useful in non-georeferenced mode.
• Automatic Fetch: Enables fetching pieces of the city as you move around the map 

(Interactive) or animate (Streaming). Used when loading 3D Cities rather than single models.

Note: This plug-in is located in: Built Ins -> Geometry plug-ins -> Maps

http://sketchup.google.com/3dwarehouse
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Advanced
The Advanced tab is more suitable for a streaming mode of the plug-in, when the plug-in loads/
streams data out of a large data bank which cannot be loaded entirely due to its size.

• GPU Cache Size: Limits the amount of data that is loaded to the GPU (loaded data may 
consume more size than expected on GPU).

• Model Index: Enables to run through loaded models (mostly for debug purposes) when 
multiple models are loaded. When a specific index is set, the model is in focus, so the 
bounding box is shown and Fly To and Info buttons can be used on that model.

• Level of Detail: Defines how many of the largest levels of the texture pyramid (.dxt format) 
can be neglected during loading. May be useful in cases where the texture data is heavy and 
presents a higher resolution than that required to be shown.

• Height Offset: Height offset during fetch of the models.
• Show Coverage: Shows the total available geo coverage in green color and currently loaded 

coverage in orange when models are loaded/streamed from the large database.
• Fetch Method: Attempts to load as much data around the fetch point as possible (the 

amount is limited by the GPU Cache Size parameter) when models are fetched either by 
pressing the Fetch Locally button or in streaming mode. 

• Navigator: Defines the fetch point as the current Navigator position. 
• Manual: Enables manual definition of the fetch point. 

• Loading Type: Determines how to load multiple models. The Serial mode may be preferred 
for recording (using Viz Post), when you have to be sure that all the models were loaded up 
until the next frame.

• Fade Time (sec): Defines the time period during which a new model fades from transparent 
to opaque, to create a more pleasant looking effect on load.

Consolidation
The Consolidation tab is used for compiling a binary format of the plug-in out of Collada files.
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• Model Optimization: Defines the level of optimization for the model while the model is 
loading. More optimization may increase loading time while improving rendering 
performance in some models.

• Downscale Textures: Defines how much the first levels of a texture pyramid may be skipped.

Buttons
• Fly To: Used to take the camera to the model, if it is georeferenced (i.e. if the original 

Collada file had *.kml or *.kmz files containing the geolocation). Requires the presence of 
the NavFinder plug-in on the container in order to work.

• Reload: Reloads the model.
• Info: Prints information about the model to the console. It prints information about the 

dataset in the case when more than one model is loaded, and prints information regarding a 
specific model if only one model is loaded or when the Model index parameter is not zero.

• Fetch Locally: Fetches models around the fetch point (defined manually with Fetch 
Method parameter). The number of models that are fetched is limited either by dataset or by 
the GPU Cache Size parameter.

3.6.2 Working with 3D Models
This section provides a quick introduction on how to add a 3D model to your scene, and also how 
to place the model on a map or satellite imagery.

To Add 3D Models to a Scene

1. Start Viz Artist.
2. Add the 3D models plug-in to an empty scene tree.
3. Open the 3D models plug-in editor and load a KMZ file.

Tip: Download models for testing from http://sketchup.google.com/3dwarehouse.

http://sketchup.google.com/3dwarehouse
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To Add 3D Models to a Map

1. Start Viz Artist.
2. Add the Navigator to an empty scene tree.
3. Add the Atlas plug-in to the GeoReferenceMap container.
4. Open the Atlas editor and set it to use Mercator projection.
5. Add a new group as a sub-container of the first container and name it position.
6. Add the World Position plug-in to the position group.
7. Add a new group as a sub-container of the position group and name it model.
8. Add the 3D models, Expert and NavFinder plug-in to the model group.
9. Open the 3D models plug-in editor and load a KMZ file (e.g. Tower Bridge in London).

10. Click Go To Model. This should bring the model into view.
11. Open the Navigator editor, select Advanced, and then enable (On) the Pan and Tilt 

Animation option.
12. Open the 3D models plug-in editor again and click Go To Model.
13. Open the transformation editor for the model container.
14. Open the NavFinder editor in order to adjust the distance, pan and tilt of the map.

See Also

• Viz Artist User Guide for information on the Expert plug-in.

3.7 3D Region Control

The 3D Region Control plug-in controls one or more 3D Region objects by changing and applying 
graphic properties to the objects. The 3D Region Control plug-in is typically used for producing 
election graphics where it is useful to distinguish regions by, for example, color.

Tip: Press Shift+CTRL while adjusting the Distance, and Shift while adjusting the Pan
and Tilt.



Note: This plug-in is located in: Built Ins -> Geometry plug-ins -> Maps_Adv

http://docs.vizrt.com/viz-artist.html
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3.7.1 3D Region Control Properties

• 3D Regions Parent Container: Container placeholder for the container holding the region 
objects.

• Control Mode:  Defines the data segment of the object to be controlled. Select Region or Sub 
Region and then select what part of the region/sub-region to control:

• Fill: Enables control of the region/subregion’s fill properties.
• Border: Enables control of the region/subregion’s border properties.

• Fill Mode:  Defines the fill of the regions.
• Interpolate 3: Sets three colors that define the region's color range. The region's color 

is derived from the range of colors and the number of regions.
• Interpolate 2: Sets two colors that define the region's color range. The region's color is 

derived from the range of colors and the number of regions.
• Group: Controls the fill of all the 3D Region objects under the defined 3D Regions 

Container (apply the material added to the 3D Region Control container).
• Highlighted: Controls the selected regions on the map only.
• Not Default: Allows 3D Region Control to draw any sub region in the target 3D 

Region which is not in group one.
• Apply Sender Matrix: Applies a matrix to the regions. Available options are None, Multiply, 

Translate, Scale and Full.
• None: Uses the 3D Region matrix.
• Multiply: Uses the 3D Region matrix multiplied by the 3D Region Control matrix.
• Translate: Uses only the translated part (x, y and z position) of the 3D Region Control 

matrix.
• Scale: Uses the scale part (x, y and z scaling) of the 3D Region Control matrix.
• Full: Uses the 3D Region Control matrix.

• Apply Sender Matrix: Applies a matrix to the regions. Available options are None, Multiply, 
Translate, Scale and Full.

• Apply On: Applies the sent matrix on all regions or only the selected sub regions.

3.8 3D Region

The 3D Region plug-in applies a graphic design to selected regions of the map. The designs are 
defined in the scene and linked in the CWMClient plug-in to create the regions received from the 
maps server.
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The plug-in has the following four editor views:

• General: Quality and performance parameters.
• Region: The object’s graphic properties.
• Sub Regions: The object’s sub regions graphic properties. This tab is enabled when the Sub 

Regions parameter, under the Advanced tab’s Data settings, is enabled (On).

• Advanced: Defines plug-in behavior in special operation scenarios.

3.8.1 3D Region Properties

General

Note: This plug-in is located in: Built Ins -> Geometry plug-ins -> Maps
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• LOD mode: Sets the level of detail (LOD). When set to auto, the plug-in manages the level of 
details according to the camera distance from the region object. When set to manual, the 
level of details do not change when the camera moves, and remain fixed. When set to 
Manual, the Polygon Quality parameter is enabled.

• Polygon Quality: Sets the quality of the generated region object. The Highest setting uses 
more polygons to build the region object, but affects performance when many regions are 
selected. The Lowest setting enables better performance when adding a lot of regions, but 
looks poor when moving the camera closer to the region objects.

• Geo Reference: References the region object to the map above 3DRegion container when set 
to On. When set to Off, the longitude and latitude numbers are transferred to the Viz Artist 

position X, Y values. The object can still be georeferenced using for example the Locator 
Control or World Position plug-ins.

• Auto Rescale: Scales all regions to the same size. Can be used when the region is not 
geographically referenced (on screen normal) and you want all regions to be the same size 
(e.g. Israel uses the same screen real estate as a map of America) in Viz units.

• Copy Map to Region: Copies overlay the map texture on top of the region geometry.
• Center X Y: Defines where the axis of the region object is placed: if Region is selected, the 

axis center is the middle of the region object. If Map is selected, the axis is placed in the 
middle of the reference map.

• Sensible Culling: Defines whether to cut off areas that belong to the selected region but are 
geographically remote. If set to Off, all marked regions are built. Use this feature to improve 

performance (usually set to On).

• Culling Threshold: Defines the level of details displayed in the regions. A higher threshold 
value draws fewer details (that is small islands, small regions, and so on).

• Use Cache: Saves the objects to a cache folder when set to On. When using cache, the 

generated objects and parameters are saved in a cache folder and when switching between 
parameters the regions are not rebuilt, but taken from the cache (if they exist). If no cache 
(Off) is used, every change in the plug-in interface triggers a rebuild of the region objects.
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Region

Fill

• Fill: Adds a region object to the map, and if fill is applied, how regions are built on the map 
(either flat on the map (no width) or extruded).

• None: Does not add a region object to the map.
• Extrude: Adds and extrudes regions over the map. When extrude is used, additional 

parameters are enabled.
• Flat: Adds a flat object (Extrude=0).

• Include Bottom: Builds the bottom of the region when extruded.
• Center Z: Sets the Z axis location of the region object, with relation to the map: bottom, 

center or top.
• Type: Defines how the Height parameter is calculated.

• Absolute Height: Defines the regions extrusion height value as Viz units.
• Relative Height: Defines the regions extrusion height value as a percentage of the 

regions size.
• Show Terrain: Enables 3D Region to take into account any terrain data for a selected region. 

Adjust the Terrain Height Scale parameter. For this to work you need to enable the Fetch 
Terrain Data option in the CWMClient.

• Terrain Height Scale: Adjusts the terrain height.
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Border

 
The border parameters define whether a border is drawn around the region objects, border color, 
width and the alpha. If the 3D Region object is in Controlled Mode (On) the border properties 
parameters are disabled.

• Borders: Defines whether the object is drawn with a border. When enabled (On), the border 
is drawn and the border properties parameters are enabled.

• Line Width: Sets the number of GL lines for the border width.
• Line Color: Uses the color pallet to set the border color.
• Alpha: Sets the alpha value for the border. This value is controlled by the number to the 

right of the Line Color selection.

Sub Regions
The Sub Regions tab has the same fields as the Region tab, except that Sub Regions does not have 
the Show Terrain and Terrain Height Scale fields. It also has the following field:

• Sub Regions: Defines whether the object uses the sub regions data in the drawn object. 
When enabled (On), the sub regions data are reflected in the geometry and the Sub Regions 
tab displays the sub regions parameters.

Note: The color palette is visible in all 3D Region editors but it only affects the 
border color.
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Advanced

Common parameters
• Freeze: Enables the designer to freeze the region object to Viz data folders (the region is 

saved as an image containing the region’s information).
• Wireframe: Draws a wireframe of the object.
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Data

The Data tab defines how data is processed.

• Controlled Mode: Defines whether the 3D Region object is controlled by a 3D Region 
Control plug-in in the hierarchy or not.

• Render Mode: Defines whether the 3D Region object is rendered by Viz or directly in 
OpenGL.

Election
All options work together with the 3D Region Control plug-in.

• Command: Contains the text with region information used for elections.
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• Selection Data: Since the region data can be shared between scenes, setting the Selection 
Data to Local means you only influence the local scene whereas with Global you influence all 
scenes.

If Sub Regions is enabled (On), additional parameters are enabled.

• Print SubRegion Data: Prints the data in the Viz console.
• Save Sub Regions Strings: Saves back the sub regions data to the file.
• Save Sub Region: Saves the current specific sub region information back to the file.
• Convert Names: Converts the names in the plug-in to a different set of names.
• Rebuild: Rebuilds the region objects from the file.

Alpha

 
The Alpha tab is an advanced tab used mainly for elections. Alpha tab parameters are enabled 
when the Sub Regions parameter is enabled (On). The parameters affect the object only when an 
Alpha plug-in is added to the object and the 3D Region plug-in is in Controlled Mode. These 
parameters define what part of the region data is affected by the alpha plug-in.

• Draw: Defines what part of the object is affected by the alpha settings.
• All: Draws both region and sub regions in the object.
• Region: Draws only the region.
• Sub Region: Draws only the sub regions.
• None: Sets region and sub regions to be transparent.

• Region Alpha Mode: Defines what part of the data is affected by the alpha plug-in.
• Region: Affects only the region areas.
• Sub Regions: Affects only sub region areas.
• None: Does not affect data when using the alpha plug-in.

• Border Alpha Mode: Defines what part of the border data is affected by the alpha plug-in.
• Region: Affects only the region borders.
• Sub Regions: Affects only sub region borders.
• None: Does not affect data when using the alpha plug-in.

• Create Alpha Channel: Creates an alpha channel animation automatically.
• Length: Determines the length of alpha channel animation
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• Extrude Length (F): Animates sub regions height (extrude). This parameter sets the time for 
the animation.

Draw

 
The Draw tab defines advanced parameters for drawing the region objects.

• International Date Line: Relates to countries that reside on the 180 and -180 longitude line 
when using flat maps.

• None: Draws the regions on both sides of the map.
• United: Draws the regions together.

• Border Data: Defines the source data of the borders.
• Polygon: Draws borders using polygon data.
• Border: Draws borders using border data (higher memory consumption).

• Border Quality: Sets the required border quality.
• Morphing: (Off, Start, End, Start & End)

• Start: Allows multiple start shapes to be used to create multiple region morphing 
shapes. You must also design a separate region using End in order to define how the 
shape should end.

• Start & End: Allows setting two shapes (start and end), and the region morphs between 
the two shapes.

• Morphing Samples: Determines the number of data samples between the start and end 
animation.

• Morphing Value (%): Used to animate between the first and last frame of the shape.

Note: The color palette is visible in all 3D Region editors but it only affects the 
border color.
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3.9 3D Roads

The 3D Roads plug-in overlays road data onto a map. This plug-in is mainly used with a 3D Line 
Shader plug-in.  

 
The plug-in has three different editor views:

• Data: Defines what type of roads are drawn by the selected 3D Roads object. Select one or 
more types of roads to be displayed, using the plug-in graphic properties.

• Width: Defines the width of the roads drawn by the plug-in.
• Outline: Defines the objects outline properties and behavior.
• Advanced: Defines extra settings on how to handle texture mapping and low angle 

compensation when drawing streets.

Note: This plug-in is located in: Built Ins -> Geometry plug-ins -> Maps
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3.9.1 3D Roads Properties

Data

• Freeways/Motorways, Primary, Main, Secondary and Other Roads: Draws roads rated 
according to the selection in the loaded roads data when enabled (On).

• Major and Other Railways: Draws railways rated according to the selection in the loaded 
railways data when enabled (On).

Width
Selects how the road width is calculated.

• Fixed (Pixels): When set to Fixed the road maintains a fixed width during camera zoom 
movements. Available options are Width (pixels) and Fade Edge (%).

• Width (Pixels): Sets the width of the roads in number of pixels.
• Fade Edge (%): Sets the percentage of softness applied to the road edges.



Viz World Plug-ins Guide - 17.0

Copyright © 2019  Vizrt                                                          Page  49

• Height Offset: Offsets the borders from the map (on the fly).
• Scaling: When set to Scaling the road width varies according to the camera zoom 

movements. When selected, the following parameters are available:
• Width (Meters): Sets the physical road width (in Meters). This value is translated into 

drawn pixels according to the camera zoom position and the size of the map.
• Minimum Width (Pixels): Sets the minimum size of the roads drawn. If the calculated 

road size in pixels is lower than the minimum width, the road is not drawn.
• Maximum Width (Pixels): Sets the maximum size of the roads drawn. If the calculated 

road size in pixels is higher than the maximum width, the road width is set to the 
maximum width.

• Minimum Draw Width (Pixels): Sets the minimum size of the roads drawn. When 
zooming into an area, this is the point where the roads begin to fade in and are drawn 
over the map.

• Fade Edge (%): Sets the percentage of softness applied to the road edges.
• See Me Now: Calculates (when width is set to scaling) the width needed for the line to 

be visible at a given distance.
• Fixed (mm): When set to Fixed (mm) the road maintains a fixed width during camera zoom 

movements. When selected, the Width (mm) and Fade Edge (%) parameters are available.

Outline

• Outline: Selects one of the options for adding outline to the roads. Available options are 
None, Master, Slave and Stand Alone.

• None: Does not add an outline to the roads drawn by the plug-in.
• Master: Controls other 3D Roads plug-ins which are in slave mode. The same outline 

attributes are applied to roads drawn by the master plug-in and by all its slave plug-
ins. When selected, additional parameters are Outline Width (%), Outline Fade (%) and 
Outline Color. 

• Slave: Draws the outline according to the defined outline in the master plug-in above it 
in the scene hierarchy. All other parameters are disabled, displaying the master’s 
values.

Note: The master setting ONLY controls other plug-ins, it does not draw any 
outlines itself. If there are no slave plug-ins, then no outlines are visible.
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• Stand Alone: Defines the outline parameters for the roads drawn by this 3D 
Roads plug-in only. When selected, available additional parameters are Outline Width 
(%), Outline Fade (%) and Outline Color.

• Outline Width (%): Sets the width of the outline, as a percentage of the road width, where 0%
is the road width.

• Outline Fade (%): Sets the percentage of softness applied to the outline edges.
• Outline Color: Sets the color of the outline and the alpha value of the outline.

Advanced

• Line Shader: Line shader has two variants. The first is Simple with fewer options (and better 
performance), while the second is more Advanced and allows for more options (but at the 
cost of performance).

• Update Texture Mapping: Defines when to update the mapping of textures applied in the 
container:

• Disabled: Does not ever update the mapping of the texture.
• Always: Updates the mapping of the texture while animating.
• Stationary: Updates the mapping of the texture only when the scene is stationary or 

not an animation.
• Low Angle Compensation: Used when creating graphics that have a low angle point of view 

or tilt in order to remove aliasing on lines far away from the camera.
• Wireframe: Displays the roads as wireframe.
• Debug: Enables debug messages in the console.
• Min Angle: If the angle between the camera and the ground below the line is lower 

than Min Angle, then line width and transparency are not changed.
• Max Angle: If the angle between the camera and the ground below the line is higher 

than Max Angle, then the line width is increased by the Width Factor and the 

Note: The hierarchy structure is important when using the master/slave outline 
configuration. The master plug-in should always reside as the first container in the 
group of 3D Roads containers. An Expert plug-in should be added to the map (above 
the 3D Roads containers) and Z-Buffer Draw should be set to Off.



Note: Road data should be loaded (using the CWMClient plug-in) before working on 
roads design.
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transparency is scaled by the Alpha Factor. If the angle is between Min Angle and Max 
Angle then the width and transparency are interpolated.

• Outline Angle Offset: For outline width, apply an offset to the angle calculation in 
order to make the outlines affected at higher angles than the lines themselves.

• Width Factor (%): Determines the factor for modifying line width when applicable. 
Percentage value for the width of the line far away from the camera. For example, 
400% thicker than when it is close to the camera.

• Alpha Factor (%): Determines the factor for modifying line alpha when applicable. 
Percentage value for the alpha of the line far away from the camera.

3.10 Atlas

The Atlas plug-in displays satellite imagery from Microsoft Bing, Digital Globe, Google and other 
providers. This object plug-in is used with a navigator plug-in, enabling interactive navigation to 
any location on Earth. The plug-in can be used to display imagery for a Navigator animation 
(Hops), while creating the required image tiles for a smooth and complete camera movement. It 
can also be used with the Globe plug-in.

To create an interactive Touchscreen Application, the Atlas plug-in must be used together with 
the Navigator.

The plug-in has the following editor tabs:

• Atlas Properties
• Data

• Bing
• CMR
• DG
• Blom
• WMS
• Nokia
• Map Server
• Google

• General
• Advanced
• Communication
• Animation

IMPORTANT! To ensure that image tiles appear correctly, use a base map with the correct 
projection.



Note: This plug-in is located in: Built Ins -> Geometry plug-ins -> Maps
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3.10.1 Atlas Properties

Data
The Data tab is used to define imagery parameters.

• Data Source: Sets the data provider. Available providers are:
• Microsoft Bing
• Vizrt’s CMR (Curious Multi Resolution)
• DG (Digital Globe)
• Blom
• WMS (Web Map Service) geo server
• Nokia
• Map Server
• Google
• myRadar Weather Radar. 
• Weather Decision Technoloies (wdt)

• Hide Attribution: Hide the provider's attribution. Some data sources provide the possibility, 
but this is different for every data source. Some provide a separate license to enable this 
feature.

Bing
• Protocol: If Legacy is selected, the API used in previous versions of Viz World are used. You 

can use the Data Type parameter to choose between satellite imagery, road and border 
maps with labels or a combination of the two. If you combine the two road and border maps 
with labels they are imposed over the satellite imagery.

Note: Bing, Blom, DG, WMS and Google require an internet connection. Bing, 
Blom and Google does not work without a license. DG does, but shows a 
watermark.



https://wdtinc.com/
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• Satellite: Displays ONLY satellite imagery.

• Map: Displays the map using the hybrid styling and also displays labels.

• Combined: Displays a mix of Satellite imagery and Labels.

• Traffic: Draws a traffic layer. 
If New is selected, a new API is used, which gives you more control over what to 
display in the map. It allows selecting whether to include labels in the map, and what 
language to use for those labels. The following parameters are available:

• Map: Displays Satellite imagery, or displays the Map using the hybrid styling.
• Labels: Turns the labels in the Map on/off.
• Culture: Selects the language of the labels.
• Vector: Determines whether the map includes vector data (streets/ borders) with the 

satellite imagery.
• Hills: Determines whether the synthetic map includes hills topography.

CMR
• CMR File: Sets the path to the CMR file.
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• CMR Data Status: Indicates whether the file was loaded correctly.

DG
• Projection: Defines the projection of the map, either Unprojected or Mercator.
• Digital Globe Profile: Enables you to select from the most common profiles of Digital Globe 

maps (Note that imagery from different profiles may differ in some places and be the same 
in others).

In addition, the following parameters can be configured in the VizWorld.ini configuration file (by 
default located at C:\ProgramData\vizrt\viz3\Maps):

• DigitalGlobePrefix
• FirstLookPrefix

If these parameters are used (i.e. present and not commented with hash) then Atlas uses these 
strings as the basic connection string. The license key, projection, tile coordinates and additional 
parameters like profile or header are added in Atlas itself.

Blom
• Data Type: Sets how the map is displayed. For more information, see the description of the 

Data Type parameter in the Bing tab.

WMS
• Projection: Defines the projection of the map, either Unprojected or Mercator.
• URL: Sets the URL of the WMS geo server.
• Layer: Comma-separated list of one or more map layers. Values in list correspond to the 

layer <Name> values by the geo server’s Capabilities file. Layer list is optional if the Styled 
Layer Descriptor (SLD) parameter is present in the request.

• Free text: Sets optional parameters like transparency and background color 
(e.g. TRANSPARENT=TRUE&BGCOLOR=#E98300&). For more information on how to set optional 

parameters in the free text field, see the WMS specification documentation.
• Version: Request version. Valid values are 1.0.0, 1.1.0, or 1.1.1.

Nokia
• Data Type: Sets how the map is displayed. For more information, see the description of the 

Data Type parameter in the Bing tab.

Map Server
This allows the use of the TPLs and stylesheets in an available map server.

• Server Configuration:
• Default: Uses the default server configured in the engine (see the Configuring 

Viz section of the Viz Engine Administrator Guide).
• Manual: Allows using a different server than what is configured in the Viz Engine.

http://webhelp.esri.com/arcims/9.3/general/mergedprojects/wms_connect/wms_connector/get_map.htm
http://documentation.vizrt.com/viz-engine
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• Projects: Lists all TPLs that are available in the map server.
• Project: Displays the selected TPL.
• Pick Style: Shows available style sheets in the selected TPL by numerical index .
• Layer: Shows the name of the selected style sheet.

Google
• Profile XML Status: Shows if the file GoogleMaps_Profiles.xml (by default located at C:

\ProgramData\vizrt\viz3\Maps) was read correctly.
• Google Profile: Lists all found profiles from the file GoogleMaps_Profiles.xml.

General

• Use Base Map: Uses base map. This option is used when working with a base map above the 
Atlas container, and the base map is projected. Note that Microsoft Bing imagery is 
unprojected, so in order to have the images positioned correctly over the map set this 
parameter to On. The same applies if you use the Globe plug-in.

• Map Size: Defines the size of the Atlas image.
• Fade Time: Defines the duration of the transition between tile resolutions when zooming in/

out of the image.

Advanced
The Advanced tab is used for configuring connection and operation parameters.

Note: In the Viz Artist interface, a maximum of 256 TPLs can be displayed.

Note: To add or modify Google profiles, edit the file GoogleMaps_Profiles.xml. The 
Google Maps Tile documentation lists all possible configurations.



https://developers.google.com/maps/documentation/tile/#session_token_request
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• Temp Folder: Defines a specific cache folder for the retrieved imagery.
• Mode: Defines the mode of retrieving the tiles from Microsoft Bing server. When set to Serial, 

and new image tiles are required, Atlas plug-in sends a request to the server and waits for a 
reply. Only after the reply, another tile is requested, and so on. During the time that the 
plug-in as waiting for a replay the UI is locked the user cannot perform other operations. 
When set to Multithreaded, the images are requested by a thread of the plug-in and the UI is 
not locked.

• Requests per Frame: Defines the maximum image requests from the server in a frame.
• Layers: Defines the number of images (with different resolution) per one area.
• Texture Compression: Selects one of the required compression modes for the images.
• Texture Quality:

• Linear: Performs a linear interpolation to smooth the texture when being magnified or 
shrunk. The texture looks good, but some distortions can be visible when the textured 
object is animated further away on the Z axis. As the object then gets smaller and 
smaller, the shrinking and interpolation of the texture creates a lot of "noise" on the 
texture. As a consequence, the linear quality is appropriate when the objects that have 
the texture do not change their size much.

• Mipmap: Performs a linear interpolation to smooth the texture. In addition, it offers a 
solution to the problem that appears on the two other qualities when the object is 
being moved away along the Z axis or shrunk. To avoid the "noise" that we see when a 
texture constantly scales to try to fit.

• Quality: Defines the quality of the images requested from the server.
• Memory Buffer Size: Controls memory buffer used by Atlas. Useful for scenes with multiple 

Atlas plug-ins.
• Layer Type: Maintains transparency while stacking multiple layers on top of each other when 

a transparent layer type is selected. Selecting opaque consequently blocks anything below it. 
WMS layers tend to be transparent (e.g. power lines or flood area). This parameter is only 
visible when the Data Source is set to WMS.
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• Stop Support Margins: Retrieves additional image tiles surrounding the displayed area to 
enable immediate display of high resolution images when the user moves the image when 
set to On.

• Limit Disk Read Time (ms): Specifies the maximum time period for the plug-in to be 
occupied with loading. If while loading the tiles for the current frame, the plug-in recognizes 
that loading is taking too much time, it stops loading and renders the frame.

• Use Hysteresis: Resolves the ’flickering problem’ that may occur if the Navigator position 
moves back and forth around a point where the plug-in decides to change resolution levels. 
Hysteresis uses history data in the calculation of a point where the level should be changed, 
such that the switch for zoom in and zoom out does not happen in the same point, thus 
avoiding the flickering. If enabled, set the Hysteresis size.

• Tessellation: Increases tessellation of each tile in the Atlas plug-in. This may be useful when 
projection of the basemap differs from the projection of Atlas data source (and one of the 
projections is not linear). By using tessellation, the tile fits more accurately to the basemap 
(less distortion). Raising this parameter affects performance, so only use when distortion 
due to a difference of projections is visible and unacceptable. Only visible when Atlas is used 
under basemap. 

Communication

• Use Proxy: Enables proxy configuration parameters when set to On. Use this option when 

working an a network with proxy:
• IP: Determines proxy server IP number.
• Port: Determines proxy port number.
• Username/Password: Sets the username and password.

• Bind to IP Address: Forces the plug-in to use the IP address of a specific network card in the 
computer (used when multiple network cards are part of the computer) when set. When not 
set, it defaults to the first network connection.
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Animation

The animation properties are only valid if the Data Source is set either to My Radar or to Weather 
Decision Technologies. It gives access to advanced options on how different animation slides are 
being displayed.

3.11 C3D Terrain

The C3D Terrain plug-in displays terrain objects. The terrain is retrieved from the Viz World Server 
(WoS) when a CWMClient plug-in is added to a C3D Terrain object. When the CWMClient plug-in is 
added to the C3D Terrain plug-in, terrain tessellation parameters are enabled in 
the Miscellaneous tab of the CWMClient plug-in.

The plug-in has three views:

• C3D Terrain Properties
• Terrain
• Pyramid
• Advanced

• Buttons

Note: This plug-in is located in: Built Ins -> Geometry plug-ins -> Maps



Viz World Plug-ins Guide - 17.0

Copyright © 2019  Vizrt                                                          Page  59

3.11.1 C3D Terrain Properties

Terrain

• Height Scale Mode: Sets the height scaling option for the terrain:
• Manual: Sets the height scale manually by changing the Height Scale parameter. When 

selected, additional parameters are enabled:
• Soft: Sets the terrain surface to be softened by interpolating points over the terrain. 

This option prevents the sharp edges over the terrain surface.
• Normal: Uses the same terrain elevation values received from the server.
• Exaggerate: Applies a large scaling factor to the terrain height differences, 

exaggerating the terrain surface.
• Tiling: Does not take the terrain height into account for the map size. Setting Height 

Scale Mode to Absolute may therefore be needed for the terrain tiling, or else the tiles 

might not connect properly (due to height differences).
• Globe: Draws the terrain as part of a globe and enables the Globe Radius parameter when 

set to On.
• Globe Radius: Sets the size of the globe used for drawing the terrain.

• Height Scale: Sets the scaling value for the terrain elevation. Using a low value flattens the 
terrain surface.

• Delta Z: Sets the Z axis offset for the terrain (mainly used when using the base map).

Pyramid
A Pyramid is a set of map textures in different resolutions, used for zooming into a defined area. 
When the camera is far from the map, a low resolution map texture is used (covering a wide area). 
As the camera zooms into the map, it zooms into an area with higher resolution texture, until the 
final map, with the highest resolution, is used. In order to enable the Atlas Pyramid parameters 

Note: The Globe and the Globe Radius parameters are disabled if Use Base Map is 
enabled (On).
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a CWMClient plug-in must be attached to its container. Note that this disables Atlas Terrain File 
Name parameter. See the Terrain editor view.

• Pyramid: Defines whether a pyramid of map textures is created for the terrain area. When 
enabled (On) the Max Height and 3D Levels parameters are enabled.

• Max Height: Defines the number of textures that are created.
• 3D Levels: Defines the number of terrain objects that are created.

• Blend Textures: Defines whether the edges of the maps are soft, blending into the larger 
map of the pyramid. When enabled (On), the edges are softened and the Blend 

Amount parameter is enabled.
• Blend Amount: Defines the amount of softness added to the map edges.

• Rebuild Pyramid: Builds the pyramid levels.

Advanced

Note: The parameter Rebuild Pyramid is enabled only if Pyramid is enabled (On) and it 
is visible in all tabs.
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• Sampling Resolution: Defines the number of points used to calculate the terrain. The higher 
the sampling resolution, the less detail shown. When Pyramid mode is enabled (On), this 

parameter is disabled.
• Use Base Map: Defines the geographical referencing of the terrain. If Use Base Map is 

enabled (On), the terrain moves to its geographic location on the base map, and the Base 

Container parameter is enabled.
• Base Container: Uses the first map above the C3D Terrain container in the hierarchy as 

the base map if empty and Use Base Map is set to On. To use a specific map as the 

base map, drag a map container to the Base Container place holder. If Use Base Map is 
set to Off, the Globe parameter is enabled and the terrain is drawn as part of a globe. 

Set the Globe Radius to modify the terrain size and curve.
• Wireframe: Displays the terrain as wireframe.
• Sides Smoothing: Draws the edges of the terrain as flat lines (height is zero) when 

enabled (On). This option is useful when using the terrain object over the base map. When 

enabled (On), additional parameters are enabled:

• Sides Smoothing Factor: Defines the width of the area, close to the edges, that is 
interpolated to create the smooth transition from terrain info to a flat edge.

• Uniform Smoothing: Applies smoothing for all sides. Enabling Uniform smoothing (On), 

sets smoothing for all sides, and hides the individual parameters. Available individual 
parameters are; Left, Right, Top and Bottom smoothing.

• Texture Compression: Sets the compression level for the texture (DTX5 is the highest 
compression level; hence, less texture quality).

• Terrain Status: Displays the terrain object status. If the terrain object was rebuilt 
successfully, the indicator displays OK, otherwise, the indicator displays Not Built.

3.11.2 Buttons
• Rebuild: Forces a rebuild of the geometry, which is necessary when changing parameters 

that cannot be updated in real time.
• Freeze Terrain: Saves the terrain image and data as Viz images for faster loading and for 

archiving.

3.12 GeoChart

The GeoChart plug-in represents geo-located values as 3D bars on a map. The data format can be 
a grid of geo positions (locations with constant distances from one another) or a list of 
coordinates. In addition, data may be split by timeframes and the plug-in is able to animate the 
data chart throughout the frames.

In order to use GeoChart, it should be put beneath the geo reference and load data (see Supported 
Formats). GeoChart adds the GeoChart Shader plug-in to the container automatically.
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3.12.1 GeoChart Properties

General

• Load Data: Selects the data file to be loaded.
• Frame Number: Allows selecting the desired timeframe with this control when data comes in 

frames (see Supported Formats).
Please note that although it is possible to animate data through the Frame Number 
parameter it is not recommended because when the frame is switched the data is read from 
the hard disk such that such an animation is more performance consuming. Moreover there 
is no interpolation between frames such that the animation jumps from timeframe to 
timeframe. Use Animation Timeline instead.

• Animation Mode: Analyzes the whole frame sequence and builds an animation if the data 
has timeframes. The data is interpolated smoothly between the frames such that the 
animation looks smooth.

• Animation Timeline: Animates data through timeframes when an animation is built.
• Animation Buffer Size: Defines the size of the memory buffer in which the created animation 

is stored. If the buffer size is less than that required to build the animation from all the 
available frames, then not all of the frames are included (You can check the total available 
frames by dragging the Frame Number parameter to the right and seeing the largest frame 
shown, and the frames included in the animation by dragging the Animation Timeline 
parameters to the far right).

• Bar Type: Defines the geometry of the bar. Please note that Cylinder geometry is the most 
performance consuming while Prism is the lightest.

• Bevel Bars: Bevels bars edges.

Note: This plug-in is located in: Built Ins -> Geometry plug-ins -> Maps_Adv
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• Bar Height: Scales the height of the bars.
• Bar Width: Scales the width of the bars.
• Bar Length: Alters bar’s length starting from the bottom.
• Mask Source: Clips data to a specific region such that only bars inside the region are seen. 

For this purpose a mask image is required. You can drag the image into the Mask rectangle 
in the Image option or specify a container with a mask image in the Container option. 
See Creating Mask Images.

• Rebuild: Reloads the parameter values after a change. Only three parameters of the 
GeoChart plug-in can be changed on the fly: Bar Height, Bar Width and Bar Length. Altering 
other parameters requires a Rebuild.

Color

• Logarithmic Color: Applies logarithmic scale to a color transform. This may be used when 
the data has dramatic differences between low and high values (in such cases the high 
values are red by default and all the low values are blue). Logarithmic scale makes this 
difference less dramatic, such that more in-between colors appear on lower values. An 
example of such data may be world population density. In large cities this value is 
considerably higher than in its surroundings, making it difficult to see less dramatic 
differences in low population areas.

• Set Input Range: Constrains input range to a specified Input Minimum and Input 
Maximum value. All values below the minimum are interpreted as lowest possible bar height 
(zero by default) and all values higher than the maximum are interpreted as a maximum bar 
height. Note that when Set Input Range is pressed the actual minimum and maximum data 
values from the loaded data are seen.

• Colors: Defines the color map by choosing colors and a number of in-between color ramp 
stages.
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• Color Image: Uses an image to define the color map. The image must be dragged to this 
control. An example of an image defining color map:

• Posterization: Enables a continuous color map to be split into a desired number of discreet 
colors.

Advanced

• Bar Response: Defines which property of the bar is affected by the value it represents.
• Logarithmic Data: Puts the values that the bars represent on the logarithmic scale. This gives 

a better indication of differences between low values, and makes the difference between low 
and high values less dramatic. May be useful in cases where there is a large difference 
between low and high values. (e.g. world population density). Consider using this option in 
combination with the Logarithmic Color option under the Color tab.

• Data Simplification: Resamples the data and create different resolution levels to show lower 
resolution from farther distance. Moreover, data is spit into tiles by a culling mechanism. 
The data file that is being loaded to a plug-in may contain a huge amount of data and can 
become very performance intensive during rendering. This parameter defines how may 
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resolution levels are created out of the original data, and therefore effects loading time and 
the animation built process.

• Fix To Resolution Level: Uses a fixed resolution level, selected by the Resolution 
Level parameter. In some cases you would not like the data to be resampled, since this 
means a loss of some information. A zero value means that raw data is used. Raw data is not 
resampled and not split to tiles.

• Invert Output: Gives maximum values the lowest bar heights and vice versa.
• Output Minimum: Defines the height of the bar representing the minimum found value.
• Output Maximum: Defines the height of the bar representing the maximum found value.
• Use Input Range: Defines the input range such that values lower than Input Minimum are 

considered as having the Input Minimum value, and values higher than Input Maximum are 
considered as having the Input Maximum value. This may be useful when focusing on a 
specific range in values.

• Clip Data: Enables clipping the bars representing values lower or higher than defined in 
the Clip Bottom and Clip Top parameters. Note that when this button is switched to On, the 
Clip Bottom and Clip Top controls appear with values corresponding to the actual minimum 
and maximum found values in the data.

3.12.2 Supported Formats
The following formats are supported:

• ASC File
• Viz Weather Data Format
• TAB File

ASC File
In the *.asc format, the ascii file represents a grid of values in defined geographic range, defining 
the number of rows and columns of such data. For example, the following shows a part of a file 
showing a grid of world values:

ncols         360 
nrows        180 
xllcorner     -180.0 
yllcorner     -90.0 
cellsize      1.000000000000 
NODATA_value  -9999 
-9999 -9999 -9999 0.1252774 0.1192886 …

Note: Unlike using input range, the clipped bars are not seen at all rather than just 
representing minimum and maximum values defined in clipping.
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Viz Weather Data Format
The data is contained in one *.ini file and a corresponding list of binary files representing each 
timeframe. This data format enables the creation of an animation through timeframes. The .ini file 
defines what to expect from the binaries, including the region, projection and resolution (distance 
between samples of a grid data). The binaries are a list of values corresponding to one timeframe 
in float precision. Example of *.ini file:

[Grid] 
ModelType=GFS 
ModelName=GFS 
DataName=Temperature 
DataType=TEMPERATURE 
FileType=BINARY 
FromTime=201204102100 
ToTime=201204132100 
TimeStep=180 
Region=-180.000000/180.000000/-90.000000/90.000000 
Resolution=1 
Compression=UNCOMPRESSED 
[Projection] 
Type=UNPROJECTED 
[Files] 
File0=grid_0.b 
File1=grid_1.b 
File2=grid_2.b 
[Times] 
Time0=201204102100 
Time1=201204110000 
Time2=201204110300 
[Mins,Maxs] 
Vals0=-64.059998,37.739994 
Vals1=-63.859997,35.239994 
Vals2=-64.260010,36.139988

TAB File
The *.tab format is used for non-grid type data. It contains a list of data samples defining the date, 
hour, coordinate and value of each. The first time such data is read, it is processed such that all 
the samples corresponding to the same hour represent one timeframe, and the processed data 
is saved as a cache (in the same folder where the *.tab file is located) containing a *.bin header file 
and numerous *.dat files each corresponding to one frame. (The filenames of *.dat files define the 
date and hour they represent). For example:
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2013-06-29 00 -90.087890625 179.912109375 112 
2013-06-29 00 -41.30859375 174.7265625 1 
2013-06-29 01 -40.95703125 174.814453125 1 
2013-06-29 01 -39.0234375 -68.115234375 2 
2013-06-29 01 -38.759765625 -72.685546875 1 
2013-06-29 02 -38.49609375 -63.6328125 1 
2013-06-29 02 -38.232421875 144.31640625 7 
2013-06-29 02 -37.96875 145.107421875 1 
2013-06-29 02 -37.880859375 144.931640625 32

3.12.3 Creating Mask Images
A mask image is created with the help of the CWMClient plug-in.

The image should correspond exactly to a georeference on which GeoChart is placed, so the 
basemap region must be defined in the CWM plug-in. In the case when Atlas is used as 
georeference, put it beneath the CWM so that it corresponds exactly.

1. Go to the CWM plug-in defining the georeference and change the Texture Compression
parameter to None. You can find it under the Texture tab.

2. Open Viz World Map Editor and select the desired region.
3. Put the Map Layers Control plug-in on a container with CWM (the georeference).
4. In the Map Layers Control plug-in, switch Control to Enable and deselect all of the options 

except the Selected Regions, and press Refresh Map.
5. Go to CWM Client’s Miscellaneous tab and press Freeze.
6. Drag the resulting image from the container to the image pool. You can now use it as a 

mask for the selected region. You can unfreeze the CWM, remove Map Layers Control and 
change back the texture compression, but be careful not to change the size and range of the 
georeference map.

3.12.4 Examples

Example Description

Weather precipitation data.

Weather precipitation data clipped to a region.
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Example Description

Social TV scene showing population of a particular word in 
Twitter.

Weather precipitation data on the globe.

World temperature values.

3.13 GeoImage

The GeoImage plug-in enables geographic referencing options. The plug-in is used as a base 
object with maps. GeoImage is short for Geographical Reference Image.

The plug-in has three views:

• GeoImage Properties
• Basic
• Pyramid
• Advanced

Note: This plug-in is located in: Built Ins -> Geometry plug-ins -> Maps
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3.13.1 GeoImage Properties

Basic

• Use Base Map: Defines the geographical referencing of the GeoImage. If Use Base Map is 
enabled (On), the GeoImage moves to its geographic location on the base map and resizes 

accordingly.
• Map Size: Sets the size of the GeoImage geometry if Use Base Map is set to Off.
• Tessellation: Changes the number of triangles of the rendered filecard to increase the visual 

quality.

• Base Container: Uses the first geo-referenced map above the GeoImage container in the 
hierarchy as the base map if empty. To use a specific map as the base map, drag a map 
container to the Base Container place holder.

• Delta Z: Sets a Z offset for the GeoImage geometry.
• Map Status: Displays the status of the imagery and whether the imagery contains geo-

referencing.
• Apply Fade Plugin: Applies a Fade Texture plug-in to the container when clicked.

Note: The number of triangles affect the performance of the system.
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Pyramid

• Pyramid: Uses local parameters when to set to None or Local. When set to Global, it uses the 
parameters as defined in the Hops Manager.
Map Style: Defines the map style to be used for the pyramid maps:

• Source: Uses the top CWMClient container (Map Tiler) style selection when creating the 
pyramid maps.

• Target: Uses the hop CWMClient style selection when creating the pyramid maps.
• Split: Splits the pyramid layers style, based on image latitude and longitude size. If the 

image size is smaller then the threshold the target style is used, if larger then the 
source style is used. Additionally, it is possible to turn on the color correction option 
in Pyramid Control which color corrects the target image to match the source images. 
Set the Satellite Threshold (deg).

• Max Pyramid Height: Defines the maximum number of maps that are created in the pyramid. 
The optimal number of pyramid maps is calculated by the Map Pyramid plug-in. If the 
optimal number exceeds the Max Pyramid Height value, then the plug-in generates the 
maximum number defined.

• Pyramid Factor: Calculates the number of maps required defining the size factor between the 
maps of the pyramid.
Pyramid Steps: Defines how the map coverage area grows from pyramid to pyramid:

• Equal: The size factor is based on map pyramid height, pyramid factor and the 
resolution difference between the base map and the final map. The actual number 
might be different than the pyramid factor. The number of levels might also be 
smaller than the max pyramid height

• Constant: Uses the value of the pyramid factor as is, with the value of max pyramid 
height.
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• Create Hole: Creates a hole on each pyramid tile.
• Image Aspect: Calculates the closest power of two size, based on the selected image size of 

the CWMClient plug-in texture size. Target uses exactly the same size as 
the CWMClient plug-in texture size.
Note: It is recommended to use this setting to improve performance.
Apply Fade: Defines whether the maps used in the pyramid uses soft edges. Available 
options are Off, Target and Pyramid.

• Off: Does not use soft edges. The transition between the maps is visible (the maps 
have sharp edges).

• Target: Sets the last map (target) to have soft edges only.
• Pyramid: Sets all maps in the pyramid to have soft edges.

• Fade Range: Sets the fade level (the area of the image that the fade is applied to) when 
the Apply Fade parameter is used.

• Texture Compression: Selects one of the required compression modes for the images.
• Hide Lower Resolution: Defines whether the map created by the CWMClient plug-in, located 

on the Map Pyramid container, is turned off when the texture resolution of that map is lower 
than the Globe or GeoImage map tiles resolution. If it is enabled (On), the maps with lower 

resolution is turned off automatically by the Map Pyramid plug-in. If it is disabled (Off), the 

Map Pyramid does not turn off the low resolution maps.
• Map Status: Determines the status of the map.

Advanced
When the Use Base Map option on the Basic tab is turned on, the Advanced tab displays 
parameters for cropping the imagery applied on this container.

• Crop Mode: Defines whether the GeoImage is cropped:
• None: Does not crop the map.
• Manual: Sets the crop values using manual values for the map: West and East set the 

Longitude value for the western and eastern edge of the GeoImage 
map. North and South and set the Latitude value for the northern and southern edge 
of the GeoImage map.

• Base Map: Crops the GeoImage according to the base map, that is, if the GeoImage 
exceeds the base map edges, it is cropped accordingly.
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3.14 Globe

The Globe plug-in enables geographic referencing options over a globe. The plug-in is used as a 
base object with maps. The globe object geographically references the map at the correct location 
over the globe.

This page contains information on the following topics:

• Globe Properties
• Basic
• Pyramid
• Advanced

• Buttons

Note: This plug-in is located in: Built Ins -> Geometry plug-ins -> Maps
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3.14.1 Globe Properties

Basic

• Tessellation: Defines the number of polygons used to create the Globe geometry.
• Radius: Defines the radius of the globe.
• Map Status: Reports if the map was loaded as expected (Ok), geographic referencing of the 

map, and so on.

Pyramid

• Pyramid: Uses local parameters when to set to None or Local. When set to Global, it uses the 
parameters as defined in the Hops Manager.

• Map Style: Defines the map style to be used for the pyramid maps:
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• Source: Uses the top CWMClient container (Map Tiler) style selection when creating the 
pyramid maps.

• Target: Uses the hop CWMClient style selection when creating the pyramid maps.
• Split: Splits the pyramid layers style, based on image latitude and longitude size. If the 

image size is smaller then the threshold the target style is used, if larger then the 
source style is used. Additionally, it is possible to turn on the color correction option 
in Pyramid Control which color corrects the target image to match the source images. 
Set the Satellite Threshold (deg).

• Max Pyramid Height: Defines the maximum number of maps that are created in the pyramid. 
The optimal number of pyramid maps is calculated by the Map Pyramid plug-in. If the 
optimal number exceeds the Max Pyramid Height value, then the plug-in generates the 
maximum number defined.

• Pyramid Factor: Calculates the number of maps required defining the size factor between the 
maps of the pyramid.

• Pyramid Steps: Defines how the map coverage area grows from pyramid to pyramid:
• Equal: The size factor is based on map pyramid height, pyramid factor and the 

resolution difference between the base map and the final map. The actual number 
might be different than the pyramid factor. The number of levels might also be 
smaller than the max pyramid height

• Constant: Uses the value of the pyramid factor as is, with the value of max pyramid 
height.

• Create Hole: Creates a hole on each pyramid tile.
• Image Aspect: Calculates the closest power of two size, based on the selected image size of 

the CWMClient plug-in texture size. Target uses exactly the same size as the 
CWMClient plug-in texture size.

• Apply Fade: Defines whether the maps used in the pyramid uses soft edges. Available 
options are Off, Target and Pyramid.

• Off: Does not use soft edges. The transition between the maps is visible (the maps 
have sharp edges).

• Target: Sets the last map (target) to have soft edges only.
• Pyramid: Sets all maps in the pyramid to have soft edges.

• Fade Range: Sets the fade level (the area of the image that the fade is applied to) when the 
Apply Fade parameter is used.

• Texture Compression: Selects one of the required compression modes for the images.
• Hide Lower Resolution: Defines whether the map created by the CWMClient plug-in, located 

on the Map Pyramid container, is turned off when the texture resolution of that map is lower 
than the Globe or GeoImage map tiles resolution. If it is enabled (On), the maps with lower 

resolution is turned off automatically by the Map Pyramid plug-in. If it is disabled (Off), the 

Map Pyramid does not turn off the low resolution maps.
• Map Status: Determines the status of the map.

Note: It is recommended to use this setting to improve performance.
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Advanced

• Sub Tessellation: Divides each of the Globe flat areas, to increase texture coordinates and 
improve the way the textures look on a globe.

• Texture Mapping: Defines how the texture (map) is mapped over the Globe:
• Absolute: Crops the globe object according to the values set in the West, East, South 

and North parameters.
• Relative: Crops the globe object according to the geographical properties of the map 

applied to the Globe.
• GeoRef: Maps the map over the globe object according to its geographical properties.

• West/East: Sets the Longitude value for the western/eastern edge of the Globe. The globe 
object is cropped at that Longitude.

• South/North: Sets the Latitude value for the southern/northern edge of the Globe. The globe 
object is cropped at that Latitude.

• Enable Hole: Saves performance when building pyramids using globe objects. When the 
globe objects for the pyramid layers are created, a hole is created where the higher 
resolution maps are, to avoid rendering multiple pixel layers (and to save performance). It 
can be used manually to create a hole in a globe object by setting values which are in the 
area of the map in use. When enabled (On) additional parameters are enabled:

• Hole West (From lon): Defines an inner Longitude in the map area where the hole 
begins (West side).

• Hole East (To lon): Defines an inner Longitude in the map area where the hole begins 
(East side).
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• Hole South (From lat): Defines an inner Latitude in the map area where the hole begins 
(South side).

• Hole North (To lat): Defines an inner Latitude in the map area where the hole begins 
(North side).

• Avoid Radius Cheat: Contains a Radius setting that can be avoided if required.

3.14.2 Buttons
• Build Pyramid: Rebuilds the pyramids. 

If Pyramid is set to None in the Pyramid tab, then the available buttons are:

• Apply Fade Plugin: Applies a Fade Texture plug-in to the container when clicked.
• Face Z Axis: Rotates and centers the globe object facing the Z-axis. This button can be used 

when not a full globe is rendered (for example only Asia). Do not use this feature with 
the Navigator plug-in, as it assumes no rotation.

3.15 Label And Go

The Label and Go plug-in draws multiple labels on screen. It is mainly used for interactive scenes, 
but it can also be used for regular scene design. Traditionally, label drawing has been done by 
repeatedly copying a design. This method gives you full control over the look of the label, but 
limits the number of labels which can be used as every label has at least two containers. Also, if 
the number of labels exceed 500 containers, it may cause a performance issue.

Label and Go gives fewer options for design, but since all design is done for one container 
performance is still good using 70,000 labels.

This page contains information on the following topics and procedures:

• Label and Go Properties
• Global
• Design

• Caption
• Background
• Pointer

• Communication
• Shared Memory Communication with Label and Go

Note: This is a very advanced feature which should be used with caution.

Note: This plug-in is located in: Built Ins -> Geometry plug-ins -> Maps
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• Example
• Working with Label and Go

• To Create a Label and Go Scene
• To Use Viz Config for Interactive Communication
• Notes

3.15.1 Label and Go Properties

Global

• Data source: Defines the type of source the plug-in should render. Label and Go supports 
the following data sources:

• Auto labels: Uses labels of the entire world.
• CWM labels: Uses labels created by the CWMClient plug-in.
• Streets: Uses street labels (created by the 3D Road Manager or CWMClient plug-in).
• Other: Uses other labels. Currently Viz World supports the KML plug-in.
• Local file: Determines the shape file that contains names and geo positions.
• Shields: Allows the designer to set designs for road types such as highways, 

interstates, etc., and to use an iconic representation of the street instead of the street 
name. This is based on street data and currently only supports Tom-Tom data for the 
USA. During import of the street data, a CSV file is created under 
plugin\data\maps\DesignMappings, which contains all the types of shields found in 
the data. The Mapping column in this file can be edited to map the shield types to 
specific user designs, and then the Label and Go plug-in is used to read the file.

• Labels Draw Style
• On Map: Places the labels on the same camera as the navigator camera.
• Overlay: Places the labels on the second camera (normally front layer).

• Alpha fade time: Determines the amount of time (fields) for new labels to appear or 
disappear.

• Max number of labels: Determines the maximum number of label to render including all the 
labels so far (other Label and Go are taken into account as well).
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• Culling bounding box: Scales the real bounding box to avoid too many labels on screen.
• Line spacing: Determines line spacing when using two lines.

Design

• Font: Sets the font used by all labels.
• Label Type: Selects from the default types of labels when using auto-labels on Data Source 

(Country, Capital, etc). Using POI-1, POI-2 and so on, allows definition of the name of the 
style, for example: Earthquake, Explosion, etc.

• Render: Renders the selected label design type (e.g. Country, POI-1 and so on) when set to 
On.

• View Distance: Sets the distance from where the label style should be visible.
• Set Distance: Sets the View Distance property based on the current distance of the map.
• Priority: Overwrites the default priority which is based on type and town size.
• Caption/Background/Pointer: The Caption, Background and Pointer properties are different 

for each type of design, and are described below.
• Buttons

• All Off: Turns off all labels, except the one currently being edited.
• All On: Turns on all labels.
• Copy setting from type above/below: Copies the settings from the label type above/

below.
• Outline Quality: Determines the quality when background is set to outline.
• Outline Quality Mask: Selects the mask to use so it does not interfere with the scene regular 

makes.
• Debug: Draws a green rectangle around all/current labels. (useful to see the bounding box).
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Caption
• Caption

• Hide: Displays only the pointer of each label.
• Show: Displays both the pointer and the text of each label.

• Text color: Sets the color of the text.
• Text Size: Sets the size of the text. Text size influences all sizes.
• Max size: Limits the size of the text on either X or X/Y axis when set to either Scale X or 

ScaleX/Y.
• Max width: Sets the maximum width the text should take and scales the text either on X or 

XY based on the Max Size setting.
• X/Y Offset: Offsets the text on X/Y from its latitude and longitude.
• Rotate: Rotates labels to follow the street when set to On. When set to Off they are not 

rotated.

Background
• Background: Defines the background type for the text (none/rectangle/image/outline).
• Size: Sets the size of the background in relation to the text in percent (%).
• Image: Sets a background image for the text.
• Background color: Sets the background color.
• Outline color: Sets the outline color.
• Outline width: Sets the outline width.
• Background Fixed Size, Background X, Background Y: Defines the X/Y size of the 

background when set to fixed size.

Pointer
• Point: Sets the type of point.
• Caption position: Sets the position of the label in relation to the point.
• Point Color: Sets the color of the point.
• Point Size: Sets the size of the point.
• Point Distance (%): Sets the distance of the label in relation to the point in percent (%).
• Point BG: Enables (On) or disables (Off) the Point BG properties.

• Point BG Color: Sets the points background color.
• Point BG Size (%): Sets the points background size in percent (%).
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Communication

• Interactive Mode: This property is here for backwards compatibility only. The recommended 
way is to use the MTButton plug-in instead. (For more information on MTButton, see the Viz 
Artist User Guide).

• Shared Memory Type: Changes between Scene-, Global- and Distributed-Shared Memory.
• Shared Memory Identifier: Sets the Shared Memory key name.
• Set Data Pool: Enables the distribution of the data to a DataPool structure using the same 

name as the Shared Memory Identifier.

Shared Memory Communication with Label and Go
To send labels via shared memory to Label and Go, you need to send:

Id,Label,long,
lat style ( optional )

Each label must start with id.

Example

dim Variable as string 
dim array as Array[string] 
\qMy data separated my new line 
dim data as String = GetParameterString("Data") 
data.Split("\n\r", array) 
\qDepending on label@Go setting 
Variable = "LABELANDGO_" 
Variable.Append("ADDLABELS")
Scene.Map[Variable] = array

http://docs.vizrt.internal/viz-artist
http://docs.vizrt.internal/viz-artist
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3.15.2 Working with Label and Go

To Create a Label and Go Scene

1. Add the Atlas plug-in to your scene tree.
2. Add the Navigator plug-in to the same container as the Atlas plug-in.
3. Open the Navigator editor, click Miscellaneous and set Interactive Mode to Always.
4. Add a sub container to the GeoReferenceMap.
5. Add the Label and Go plug-in to the new container.

6. Click the Scene Editor’s E button. E enables the handling of interactive script/plug-in events. 
Interactive scripts and plug-ins are those related to mouse or keyboard actions.

7. Click the scene and zoom in and out with your mouse to see the labels appear.
8. Open the Label and Go editor to test the settings.

To Use Viz Config for Interactive Communication
When using MTButton for interactivity together with Label and Go:

1. The input method from Viz Config is used (e.g. Win 7, PPI, TUIO, mouse).
2. The clicked label on the map is published to shared memory.

Notes
• All data sources may select from ten different designs.

Note: For more information on MTButton, see the Viz Artist User Guide.

http://docs.vizrt.internal/viz-artist
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• There are currently no limits as to how many Label and Go plug-ins can be used by one 
scene.

• Label collision is calculated and taken into account. Other types of labels (e.g. design using 
the Street Labels plug-in) are not taken into account.

• Label and Go currently works on flat maps only.

3.16 Pyramid Control

The Pyramid Control plug-in sorts overlapped layers of the pyramids in the scene such that tiles 
with higher resolution are not hidden by tiles with lower resolution.

3.16.1 Pyramid Control Properties

• Fade Tiles: Applies a fade animation to each tile level based on the distance to the hop when 
enabled.

• Start/End Fade (%): Sets the distance (percentage) to the hop for starting and ending the fade 
when Fade Tiles is enabled.

• Bind to Hop: Synchronizes the visibility of pyramids based on the hop that they belong to 
when enabled. When disabled (default), the pyramids are shown based on the highest 
resolution available throughout the entire scene.

Note: The plug-in must be located in the hierarchy of the Map Tiler plug-in.

Note: This plug-in is located in: Built Ins -> Geometry plug-ins -> Maps
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• Pyramid Fade Start (%): Determines the duration that the pyramids are fully visible, in 
percentage of total hop time.

• Target Fade Start (%): Determines the duration that the target image are fully visible, in 
percentage of total hop time.

• Pyramid Fade Length (%): Determines the time taken for pyramids to fade, in percentage of 
total hop time.

• Target Fade Length (%): Determines the time taken for target to fade, in percentage of total 
hop time.

• RenderTile: Selects which pyramid image to display, from all the pyramid levels. Used mainly 
for debugging the graphics.

• Wire Frame: Shows the pyramids in wire frame mode, to help understand the coverage of the 
pyramids. Used mainly for debugging the graphics.

• Show Bounding Boxes: Renders the bounding box of the pyramids.
• Refresh All Pyramids (button): Forces a refresh of all pyramids for all hops in the scene.

3.17 MapScale

The MapScale plug-in displays the scale factor of the map.

Note: When using Control MultiHop, the Bind To Hop Property is set to Enabled by 
default.



Note: This plug-in is located in: Built Ins -> Geometry plug-ins -> Maps



Viz World Plug-ins Guide - 17.0

Copyright © 2019  Vizrt                                                          Page  84

3.17.1 MapScale Properties

General

• Geo Source: Bases the scale or zoom factor data on the navigator plug-in, when set to 
Navigator. When set to Map, the values are based on the defined Map container.

• Screen Size (%): Defines the screen geometry size, measured as percentage of the screen on 
the X axis.

• Height (%): Defines the height geometry, measured as percentage of the screen on the Y 
axis.

• Units: Displays units in Kilometers or Miles.
• Labeling Mode: The Large/Small Limps options try to find the closest round number in the 

visible range. While gradually zooming in or out, the rectangle containing the map scale is 
scaled according to a visible number. When the range limit is reached, the number changes 
and the rectangle jumps to a new range. This may result in an unpleasant visual effect, so 
the Continuous mode is used where the rectangle showing the scale remains unchanged and 
the numbers showing the range change continuously without jumps.

• Large Limps: Changes the text display when the scale factor changes significantly (e.g. 
1000KM, and next limp 500KM).

• Small Limps: Changes the text display when the scale factor is a smaller change (e.g. 
1000KM, and next limp 900KM).

• Continuous: Provides an exact number of the coverage area of the geometry.
• Ruler: Combines Continuous and Limps modes. While the total width of the rectangle 

remains unchanged, notches are added showing the rounded range.
• Shape: Determines the shape of the edges: Rectangular edges, Rounded Edges or Notched 

left and right. When using Notched, an additional parameter is visible for the direction for 
the notches (Up/Down/Both and the height and width of each notch).

• Expansion:
• Outline: Toggles the outline of the geometry.
• Outline Width: Defines the width of the outline when outline is enabled (On).
• Outline Color: Defines the color of the outline when outline is enabled (On).
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Advanced

• Camera: Determines the camera for placing the geometry.
• Centimeter/Meter/Kilometers/Feet/Miles Label: Defines the suffix for each unit.

3.18 Shadow Agent

The Shadow Agent plug-in is an agent for the Shadows parameters covered by the scene plug-
in Label Manager.

3.18.1 Shadow Agent Properties

• Render With Camera: Defines for which camera shadows apply.
• All: Renders shadows on all cameras (Compatible with previous versions).
• Label: Renders shadows only for the defined off screen labels camera.
• Map: Renders shadows only for the defined map camera.
• Shadow: Renders shadows only for the defined shadows camera, as defined in the 

Label Manager plug-in (Shadows tab).

Note: This plug-in is located in: Built Ins -> Geometry plug-ins -> Maps_Adv
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3.19 WindFlows

The WindFlows plug-in visualizes geo-located winds by representing it as running flows of various 
length and colors on top of a map. The flow direction corresponds to the wind direction. The plug-
in can load multiple time frames of wind velocities and directions, and produce a smooth 
animation over time.

 

This section contains the following information:

• WindFlows Properties
• General
• Color
• Advanced

• Appendix A - Showing Winds on Top of Color Heat Map
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• Appendix B - Example of Masking to Desired Region

3.19.1 WindFlows Properties

General

• Data Path: Specifies data files or relevant data (comes in u and v components). This should 
be a weather grid model data of type Wind. An hours folder of windU or windV component 
should be specified as input. 
Example: W:\DemoData\WindSpeed\EC025\windU\contourdata\hours

• Start Time / End Time: Loads only relevant data for that time frame if time frame is 
specified.

• Frame Number: Selects time frame of data. 
• Frame Interpolation Mode: Loads all available frames of animation to produce a smooth 

animation between time frames. 

• Timeline (frames): Control time progress between frames while in interpolation mode. Only 
this parameter and not Frame Number should be animated.

Note: This plug-in is located in: Built Ins -> Geometry plug-ins -> Maps_Adv

The Data Buffer Size [mb] parameter under the Advanced options limits the number 
of time frames that is being loaded to animation according to desired size. 
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• Flows: Determines the number of flows representing wind. Flows are randomly distributed 
across the canvas.

• Line Width: Defines width of strokes. Width is specified in pixels of canvas, changing canvas 
size causes flows to look as if their width was changed.

• Max Age: Defines maximum age in frames of the flows. The age (length) of each stroke is a 
random quantity; however, flows presented in area of strong winds move faster and those 
appear longer. 

• Speed: Controls general speed level of flows, although faster winds always result in faster 
flows. 

• Fade Rate (frames): Determines the number of frames it takes to completely fade out the 
stroke. 

• Canvas Resolution: Renders flows to a canvas and then this canvas is applied to map like a 
texture. This parameter allows changing the size of the canvas. Large canvases are useful 
when small zoom-ins are required without losing the resolution. Flows widths, however, are 
affected by canvas size. When using Dynamic mode, there is no reason to go 
beyond Normal canvas size.

• Normal: Corresponds to HD resolution (1920X1080). 
• High: Corresponds to 4K (3840x2160).
• Ultra High: Corresponds to 7680x4320. 

Color

• Color Source: Defines whether color presets are taken from image or a manual preset.
• Color Presets: Predefines color presets to start with. Every change sets the position to 

custom.
• Colors: Defines number of colors to be used in color-map, as well as their values.
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• Color Image: Uses an image to define the color map. Image should be dragged to this 
control.  An example of an image defining color map: 

• Posterization: Splits a continuous color map to a desired number of discreet colors.
• Color Levels: Defines number of desired levels for posterization.
• Use Flows Alpha: Allows wind strength to affect flow transparency when set to On. 

Advanced

• Wireframe: Displays a wireframe of the canvas geometry (may be useful for globe 
geography).

• Data Buffer Size (mb): Defines limit for the amount of data to be loaded to the plug-in, used 
to limit number of frames in animation.

• Invert Depth Test: Masks the desired area and shows winds only above that area. A masking 
image should be put on top of wind flows and this option enabled. See example of the result 
in Appendix B. 
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• Canvas Positioning: Defines canvas coverage behavior. Flows are actually rendered to 
canvas, and then this canvas is placed on top of geo geometry. 

• Dynamic: Calculates canvas size in each frame. Canvas is of the size of the visible 
geographic area. 

• Static: Covers basemap/data range and stays in place. As a result, if you zoom-in in 
static mode the resolution of flows deteriorates. 

• Use Window: Limits the visualization area to a specific geographic region 
manually defined by west/east/north/south borders. Enabled only in Static mode.

• Autodetect Max Value: Detects maximum value of loaded data and normalizes the 
visualization accordingly when set to On. When set to Off, it enables manual setting of the 

maximum value for normalization. All data larger than maximum defined value obtains 
maximum value for visualization (maximum alpha and color representing strongest wind).

• Clip Data: Discards flows larger or smaller of specified clipping values.
• Clip Bottom: Discards flows smaller of specified clipping value.
• Clip Top:Discards flows larger of specified clipping value.
• Adaptive Density: Reduces the number of flows dynamically according to the zoom 

level such that there are fewer flows as you zoom-in when set to On.

• Density Upper Bound/Density Lower Bound: Defines percentage of flows (out of the number 
defined in General tab) for the current visible geographic range (When value is set, the 
visible geo area at that moment is considered). Any zoom-in level below the one saved for 
the lower bound or zoom-out above the one saved for the upper bound has lower/upper 
amount of flows correspondingly. In between, the number is interpolated. 

• Render On Move: Defines behavior of the rendering during movement in dynamic canvas 
positioning mode. Since it is problematic to move canvas with already rendered data 
dynamically, add new data and still look correct a number of behaviors were defined: 

• None: Shows nothing during movement.
• Defer: Preserves the previous canvas state until movement stops.
• One Frame: Renders only one frame of flows, with the canvas being reset after each 

frame.
• Continuous: Produces a spread-blur effect. 

• Smooth: Defines smoothing quality of the flows. Be careful with Multisample HQ, as it can be 
very expensive performance-wise.

3.19.2 Appendix A - Showing Winds on Top of Color Heat Map
It is possible to show flows on top of Color heat-map representing wind strength. The IsoGrid 
plug-in is used to show heat-map and WindFlows shows flows on top of it. Some change is 
required in configuration of the fetch to produce another folder with wind data representing wind 
strength (instead of just one vector component). This folder is called windS and it should be 
loaded to IsoGrid in order to show the heat map.

Open WD Administration Tool, go to Providers Info and add the following line for each provider:

<entry name="isoScriptOutput">contours.log &amp; WindSpeed.py --dataset 
&quot;PATH_TO_DATA_FOLDER&quot; -R_MODEL_GEO_BOUNDS –I_MODEL_RESOLUTION</entry>
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• PATH_TO_DATA_FOLDER is a path to folder containing WindU and WindV folders.

• MODEL_GEO_BOUNDS are the bounds found in config.ini file of each model under ‘Region’ 

section.
• MODEL_RESOLUTION – resolution of data in degrees, also found in config.ini file. 

Example of such a line for GFSX model (0.5 degrees resolution):

<entry name="isoScriptOutput">contours.log &amp; WindSpeed.py --dataset &quot;C:
\Program Files (x86)\vizrt\vizWeather2\SharedData\FetchData\Wind\GFSX&quot; -
R-180.000000/180.000000/-90.000000/90.000000 -I0.5</entry>

As mentioned above, after adding this line fetch application should fetch three folders for wind 
data – WindU, WindV and WindS representing strength.

3.19.3 Appendix B - Example of Masking to Desired Region

Mask image is created with the help of CWM client plug-in. The image should correspond exactly 
to a georeference on which GeoChart is placed, so make sure the basemap region is defined in 
CWM plug-in (in a case when Atlas is used as georeference put it beneath the CWM to correspond 
exactly).

1. Go to CWM plug-in defining the georeference and change the Texture Compression
parameter to None. You can find it under the Texture tab.

2. Open Viz World Map Editor and select desired region.
3. Put the Map Layers Ctrl plug-in on a container with CWM (the georeference).
4. In the Map Layers Ctrl plug-in, switch Control to Enable and deselect all options except the 

Selected Regions and press Refresh Map.
5. Go to CWM client's Miscellaneous tab and press Freeze.
6. Drag the result image from container to the image pool. You can now use it as a mask for 

the selected region. You can unfreeze the CWM, remove Map Layers Ctrl and change back 
texture compression, but be careful not to change the size and range of georeference map.
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4 Container Plug-Ins
This chapter describes container plug-ins. The container plug-ins are found in five plug-in folders:

• Maps: Contains standard plug-ins.
• Maps-Adv: Contains advanced plug-ins.
• Maps-Lab: Contains experimental plug-ins. Since these plug-ins are experimental and not 

supported, they are not documented here.
• Maps-Man: Contains a set of Manager plug-ins used for batch creation of 3D Objects such as 

regions, borders, and so on.
• Maps-Obs: Contains obsolete plug-ins, installed only for backward compatibility. These plug-

ins should not be used when designing new scenes. Since these plug-ins are obsolete and 
not supported, they are not documented here.

• Tools: Contains tool plug-ins.

See the following sections for more information:

• 3D Border Manager
• 3D Line Manager
• 3D Line Tracer
• 3D Map Telestrator Design
• 3D Map Telestrator
• 3D Region Manager
• 3D Roads Manager
• Center Map
• CWMClient
• Focus On Map
• GeoDataReader
• Geo Text
• Hop It
• Hops Manager
• Hop Sync
• KML Reader
• Label and Go Assistant
• Label AddOn
• Label It
• LatLongGrid
• Locator Control
• Map Layers Control
• Map Layers
• Map Tiler
• Map Zoom
• Mouse2Memory
• Mute
• NavCom
• NavFade
• NavFinder



Viz World Plug-ins Guide - 17.0

Copyright © 2019  Vizrt                                                          Page  93

• Navigator
• NavScale
• NavSlave
• Place Finder
• Publish To Design
• Region To Texture
• Trace It
• World Position

4.1 3D Border Manager

The 3D Border Manager plug-in creates 3D Border objects based on shape files. The plug-in uses 
a 3D Border design to create borders according to the defined settings.

4.1.1 3D Border Manager Properties

• Design: Sets the 3D Border design container that is used for building lines. The design 
container should be built with a 3D Border object and a material. No special naming 
convention is required.

• Target: Defines the container to be used as the parent container for the border containers:
• Me: Builds 3D Border objects under the current container (holding the 3D Border 

Manager plug-in).
• Next: Builds 3D Border Objects under the next container (next container in the tree 

and at the same level as the 3D Border Manager container).
• Down: Builds 3D Border objects under the first child container.
• Container: Builds 3D Border objects under the container dragged into 

the Target container place holder.
• Target Container: Specifies the container that holds all the 3D Border objects.

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps_Man
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• Shape File: Defines a path to the shape file (.shp), containing the border definitions. Shape 
files are bought from vendors specialized in Geographic Information System (GIS) and holds 
the actual shape data; polygons, splines, and others.

• Simplify Threshold: Sets the detail reduction factor for the shape borders.
• Persistent Data: Defines whether the data is removed from Viz memory when the scene is 

closed or not. When enabled references are kept, and load time is quicker.
• Border Type: Defines which border type associated with the created objects. If Advanced is 

selected, additional parameters are enabled allowing the configuration of border type 
according to the data associated with the shape file.

• Borders Type: Specifies the column name that holds each border type. Country ID, 
Region ID, Sub Region ID and Coastline ID: Specifies the string in the database file 
(.dbf) that matches to each type (e.g. Country, Region and so on).

• Clear and Build: Removes all child objects of the target container and rebuilds the objects, 
using the plug-in settings.

• Clear Target Tree: Removes all child objects of the target container.

4.2 3D Line Manager

The 3D Line Manager plug-in controls and creates 3D Line objects. The plug-in uses a 3D 
Line design to create lines according to the defined settings. The plug-in allows you to build 3D 
Line in four different modes: Navigator, Command, from WME and from a Shape file.

4.2.1 3D Line Manager Properties
Selecting the Data Source defines how the 3D Line objects are created:

Navigator
Creates a 3D Line object using the hop locations defined in the Navigator plug-in. The line starts at 
the first hop location and end at the last hop location. Note that when using the Navigator as the 
data source, the 3D Line Manager should reside under the Navigator container.

Note: Shape files must be stored in individual folders.

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps_Man
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• Design: Sets the region design container that is used for building sub-regions. The design 
container should be built with a 3D Line object and a material. No special naming 
convention is required.

• Target: Defines the container to be used as the parent container for the sub regions 
containers:

• Me: Builds the 3D Line objects under the current container (holding the 3D Line 
Manager plug-in).

• Next: Builds the 3D Line objects under the next container (next container in the tree 
and at the same level as the 3D Line Manager container).

• Down: Builds the 3D Line objects under the first child container.
• Container: Builds the 3D Line objects under the container dragged into 

the Target container place holder.
• Simplify Threshold (m): Sets the detail reduction factor for the shape of the lines.
• Spline: Determines how to display the spline.
• Tessellation: Sets the degree of detail for use with spline.
• Start Hop: Determines the starting point for the hop.
• Number of Hops: Determines the number of hop points to use.
• Rebuild: Forces a rebuild on the cache files generated for the selected shape file.

Command
Creates the 3D Line object from a list of Long/Lat pairs defined by the user, for example: MyLine: 
0,0 0,50 30,30.
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• Design: Sets the region design container that is used for building sub-regions. The design 
container should be built with a 3D Line object and a material. No special naming 
convention is required.

• Target: Defines the container to be used as the parent container for the sub regions 
containers:

• Me: Builds the 3D Line objects under the current container (holding the 3D Line 
Manager plug-in).

• Next: Builds the 3D Line objects under the next container (next container in the tree 
and at the same level as the 3D Line Manager container).

• Down: Builds the 3D Line objects under the first child container.
• Container: Builds the 3D Line objects under the container dragged into 

the Target container place holder.
• Simplify Threshold (m): Sets the detail reduction factor for the shape of the lines.
• Spline: Determines how to display the spline.
• Tessellation: Sets the degree of detail for use with spline.
• Rebuild: Forces a rebuild on the cache files generated for the selected shape file.

WME Labels
Allows you to build a line between locations chosen in Map Editor Classic (WME) as WME labels (no 
line is built if WME labels are not defined). Also, the WME source container must be specified and 
refresh should be applied by clicking the Refresh button in CWMClient (Rebuild button is disabled 
in this mode). The line between the labels starts and ends in the order they where added (as seen 
in WME’s Map Details list). The first label location is the label at the top of the list, and the last is 
at the bottom of the list. Rearrange the list to create a new order.
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• Design: Sets the region design container that is used for building sub-regions. The design 
container should be built with a 3D Line object and a material. No special naming 
convention is required.
Target: Defines the container to be used as the parent container for the sub regions 
containers:

• Me: Builds the 3D Line objects under the current container (holding the 3D Line 
Manager plug-in).

• Next: Builds the 3D Line objects under the next container (next container in the tree 
and at the same level as the 3D Line Manager container).

• Down: Builds the 3D Line objects under the first child container.
• Container: Builds the 3D Line objects under the container dragged into 

the Target container place holder.
• Simplify Threshold (m): Sets the detail reduction factor for the shape of the lines.
• Spline: Determines how to display the spline.
• Tessellation: Sets the degree of detail for use with spline.
• Set Navigator Hops: Enables the scene to do a hop animation between the lines.
• Exclude Hops: Excludes the hop animation for the following labels; None, First, Last, or First 

and Last. Manual Shift allows you to define which destination is the starting point (limited to 
a selection of 30 destinations).

• Set Hops Height: Determines the height of the hops.

Shape File
Uses a shape file as data source.

Note: In WME Labels option, the 3DLineManager should be attached to the  CWMClient 
plug-in container. The Labels in the CWMClient plug-in must be enabled.
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• Design: Sets the region design container that is used for building sub-regions. The design 
container should be built with a 3D Line object and a material. No special naming 
convention is required.
Target: Defines the container to be used as the parent container for the sub regions 
containers:

• Me: Builds the 3D Line objects under the current container (holding the 3D Line 
Manager plug-in).

• Next: Builds the 3D Line objects under the next container (next container in the tree 
and at the same level as the 3D Line Manager container).

• Down: Builds the 3D Line objects under the first child container.
• Container: Builds the 3D Line objects under the container dragged into 

the Target container place holder.
• Shape File: Defines a path to the shape file (*.shp), containing the line definitions. Shape 

files are bought from vendors specialized in Geographic Information System (GIS) and holds 
the actual shape data; polygons, splines, and others. Note that shape files must be stored in 
individual folders.

• Name Column: Determines the column to search for names in the shape file.
• ID Column: Determines the column to search for IDs in the shape file.

• Compare as: Compares line types as strings or numbers. Numbers allow for a range to 
be entered.

• Line Type Column: Determines the column to search for line types in the shape file.
• Line Types: Determines line type to use when importing shape files. 
• Simplify Threshold (m): Sets the detail reduction factor for the shape of the lines.
• Spline: Determines how to display the spline.
• Tessellation: Sets the degree of detail for use with spline.
• Rebuild: Forces a rebuild on the cache files generated for the selected shape file.

Flow and Routing
Defines the Simplify Threshold and FRC level for the selected data source. Simplify 
Threshold reduces the resolution of the data from the shape file selected. FRC level (High/
Medium/Low) sets the FRC level, for example, High would draw highways and major roads.
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• Shape File: Defines a path to the shape file (*.shp), containing the line definitions. Shape 
files are bought from vendors specialized in Geographic Information System (GIS) and holds 
the actual shape data; polygons, splines, and others. Note that shape files must be stored in 
individual folders.

• Simplify Threshold (m): Sets the detail reduction factor for the shape of the lines.
• Level Target: Container placeholder for selected level of roads.
• Motorway/Freeway, Major Road, Other Major Road, Secondary Road, Local Connecting Road, 

Local Road of High Importance: When enabled (On), the plugin draws roads rated according 
to the selection in the loaded roads data.

• Rebuild: Forces a rebuild on the cache files generated for the selected shape file.
• Build Hierarchy and Data: Builds base scene hierarchy for traffic flows scene type and 

generate needed cache data from the selected shape file.

4.3 3D Line Tracer

The 3D Line Tracer plug-in works in conjunction with the 3D Line Manager, it allows to trace lines, 
build Routes of one point or two points, when the Data Source is in Flow and Routing and you have 
the correct shape file (TomTom TMC Data).

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps_Adv
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4.3.1 3D Line Tracer Properties

• Tracing
• None: No tracing.
• One Line: Traces one line. A mouse click selects a line.
• Two Points: Traces two points. The first mouse click starts and the second mouse click 

ends. 
• Continuous: Traces continuously. Hold down mouse button and drag.

• Shortest Line Holder: Container holding 3D Line to show the shortest route.
• Fastest Line Holder: Container holding 3D Line to show the fastest route.
• Picking Threshold (px): Determines the distance (in pixels) from line for picking to capture.
• Max Junctions: Determines the maximum number of junctions to pass when calculating 

shortest route before giving up (due to performance).
• Set Data Pool: Sends output to DataPool.
• Use Only TMC: Uses TomTom shape file data only.
• Shared Memory Type: Selects the shared memory area to update. Click either None, Global, 

Scene, or Distributed.
• Field Name Prefix: Determines the shared memory field name to use with DataPool.
• Start Building Route: Starts building (and recording) a route with many clicks for better 

control on the selected route.
• Pause Building Route: Pauses building (for example, to move the map) the route.
• Continue Building Route: Continues building the route.
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• End Building Route: Stops building the route.
• Rebuild from Saved Data: Rebuilds the line form the data saved in the command box above.
• Clear: Clears the contents of the line tracer.
• Picking Active: Specifies the place on the screen where can routes can be selected.  There 

are three options:
• All: Allows selecting routes anywhere on the screen.
• Inside Rectangle: Allows selecting routes anywhere inside the rectangle.
• Outside Rectangle: Allows selecting routes anywhere outside the rectangle.

4.3.2 How to Create a Scene Showing Flow and Routing 
1. Create a base map using the Atlas plug-in, add a Navigator plug-in.

2. Add a 3D Line Manager to the Hierarchy. Set the Data Source to be Flow and Routing, Load 
the correct Shape File (TomTom TMC Data) and Click Build Flow Hierarchy, Viz builds the 
data for Routing.

3. After Building this adds three containers: Flow-Data, Flow-Draw and Routing-Lines.
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4. Flow - Data: The 3DLine Tracer plug-in and the .VWBReader vmaps are added to the 
container. Underneath it adds three containers with three types of Roads: Low, Medium and 
High.

5. In the 3D Line Manager plug-in, you can set the types of Roads that enter in each group, you 
can change the Roads according to your selection.

6. In the Flow-Draw container: This are the painters that draw the data. 
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7. When there is no data, all the lines are in Group number 1 and has a light pink color.

4.3.3 How to Load the Traffic Data 
1. In the .VWBReader vmaps plug-in, change the data type to Custom, Load the VWB File (file 

that is created with the Feedstreemer -this file is updated constantly with the traffic) and 
Click Build. 

 

 

2. It draws all the data: Free flow to green, Jam to Yellow, Heavy Jam to Orange ... 
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4.3.4 How to Trace the Lines Using the 3D Line Tracer Plug-in
1. To make a selection with the mouse the Viz configuration should be Communication - Multi 

Touch input - Mouse. 

 

2. Enter the 3D Line Tracer plug-in. Select the Tracing mode: One Line: One Segment. 

 

3. When one of the segments is selected you can see the name and ID number. 

4.3.5 How to Show the Route Information
1. Add the Routing Item object to the yourscene, you can find it in the server under:  Global 

Designs. 
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2. Routing folder.  You find two Routing items:  
- GeoLocated.  
- Non GeoLocated. 
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3. Drop the Geolocated under the Map so it gets all the geo-information. 

 
Works with Datapool plug-ins.

4. By selecting a segment, it updates the Shortest panel showing the distance, the time, the 
speed and the flow type. 

 

4.3.6 Tracing Two Points 
1. Change the Tracing to Two Points, select one Point on the Map. That is the start point and 

select another point to be the end point. 
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2. It gives you two routes: One Fastest and another Shortest. 

 

4.3.7 Continuous Tracing
You can use this option to select a Route by dragging and hold the mouse 

4.3.8 How to Build a Specific Route 
Click Start Building Route, select the Route in the Map.

Note : Every click selects a segment of the Road. 
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Here you can see the route information. It can be saved into a text document and then you can 
send the information.  The Clear option is to Clear from the Scene and the Rebuild option rebuilds 
the route from saved data.

The Picking Active option specifies the place on the screen where can routes can be selected.  
There are three options:

• All: All Screen.
• Inside Rect:  Inside the Rectangle.
• Outside: Outside the Rectangle.
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4.4 3D Map Telestrator Design

The 3D Map Telestrator Design plug-in controls 3D Map Telestrator options through design setup. 
When this plug-in is added to the design its setup is imposed on the 3D Map Telestrator (i.e. 
parameters set in 3D Map Telestrator Design plug-in overrides parameters set for the 3D Map 
Telestrator), and thus it is possible to control spline type and smoothness, close option and shape 
recognition setup from a design perspective.

4.4.1 3D Map Telestrator Design Properties

• Smoothness: Allows the smoothness to define the threshold if spline is used in order to 
obtain smooth results. The higher the threshold the softer the curve is (see the examples in 
the 3D Map Telestrator Properties).

• Close Stroke: Closes strokes automatically when set to On.

• Recognize Ellipse, Square, Triangle and Line: Recognizes four shapes: Ellipse (including 
circle), square, triangle and line. When the plug-in recognizes a shape it rebuilds it to the 
ideal shape (i.e. a hand-drawn circle is replaced by a perfect circle of the same size). The Try 
Harder option means that there is more probability to recognize the requested shape (for 
example the circle may be less ideal and still be recognized) running the risk that it might 
replace shapes that are not e.g. circles. When Try Harder is enabled, only one shape can be 
recognized as opposed to the Try option which enables the plug-in to recognize multiple 
shapes simultaneously.

4.5 3D Map Telestrator

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps_Adv
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The 3D Map Telestrator plug-in enables you to draw strokes on maps (including globes) and 
arbitrary flat objects using screen input interface like a mouse or touch screen. The strokes, 
whether with geo or non-geo coordinates, may be passed to other scenes on distant computers 
through the mechanism of shared memory. 3D Map Telestrator uses 3DLine for strokes 
visualization and thus it benefits from the rich design capabilities of this plug-in. The obtained 
strokes may be smoothed to an arbitrary degree to obtain better looking final result of the 
drawing.

This section contains information on the following topics:

• 3D Map Telestrator Properties
• General
• Shape Recognition
• Examples

• Creating a 3D Map Telestrator Scene
• To Create a 3D Map Telestrator Scene

• Non Geo-Reference Telestration
• Shared Memory Mechanism
• Using Multitouch Interface
• Using Perceptive Pixel Interface
• Brush Design Using 3D Line

• Width
• Outline
• Effect
• Advanced

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps
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4.5.1 3D Map Telestrator Properties

General

• Camera: Defines working camera to accept screen input (which is useful in a scene with 
layers where more than one camera is used).

• Line Pixel Resolution: Defines the required resolution of line during drawing, such that for 
example if resolution of 5 is set strokes less than five pixel size is disregarded.

• Designs Holder: Searches beneath the selected container for the required design.
• Design Name: Selects the design to implement in the scene. A couple of designs may be 

implemented in the scene and here the desired one for current use is set. If the required 
design does not exist, the first one found is used.

• Target: Defines where to build line strokes. If the Container option is used, the desired 
container should be specified in Target Container section.

• Active: Defines when the plug-in is active. It may be switched off, active always or only be 
activated while pressing P button on the keyboard. This is useful when other interactive 
capabilities are used in the scene (for example interactive navigation) and care should be 
taken not to interfere with these modes.

• Spline: Smoothens the final result for a better look. The three spline types define three 
different methods for smoothing.
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• Control Points: Uses a spline that paths between the points of the original curve. This 
results in the smooth nice curve, but may be not accurate enough since the line 
doesn’t actually follow the original path and may deviate from it.

• Curve Points: Makes the spline path through points of interest of the original curves. 
This method may result in some artifacts causing the route to deform between points 
of interest due to the constraint that the curve must be smooth.

• Combined: Compromises between Control and Curve points (see Examples).
• Smoothness: Allows the smoothness to define the threshold if spline is used in order to 

obtain smooth results. The higher the threshold the softer the curve is (see the examples at 
the end of this section).

• Close Stroke: Closes strokes automatically when set to On.

• Control Mode: Evokes a shared memory mechanism to send and receive strokes to and from 
other 3D Map Telestrator plug-ins when set to On. 

• Shared Memory: Defines the type of shared memory:
• Global: Shares memory within the region of computer.
• Scene: Shares memory within the region of current scene only.
• Distributed: Shares memory between all the scenes and computers in the network.

• Shared Memory Name: Defines the name for connection, such that only 3D Map Telestrators 
with the same name shares data between them.

• Input Interface: Selects interface type for line creation. See further remarks about PPI and 
Multitouch use.

• Animation Control: Runs animation that is located on design container after line is created 
(mouse button released).

• Build on Load: Determines whether the lines created when the scene was saved are built 
when the scene is loaded.

• Clear/Undo/Redo: Clears the whole drawing or undoes/redoes last strokes.

Shape Recognition

• Build on Load: Determines whether the lines created when the scene was saved are built 
when the scene is loaded.

• Recognize Ellipse, Square, Triangle and Line: Recognizes four shapes: ellipse (including 
circle), square, triangle and line. When the plug-in recognizes a shape it rebuilds it to be of 
ideal shape (i.e. a hand-drawn circle is replaced by a perfect circle of the same size). The Try 
Harder option means that there is more probability to recognize the requested shape (for 
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example the circle may be less ideal and still be recognized) running the risk that it might 
replace shapes that are not e.g. circles. When Try Harder is enabled only one shape can be 
recognized as opposed to the Try option which enables the plug-in to recognize multiple 
shapes simultaneously.

Examples
Influence of the curves parameter set to original, control points, curve points and combined:

Influence of the curves parameter set to original, control points, curve points and combined:
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Influence of the smoothness parameter set to original, low, medium and high:
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4.5.2 Creating a 3D Map Telestrator Scene

To Create a 3D Map Telestrator Scene

1. Prepare a blank workspace for the new scene, go to Geom Plugins > Maps and drag an Atlas 
plug-in to the scene.

2. Open the Atlas plug-in editor, and in under Data Source switch to CMR (Curious Multi 
Resolution), and in the CMR File locator locate the CMR with the desired map. This creates a 
map to draw on. If you have an Internet connection and license for Microsoft Bing maps you 
see the world map as soon as you drop Atlas and there is no need to load CMR.

3. Go to Container Plugins -> Maps and drop the Navigator plug-in onto the same container as 
the Atlas plug-in. Remember to enable interactivity by pressing the E button (to the left of 
the scene editor). Navigation through the map is possible by pressing i button and using the 
mouse. If the map suddenly disappears after dropping the Navigator plug-in, click 
the Center Map button on the bottom of it.

4. Add a container above the one just prepared and name it LineDesigns.
5. Add a new container as a child of LineDesigns and name it Red.
6. Add the 3DLine plug-in to the Red container.
7. Open the 3D Line plug-in editor and set the Width parameter to Fixed (Pixels).
8. Set the Width’s sliding parameter to 4.
9. Switch to the Outline option on the topmost radio button row and set Outline to On and give 

it a width of 50 (Outline Width (%) parameter).
10. Add material to the container and make it red. This creates the first design for the line.
11. Add another container beneath the Red container and name it Green.
12. Add the 3DLine plug-in to the Green container.
13. Open the 3D Line plug-in editor and set the Width parameter to Fixed (Pixels).
14. Add a material with a green color to the container. This defines the second design for the 

line named Green.
15. Add a new container as a child of the Atlas container and name it Telestrator and add the 3D 

Map Telestrator plug-in to it.
16. Open the 3D Map Telestrator plug-in editor and drag the LineDesigns container onto 

the Designs Holder placeholder.
17. Set the Design Name parameter to Red (in order to choose red design).
18. Set the Active parameter to the On P position.
19. Set Shared Memory parameter to Distributed.
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20. Save the scene.

You can draw on the map by pressing the P key on the keyboard while holding the left 
mouse button down. If you open the same scene on another computer in the network, you 
should see the same drawings appearing on it too.

4.5.3 Non Geo-Reference Telestration
In the procedure on how to create a 3D map telestrator scene, the drawing was done on the map 
(the path has geographic coordinates and as such, it is placed on the same geographical route 
when sent to other computers via the Shared Memory Mechanism). The other map in the other 
scene may have different style and projection. It may also have globe geometry, and the path is 
still geographically correct.

There is an option to use 3D Map Telestrator without map and geographic coordinates. To use this 
option two conditions must be met:

• The plug-in must not be located under geo-reference (in the example scene the Atlas was 
used as geo-reference).

• The flat geometry about to be drawn on must be placed on the same container with 3D Map 
Telestrator plug-in.

4.5.4 Shared Memory Mechanism

As explained in the 3D Map Telestrator Properties section, the plug-in uses a shared memory 
mechanism in order to send and receive strokes to and from other 3D Map Telestrator plug-ins. 
For the two plug-ins to connect, they should have the same name for the shared memory data they 
are listening to. The given name should have a prefix of Telestrator_, such that when a user 
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enters the name alpha for the group of 3D Map Telestrator plug-ins, the actual name of the shared 
memory parameter is: Telestrator_alpha.

The format of data consists of a unique ID that each stroke receives, name of required design and 
data path that comes as a sequence of pairs of numbers representing longitude and latitude (when 
non-geo-reference mode is used the flat geometry’s bounding box is treated as if having the lat/
long coordinates of full world). All components of the data including design name and unique ID 
are separated by commas.

4.5.5 Using Multitouch Interface
This interface uses touch screen of Multitouch type. For the plug-in to receive information from the 
screen, the Input Interface button should be switched to Multitouch mode and a container with the 
plug-in should contain a geometry. Screen touches outside of this geometry are disregarded. If the 
plug-in is used in a non-georeference mode, there is no problem since it already contains 
geometry for drawing on. If it is used in a georeference mode, the best practice is to place the 3D 
Map Telestrator plug-in on the container with the map.

4.5.6 Using Perceptive Pixel Interface
In a case of using a Perceptive Pixel Interface (PPI) screen, the setup requires a couple of additional 
things. A special plug-in named Mt2dControl, that is a part of the PPI plug-in package, accepts and 
processes the inputs from the touch screen and the processed data is sent to the 3D Map 
Telestrator plug-in through a shared memory mechanism.

Continuing the procedure above on how to create a 3D map telestrator scene, you can add multi-
touch capabilities to your graphics scene. The procedure and example scene tree below expands 
on the aforementioned procedure.

1. Open the 3D Map Telestrator plug-in editor and set Input Interface to PPI (see Properties) 
and chose a name for a shared memory connection with the PPI interface (i.e. a PPI variable 
name). Note that this must differ from shared memory connections with other 3D Map 
Telestrator plug-ins.

2. Add the container somewhere in the scene which is not a part of any hierarchy.
3. Add a rectangle to the container and scale it to the maximum possible size.
4. Add a Mute plug-in on the container to avoid rendering it.
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5. Add a Multi-touch 2D control (Mt2dControl) plug-in on the container.
6. Open the Mt2dControl plug-in editor and set the following parameters:

• Lock Rotation to On.

• Lock Scale to On.

• Shared Memory to On.

• Shared Memory Type to Scene.

• Shared Memory Prefix should be the same as the PPI variable name in the 
3DMapTelestrator plug-in.

• Hit Coordinate Type to World.
7. Save the scene. Now you can draw lines by touching the screen.

4.5.7 Brush Design Using 3D Line
The 3D Line plug-in is used by the 3D Map Telestrator to visualize the strokes. The desired look of 
the line is set by various parameters in the design (inside the 3D Line plug-in) and it is important 
to understand these parameters to get the desired look and behavior for the line.

The following are the most important parameters:

Width
The options for the Width tab defines the width behavior of the line. Three options may be used to 
define width behavior:

• Fixed (pixels): Defines constant width of line measured in pixels.
• Scaling: Varies line width according to zoom and the minimum/maximum parameters set.
• Fixed (mm): Sets a fixed width in geographic units.
• Fade Edge (%): Applies a fade effect to the side-edges.

Outline
By using these options an outline of arbitrary width, fade amount and color can be set to a line.

Effect
When a line comes to a 3D Map Telestrator plug-in, it plays an animation running from single point 
to a full path by default. The attributes of such an animation can be set beneath this tab. The 
length of animation in time is controlled by the Animation Length parameter and if it is set to 0, no 
animation is played. A fade effect to a running edge of the line can be set by the Fade parameter.

Advanced
A couple of options are available for this tab, the most important of which are:

• Cap edges: Defines shape for the beginning and end edge of the curve.
• Height Offset: Defines an offset line from surface it is put on.
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• Update Texture Mapping: Updates line width during zooms according to the setting we 
made in Width tab, while line length remains unchanged (texture mapped on the line may 
deform). To keep same aspect ratio for the texture this option must be enabled.

See Also

• 3D Map Telestrator Design
• Using Multitouch Interface

4.6 3D Region Manager

The 3D Region Manager plug-in creates sub regions of a selected region on the map, using a 3D 
Region design. The plug-in receives the region name and gets all the sub regions of that region 
from the server or a shape file. The 3D Region design is duplicated for each sub region and 
displayed on the map.

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps_Man
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4.6.1 3D Region Manager Properties

Common

• Design: Sets the region design container that is used for building sub-regions. The design 
container should be built with a 3D Region object and a material. No special naming 
convention is required.

• Target: Defines the container to be used as the parent container for the sub regions 
containers:

• Me: Builds the 3D Region objects under the current container (holding the 3D Region 
Manager plug-in).

• Next: Builds the 3D Region objects under the next container (next container in the tree 
and at the same level as the 3D Region Manager container).

• Down: Builds the 3D Region objects under the first child container.
• Container: Builds the 3D Region objects under the container dragged into 

the Target container place holder.

Build Region
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• Build Region: Defines the source for which the 3D Region objects are created.
• Local: Builds the 3D Region objects for the container that the 3D Region Manager is 

applied to. The container must be a 3D Region object for the sub regions to be built 
for the defined region.

• WME: Enables the user to select the regions or sub-regions inside the WME.
• Shape File: Allows the user to select a shape file that contains the regions to be 

created.
• Command: Allows the user to set a command with the parameters of the regions to 

build.
• Region ID: Enables the user to show a specific region by region ID after having 

prepared the cache files.

Local
• 3D Border Visible Filter: Sets which borders should be cropped to map. Any border lower or 

equal to the selection is cropped to the map. Available options are Country, Region and 
None.

WME
• 3D Border Visible Filter: Sets which borders should be cropped to map. Any border lower or 

equal to the selection is cropped to the map. Available options are Country, Region and 
None.

• Scan: Defines what regions to display.
• Selected: Displays only the selected regions, selected by pressing the Select Region

button.
• Recursive: Displays all selected regions and their sub regions.

• Select Region (WME): Opens the World Map Editor, enabling the selection of regions to be 
used in Selection mode. Press the Select Region button to select the regions to be built.

• Select Region (Classic): Opens the Map Editor Classic, enabling the selection of regions to be 
used in Selection mode.
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Shape File

• Shape Regions: Defines how the regions are built. Available options are Merge, Split and 
Advanced.

• Merge: Creates all regions in the file as one object.
• Split: Creates all regions in the file as separate objects.
• Advanced: Enables the additional parameters Conversion File, State Column and Name 

Column. Conversion File defines a text file for converting regions indexes into region 
names. Parent Id Column, Parent Name Column and Names Column refer to columns 
in the database (*.dbf) file that comes with the shape file. The database files describes 
what is attached on the shape file. Note that database files can be opened with 
Microsoft Office Excel.

• Shape File: Defines a path to the shape file (*.shp), containing the region definitions. Shape 
files are bought from vendors specialized in Geographic Information System (GIS) and hold 
the actual shape data (polygons, splines, and others) for the container that the 3D Region 
Manager is applied to. The container must be a 3D Region object for the sub-regions to be 
built for the defined region. Note that shape files must be stored in individual folders.

• Conversion File: Determines files used to convert IDs in the file to Viz World IDs.
• Parent ID/Name Column: Determines which column which holds the ID/Name of the parent 

of the region.
• Parent Name Length: Truncates the parent name (0= no truncation).

• IDs/Names Column: Determines which column which holds the ID/Name of the region.
• Prepare Cache Files: Minimizes memory use by pre-creating of the cache files and then 

building the required regions only (directly from the cache files), instead of building large 
amounts of regions from a shape file (which may overload the system). Only prepare Cache 
Files (without loading the data to Viz) the files can be used later in Viz, based on the ID.
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Command

• Command: Builds a 3D Region object from the specified command. The command defines 
the region coordinates using pairs of longitude and latitude values. The command format is 
as follows:

<3D RegionContainerName>: Long1,Lat1 Long2,Lat2...

Region ID

• Shape File: Defines a path to the shape file (*.shp), containing the region definitions. Shape 
files are bought from vendors specialized in Geographic Information System (GIS) and hold 
the actual shape data; polygons, splines, and others for the container that the 3D Region 
Manager is applied to. The container must be a 3D Region object for the sub regions to be 
built for the defined region. Note that shape files must be stored in individual folders.

• Region ID: Sets the region’s ID for the required region.
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4.6.2 Common

• Design: Sets the region design container that is used for building sub -regions. The design 
container should be built with a 3D Region object and a material. No special naming 
convention is required.

• Target: Defines the container to be used as the parent container for the sub regions 
containers:

• Me: Builds the 3D Region objects under the current container (holding the 3D Region 
Manager plug-in).

• Next: Builds the 3D Region objects under the next container (next container in the tree 
and at the same level as the 3D Region Manager container).

• Down: Builds the 3D Region objects under the first child container.
• Container: Builds the 3D Region objects under the container dragged into 

the Target container place holder.

4.6.3 Buttons
• Clear and Build: Deletes all previously built objects and rebuilds the regions according to the 

current settings.
• Add to Existing: Builds the new objects without deleting the old 3D Region objects from the 

hierarchy.
• Clear Target Tree: Removes all objects built by the plug-in from the Viz scene hierarchy.
• Freeze All: Freezes the regions to the scene instead of recreating them on load.

4.7 3D Roads Manager

The 3D Roads Manager plug-in creates 3D Roads objects. The plug-in uses a shape file design to 
create roads according to the defined settings.
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4.7.1 3D Roads Manager Properties

• Roads Mode
• Global: Applies one set of road designs for all roads.
• Design: Uses a design per CWMClient. The Design field sets the roads design 

container that is used for building border data from a shape file. The design container 
should be built with a 3D Roads object and a material. No special naming convention 
is required.

• Target: Defines the container to be used as the parent container for the road designs when 
Roads Mode is set to Design.

• Me: Builds the 3D Roads objects under the current container (holding the 3D Roads 
Manager plug-in).

• Next: Builds the 3D Roads objects under the next container (next container in the tree 
and at the same level as the 3D Roads Manager container).

• Down: Builds the 3D Roads objects under the first child container.
• Container: Builds the 3D Roads objects under the container dragged into the Target 

container place holder. The Target Container specifies the container that holds all the 
3D Roads objects.

• Source: Selects street/road source.
• WME: Uses Viz World Map Editor (WME) using the CWM client plug-in to connect to the 

map server.
• Shape File: Determines the shape file that contains street data to use.
• Cloud Made: Loads street data from Cloud Made. This is a web service which requires 

a license.

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps_Man
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• Data Set: Loads street data from the converted data supplied by an external provider 
into Viz World format

WME
• Simplify Threshold: Sets the detail reduction factor for the shape of the roads.
• Select Streets (WME): Opens the World Map Editor.
• Select Streets (Classic): Opens Map Editor Classic.
• Labels Mode: Determines how labels are created.

• None: Does not create labels.
• Partial: Creates labels only visible on the view.
• All: Creates all labels.

• Labels Only: Creates labels only, not the roads when set to On.

Cloud Made
• Simplify Threshold: Sets the detail reduction factor for the shape of the roads.
• Labels Mode: Determines how labels are created.

• None: Does not create labels.
• Partial: Creates labels only visible on the view.
• All: Creates all labels.

• Labels Only: Creates only labels, but not roads when set to On.

Data Set
• Data Set: Location of data
• Simplify Threshold: Sets the detail reduction factor for the shape of the roads.
• Labels Mode: Determines how labels are created.

• None: Does not create labels.
• Partial: Creates labels only visible on the view.
• All: Creates all labels.
• Label & Go: Uses the Label and Go plug-in.

• Labels Only: Creates only labels, but not roads when set to On.

Shape File
• Shape File: Defines a path to the shape file (*.shp), containing the border definitions. Shape 

files are bought from vendors specialized in Geographic Information System (GIS) and holds 
the actual shape data; polygons, splines, and others. Note that shape files must be stored in 
individual folders.

• Sort Roads By: Sets the loaded roads from the shape file in a category.
• Category: Enables the user to select one predefined category of street data. 

Available Road Types are Freeways, Primary, Main, Secondary and Other.
• Advanced: Splits the data into different categories using specific string types. Road 

Type Column specifies a column name that holds each road category. Freeways/
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Motorways, Primary Roads, Main Roads, Secondary Roads and Other Roads specify 
what string in the database file (*.dbf) that matches the road type.

• Persistent Roads: Defines whether the roads data is removed from Viz memory when the 
scene is closed or not.

• Sort Roads by: Defines which road type is associated with created objects. If Advanced is 
selected, additional parameters are enabled allowing the configuration of road types 
according to the data associated to the shape file.

• Category: Enables the selection of road types. Available options are: Freeways, Primary 
Main, Secondary, Other.

• Advanced: Sets parameters according to the data in the files associated with the shape 
file. Defines the road type column and the specific road type ID in the file.

• Road Name/ID Column: Determines which column which holds the Name/ID of the road.
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4.7.2 Buttons
• Rebuild All: Rebuilds all data. If Roads mode is set to Design, 3D Roads objects are created 

from design. If Roads mode is set to Global, global 3D Roads renders built data.
• Rebuild All (force): Deletes any cache and force a rebuild of the cache as well as rebuilding 

the Viz geometry.
• Rebuild Labels: Rebuilds only the labels, but does not affect already built streets.
• Clean All: Cleans Target container from subcontainers.

4.8 Center Map

The Center Map plug-in is used with map objects to keep a point on the map in the center of the 
map object. The map is moved while the defined point remains centered. With a Flat map, the map 
is moved, but with a Globe map the globe is rotated. See also Map Tiler for more information on 
Flat and Globe maps.

4.8.1 Center Map Properties
• Position: Defines how the map is centered.

• User: Enables the user to manually define a center point by setting Map Center 
Longitude and Map Center Latitude values.

Note: The Center Map plug-in should only be applied to map objects.

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps
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• WPosition: Centers the map at the location of a WPosition container dragged into 
the Remote Container place holder.

• Navigator: Centers the map at the location of a Navigator container dragged into 
the Remote Container place holder.

• WPoint: Centers the map at the location of a WPoint container dragged into 
the Remote Container place holder.

• Map: Centers the map at the center of a dragged map into the Remote Container map.
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• Frame:

• Remote Container: When Position is set to WPosition, you must drag the container that holds 
the World Position plug-in to this field in order to get the information.

• Map Center Longitude/Latitude: Defines information for when Position is set to User.
• Local Scale: Sets the scale parameter for the map.
• Animate to Target: Animates the map whenever the longitude/latitude value changes when 

enabled. This is either with a fixed defined time or using length time, it is relative to the 
distance it has to travel to the new value.

• Animation Time: Target value (in fields) for the animation.
• Shared Memory: Writes the longitude/latitude values to the shared memory variable defined 

in the Identifier field when set to Master. When set to Client it listens for values in the 

shared memory key.
• Type: Determines the type of shared memory to use (for more information on Shared 

Memory see the Viz Artist User Guide):
• Global: Scene.Map: This is the map local to the current Scene. Every scene has one 

map that can be used to exchange data among the scripts in the Scene.
• Scene: System.Map: The system-wide map allows for data sharing among the scenes 

currently loaded into memory.
• Distributed: VizCommunication.Map: A distributed map that enables data sharing 

among the computers connected to one Viz Graphic Hub.
• Identifier: Identifier to be used for shared memory communication.

4.9 CWMClient

The CWMClient plug-in is the main plug-in for Viz World Client (WoC). The CWMClient plug-in 
launches the World Map Editor (WME) and retrieves the map from the Viz World Server (WoS) after 
the user has applied the changes to the map in WME.

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps

http://docs.vizrt.com/viz-artist.html
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4.9.1 CWMClient Properties

Texture
The texture section defines the geo map image parameters.

• Lock Aspect Ratio: Affects texture height and texture width parameters. When enabled (On) 

any change in the texture height or width affects both parameters. When disabled (Off), each 

parameter is controlled separately.
• Texture Size: Presets for texture sizes.

• Auto Adjust To Globe: Defines whether the texture size is modified when mapped on a 
globe if texture size is set to a setting other than manual. This option is used when 
displaying maps that are close to Earth’s poles.

• Adjust for Globe (advanced): Adjusts a 2D selection in WME converting it to 3D.
• Adjust for Zoom (advanced): Fetches a wider map when enabled. Normally, the selected map 

is zoomed in by approximately ten percent in order to avoid the fade area.
• Texture Width: Defines the number of pixels in the map width. When aspect ratio is locked, 

changing the texture width automatically changes the Texture Height parameter.
• Texture Height: Defines the number of pixels in the map height. When aspect ratio is locked, 

changing the texture width automatically changes the Texture Width parameter.
• Texture Compression: Sets the compression level for the texture (DTX5 is the highest 

compression level, i.e. less texture quality).
• Texture Quality

• Linear: Uses the same image resolution in the entire zoom range.
• Mipmap: Changes resolution according to the distance from the image (managed 

automatically in Viz Artist).
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• Texture Anisotropic Filter: Turns on the relevant anisotropic in the image on the same 
container with CWMClient (similar to Mipmap, above). Available settings are Off/2x/4x/8x/

16x. 

Labels
• 3D Designs & Holder: Defines the labels usage and behavior over the map, and has three 

available options:
• Disabled: Displays labels as part of the map texture. No manual definitions are 

required.
• Local: Requires manual definition of the 3D Designs & Holder path (e.g. On Map 

Designs: Vizrt/VizWorld/GlobalDesigns/Regions/)
• Global: Enables you to use a global design defined by the 3D Map Setting scene plug-

in.

Local and Global

• Visible Filter: Select All to build all labels defined in WoC. Select Visible to build only labels 
that are shown on the selected map.

• Backslash as New Line: When Enabled you can add labels with more than one line typing 
backslash (\) as a separator for each new line.

• Labels Type: Defines the source of the label designs. Available options are Dynamic and 
Scene. Selecting Viz-DB or Scene defines where the label designs are stored.

IMPORTANT! Global labels do not work with on screen labels so you still need 
to configure them (if needed).
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• Dynamic: Creates new labels dynamically based on label designs created in the scene 
itself or fetched from the Viz Graphic Hub (Viz DB). All designs are referenced by the 
On-Map Designs placeholder. When selecting labels in the Map Editor (WME), all labels 
are dynamically added underneath the CWMClient’s container and receive the correct 
label type (provided it is defined by your label design). Note that this approach does 
not allow you to use control plug-ins. As the number of labels are dynamic this 
approach does not allow you to use control plug-ins.

• Static: Does not create new labels underneath the CWMClient’s container, but instead 
uses the number of labels already defined by the designer (achieved by adding copies 
of the label designs as sub containers of the CWMClient’s container). As the number of 
labels and label types are static, this approach allows use of control plug-ins.

• Viz-DB: Uses label source from a merged object from the Viz objects library containing 
the label designs.

• Scene: Uses label source from a group container in the scene hierarchy containing the 
label designs.

• On-Map Designs: Defines the source of the labels that are displayed on the map (Local only). 
When Viz DB (Viz Graphic Hub) is selected, define the path to a merged object, containing 
the label designs, in Viz object library. When Scene is selected, drag a group container with 
the label designs to the container place holder.

• On Screen Designs: Defines the source of the labels that are displayed on a plane in front of 
the screen. When Viz DB is selected, define the path to a merged object, containing the label 
designs, in Viz object library. When Scene is selected, drag a group container with the label 
designs to the container place holder.

• On-Map Holder: Uses this container for grouping all the generated labels on the map (Local 
only). When a map with labels is selected, the plug-in duplicates the label designs and 
creates the labels. The duplicated labels are placed under the On Map Holder container.

• On Screen Holder: Uses this container for grouping all the on screen labels (labels that are 
not geo-referenced) used in the map (Local only). When a map with on screen labels is used 
and Viz is selected, the on screen label designs are copied to the holder container and the 
label information is sent to the copied designs.

3D Objects
The 3D Objects section defines the other 3D properties of objects on the map, other than labels 
(regions, roads and so on).

Note: Back slash (/) in label names are treated as a new line (carriage return).
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3D Objects and Regions

• 3D Designs & Holder: Defines whether the regions are part of the received texture or 3D 
objects. When set to Disabled, regions are displayed as part of the texture. When set 
to Local or Global the Viz-DB and Scene parameters are made available. Also, when set to 
Global, the global region designs and holder are used to create the on map 3D 
Region objects. On Screen parameters are enabled to define the on screen region designs 
and holder.

• Viz-DB: Sets region source to be a merged object from the Viz objects library, 
containing the region designs.

• Scene: Sets region source to be a group container in the scene hierarchy, containing 
the region designs.

• On-Map Designs: Defines the source of the 3D Region objects that are displayed on the map. 
When Viz DB is selected, define the path to a merged object, containing the region designs, 
in Viz object library. When Scene is selected, drag a group container with the region designs 
to the container place holder.

• On Screen Designs: Defines the source of the 3D Region objects that are displayed on a 
plane in front of the screen. When Viz DB is selected, define the path to a merged object, 
containing the region designs, in Viz object library. When Scene is selected, drag a group 
container with the region designs to the container place holder.

• On-Map Holder: Uses this container for grouping all the generated 3D Region objects on the 
map. When a map with regions is selected, the plug-in duplicates the region designs and 
create the 3D Region objects. The duplicated regions are placed under the On Map 
Holder container.

• On Screen Holder: Uses this container for grouping all the on screen regions (regions that 
are not geo-referenced) used in the map. When a map with on screen regions is used 

Note: The global designs and holder are defined in the 3D Map Setting scene plug-in.
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and Viz is selected, the on screen region designs are copied to the holder container and the 
region information is sent to the copied designs.

3D Objects and Borders

• 3D Designs & Holder: Defines whether the border line is part of the received texture or 
drawn as a 3D object. When set to Disabled, borders are displayed as part of the map 
texture. When set to Local the Viz-DB and Scene parameters are made available and the 
shapes added in the WME are drawn as a 3D object by Viz. When set to Global, the global 
border designs and holder are used to create the 3D Border objects.

• Recursive level: Sets the filter level for border details. If None is selected, all border data is 
drawn. If Region is selected, Sub Region data is not drawn. If Country is selected, region and 
sub-region borders are not drawn.

• Viz-DB: Sets the border source to be a merged object from Viz objects library, 
containing the border designs.

• Scene: Sets the border source to be a group container in the scene hierarchy, 
containing the border designs.

• On-Map Designs: Defines the source of the 3D Line objects that are displayed on the map. 
When Viz DB is selected, define the path to a merged object, containing the border designs, 
in Viz object library. When Scene is selected, drag a group container with the border designs 
to the container place holder.

• On-Map Holder: Uses this container for grouping all the generated 3D Border objects on the 
map. When a map with borders is selected, the plug-in duplicates the border designs and 
create the 3D Line objects. The duplicated borders are placed under the On Map 
Holder container.

Note: The global designs and holder are defined in the 3D Map Setting scene plug-in.
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3D Objects and Shapes

• 3D Designs & Holder: Defines whether the shapes are part of the received texture or drawn 
as a 3D object. When set to Disabled, shapes are displayed as part of the map texture. When 
set to Enabled the Viz-DB and Scene parameters are made available and the shapes added in 
the WME are drawn as a 3D object by Viz. When set to Global, the global shape designs and 
holder are used to create the 3D shape objects.

• Viz-DB: Sets the shape source to be a merged object from Viz objects library, 
containing the shape designs.

• Scene: Sets the shape source to be a group container in the scene hierarchy, 
containing the shape designs.

• On-Map Line Designs: Enables the user to add vector line data to the map. Either by using 
the draw option in the WME (Add Shape), or from selecting an existing line data (e.g. street).

• On-Map Area Designs: Enables vector area designs. This option has support for the area 
draw option in the WME.

• On-Map Line Holder: Defines the source of the 3D Region objects that are displayed on the 
map. When Viz DB is selected, define the path to a merged object, containing the shape 
designs, in Viz object library. When Scene is selected, drag a group container with the shape 
designs to the container place holder.

• On-Map Area Holder: Uses this container for grouping all the generated 3D shape objects on 
the map. When a map with shapes is selected, the plug-in duplicates the shape designs and 
create the 3D Region objects. The duplicated shapes are placed under the On Map 
Holder container.

Note: The global designs and holder are defined in the 3D Map Setting scene plug-in.
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3D Objects and Roads

• 3D Roads: Defines whether the road data is drawn on the map and the way the roads are 
drawn. Available options are None, Crop To Map and All.

• None: The roads data is not available to be drawn on the map.
• Crop To Map: Enables the Visibility Filter and Visibility Factor (%) settings, limiting the 

roads data.
• All: Loads the selected road data.
• Labels Only: Draws only the road labels.

• Crop Visibility Filter: Sets the highest level of road type that is cropped. Available options are 
Freeway, Primary, Main, Secondary and Other.

• Freeway: Crops all roads rated as freeways and lower (that is all roads) using 
the Visibility Factor.

• Primary: Crops all roads rated as primary roads and lower (that is primary, main, 
secondary and other) using the Visibility Factor.

• Main: Crops all roads rated as main roads and lower (that is main, secondary and 
other) using the Visibility Factor.

• Secondary: Crops all roads rated as secondary roads and lower (that is secondary and 
other) using the Visibility Factor.

• Other: Crops all roads rated as other roads (that is none of the above) using 
the Visibility Factor.

• Visibility Factor (%): Defines the cropping area of the roads on the map. 100% means the 
roads are cropped at the map edges and cover the entire map area. A lower value causes the 
selected road types in the Visibility Filter to be cropped (evenly from the map edges).

• Simplify Threshold (m): Applies a simplifying algorithm on road data. The number 
represents the biggest allowed error.

• Ignore Filter: Disables creation of roads that are lower or equal to the selection (i.e. Freeway, 
Primary, Main, Secondary, and Other).

• Roads Mode: Applies one set of road design for all roads (Global), or uses a design per 
CWMClient (Design).
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• Source: Sets the source for road designs. Available options are Viz-DB and Scene. Viz-
DB sets road source to be a merged object from Viz objects library, containing the 
road designs. Scene sets road source to be a group container in the scene hierarchy, 
containing the road designs.

• On-Map Designs: Defines the source of the 3D Roads objects that are displayed on the 
map. When Viz-DB is selected, define the path to a merged object, containing the road 
designs, in Viz object library. When Scene is selected, drag a group container with the 
road designs to the container place holder.

• On-Map Holder: Uses this container for grouping all the generated 3D Roads objects 
on the map. When a map with roads is selected, the plug-in duplicates the road 
designs and create the 3D Roads objects. The duplicated roads are placed under 
the On Map Holder container.

3D Objects and Advanced

• Regions Visible Filter: Defines whether all the selected regions are created (when using 3D 
regions) or only the regions that are visible on the selected map.

• Sort Regions: Defines how the labels and 3D objects are duplicated in the scene tree.
• No: Creates the duplicated labels and 3D objects in the scene tree grouped by 

geographic levels that is for each country, first the country, then the regions, then the 
sub regions, and so on.

• Ascending: Creates the duplicated labels and 3D objects created in the scene tree 
sorted by ascending geographic levels, that is first the sub regions, then the regions, 
then the country container.

• Descending: Creates the duplicated labels and 3D objects in the scene tree sorted by 
descending geographic levels, that is first the sub regions, then the regions, then the 
country container.

• Copy Map to Region: Sets if a map of the region is applied to the 3D Region object.
• Auto Borders: Defines whether borders are added automatically to the map and the level of 

the borders:
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• Off: Does not add borders.
• Highest: Draws country borders for the selected area (or region borders if only a 

region was selected).
• Intermediate: Draws region borders (or sub-regions if only a region was selected).
• Lowest: Draws sub-region borders.

• Auto Regions: Automatically adds region designs based on location.
• Off: Does not add regions.
• On Screen: Adds region on screen automatically.
• On Map: Adds adds region on map automatically.

• Auto Regions Level: Determines the level when creating auto 3D Regions.
• Set 3D Models: Determines whether the 3D models plug-in is called to generate 3D buildings 

in the selected map area.

Miscellaneous

The Miscellaneous section includes additional general parameters of the map.

• WME Aspect– Defines the aspect of the map in the WME window:
• Image: Sets the aspect by the texture size defined in the texture screen of the 

CWMClient plug-in when selected.
• User: Allows manual setting of the aspect when selected. When selected, 

the Aspect parameter is enabled. The aspect is modified by changing the aspect value.
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• Camera: Sets the aspect to be the same as the current camera in use. Selecting this 
option opens the WME in the same aspect as the current camera.

• Auto: Looks for a Navigator plug-in in the hierarchy, above the CWMClient plug-in 
when selected. If a Navigator is found, the camera aspect is used. If 
the Navigator plug-in was not found, the image aspect is used.

• Freeze: Retrieves the map from from the server and saves it as an image in the Viz image 
library and used as a static geo-referenced image when set to On. All map dynamic 

parameters are hidden.
• Obey Hops Manager: Uses settings of labels/regions/3D Objects as defined in the Hop 

Manager plug-in when set to On. When set to Off, settings are local to this CWMClient plug-

in.
• Transition Logic Mode: Requests the map from the server or cache when the scene is loading 

when set to Off. When set to On, the scene loads without requesting a map since the control 

application (e.g. Viz Trio or another external application) sends the parameters for a map to 
use. This option saves time during initialization of scenes using a dynamic map.

• Lock Project & Style: Locks the CWMClient plug-in to only use the selected TPL and style 
sheet and ignores any changes made from the WME.

• Is Linked to Master Map: Permits the CWMClient (slave) to be controlled by another 
CWMClient (master) when set to On. To control another CWMClient, drag and drop a 

container with a CWMClient (slave) plug-in onto the CWMClient (master) plug-in's Linked Map 
placeholder (see next parameter).

 

• Linked Map: Defines the map (slave) that is linked to the current map (master) in a container 
placeholder when set. The linked map is another CWMClient container that receives the 
same map as the map selected from the WME.

• Linked Map Size (%): Defines the size of the linked map as a percentage from the main map, 
that is if 50% is defined the linked map shows half of the area defined in the main map.

• Linked Type (advanced): Determines if the link type only include bounding box or should it 
include all the data (regions, labels etc.).

• Shared Memory Link: Defines which is the master (source) and client (target) when the same 
Shared Memory Identifier is used.

• Shared Memory Type: Defines the accessibility of the shared memory.
• Global: Makes shared memory accessible to all scenes currently loaded in memory. 

This is useful when working with Transition Logic scenes where your Viz World map 
can be one scene and the locator a different one and data can easily be transferred 
between the two.

• Scene: Makes shared memory accessible only locally and to the current scene. Every 
scene has one shared memory map that can be used to exchange data among the 
scripts in the scene.

• Distributed: Makes shared memory accessible to all computers connected to one Viz 
Graphic Hub.

• Shared Memory Identifier: Defines the identifier for the shared memory map.
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• URL Images: Container holding the URL Image manager which is invoked when the map 
changes.

• Always Fetch Terrain Data: Fetches terrain data always when enabled.
• Terrain Tessellation Locked: Appears when a C3D Terrain plug-in is combined with the 

CWMClient plug-in. Tessellation is the terrain resolution, which is the number of polygons 
used to build the terrain object. The higher the tessellation, the more detailed the terrain is. 
Use the Width Tessellation and Height Tessellation parameters to fine tune the quality versus 
the performance of the scene.

• When set to On, only the Width Tessellation parameter can be changed; hence, the 

setting applies for both Width and Height.
• When set to Off, the parameters can be set individually.

Imagery

The Imagery section includes multiple imagery configuration options.

• Data Source: Defines the source of the imagery. Available options are Bing (MIcrosoft Bing 
server), CMR (Curious Multi-Resolution imagery), Digital Globe (DG) or Blom.
When enabled (On) additional parameters are made available, and the WME button is 
disabled.

• Data Resolution: Available resolutions in pixels (i.e. width).
• Temp Folder: Sets a temporary download folder.
• Data Type: (Visible when Data Source is Bing). Available data types are satellite, map 

or a combined type of imagery.
• CMR: (Visible when Data Source is CMR). Defines a CMR file to be used as a source for 

the map.
• Digital Globe Projection: (Visible when Data Source is DG). Allows you to select the DG 

project. Currently available as Mercator and Unprojected.
• Longitude: Sets the map longitude.
• Latitude: Sets the map Latitude.
• CMR Units: Sets the Curious-Multi Resolution imagery’s units to degrees, kilometers, miles 

or nautical miles.
• Width (deg): Sets the area width in degrees, kilometers, miles or nautical miles.
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• Status: Displays the current CMR operation status.
• Get Image: Retrieves the defined imagery (of the area defined by Lon, Lat and Width 

parameters).
• Center Longitude Latitude: When clicked, the CMR is created with the longitude and latitude 

values as the center of the CMR.

Buttons
The following default buttons apply to the plug-in as a whole.

• Viz World Map Editor (WME): Opens the WME. WME connects to Viz World Server that is 
defined in Viz Config, and retrieves the current map or opens the defined default project if 
no map exists (fresh plug-in instance).

• Refresh Map: Re-draws the map and refreshes the related Viz objects using Viz World Client 
(WoC) plug-ins in the scene hierarchy. For example if a label design has been changed in Viz 
Artist, clicking Refresh Map redraws the map with the new label design without opening 
WME.

• Refresh Map (Force New): Recreates the map on the server and saves it to the cache. This 
operation forces the map creation, even if the map exists in the cache folder.

• WME (Classic): Opens WME Classic interface instead of the new WME

Search Order
The CWMClient can hold designs for labels and 3D objects such as regions, borders and shapes. 
As the designs can be stored in the scene or on the Viz Graphic Hub (i.e. Viz-DB), you need to 
understand the order in which these designs are searched for. The following rules apply when 
searching for designs under the Design holders.

Example I - Add Label Map Tool Bar

 
If, when using the World Map Editor or Map Editor Classic, you add a label and set the style to 
be Traffic_Accident, the search order is based on the following rules:

Note: The longitude and latitude values must be within the CMR area. If the values 
are not within the CMR area no map is created.
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1. Search the Scene - that may have multiple designs where each design has a name that 
corresponds to its design.

2. Search Viz Graphic Hub (i.e. Viz-DB) - that may have multiple designs stored in a design 
folder where each design is a merged object with a name that corresponds to the design.

First, the Scene design holder is searched (if used) in the following order:

1. By Style
2. By Design (Point_Label)
3. By Default Design (Default_Design)

This means that it searches for and uses:

1. Traffic_Accident, and if not found then
2. Point_Label, and if not found then
3. Default_Design

If none were found, the Viz-DB design holder is searched in the same order.

Example II - Add label Search Tab

 
If, when using the World Map Editor or Map Editor Classic, you search for and add a Town with 
more than one million (Towns > 1m) inhabitants as a label to the map and for the CWMClient set 
the style to Bigtown the search order is based on the following rules:

1. Search by style only if different than Place
2. By detail (Capital / Town_1m / Town_100k / Town_10k / Town_1k / Town)
3. By default town design (Default_Town)
4. By style (if = Place)
5. By default design (Default_Design)

This means that a search searches for and uses:

1. Bigtown, and if not found then
2. Town_1m, and if not found then
3. Default_Town, and if not found then
4. Place,
5. Default_Design
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Naming conventions

As there are several types of labels the following is the search order for each label type:

1. Capital
2. Town 1M
3. Town 100K
4. Town 10K
5. Town 1K
6. Town

• Search by style only if different than Place
• By detail (Capital / Town_1m / Town_100k / Town_10k / Town_1k / Town)
• By default town design (Default_Town)
• By style (if = Place)
• By default design (Default_Design)

7. Region:
• By style
• By region level (Country / Region / Sub_Region)
• By detail (Region)
• By default design (Default_Design)

8. Point Label:
• By style
• By design (Point_Label)
• By default design (Default_Design)

9. None of the above:
• Search by style only if different than Place
• By default design (Default_Design)

10. All Others:
• Search by style only if different than Place
• By detail (Region / Region_Name / River_Name ...)
• By style (if = Place)
• By default design (Default_Design)

List of details name:

• Capital
• Town_1m
• Town_100k
• Town_10k
• Town_1k
• Town
• Tourist_Attraction
• Reserve_Or_Park
• Region_Name
• Physical_Area_Name
• Physical_Water_Name

Note: Names using letters other than [a-z A-Z 0-9] are converted to _ (underscore).
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• River_Name
• Mountain_Name
• Label
• Street_Address
• Intersection
• Traffic_Incident
• Traffic_Accident
• Traffic_Construction
• Traffic_Speed
• Point_Label
• None_Of_The_Above
• Region

4.10 Focus On Map

The Focus On Map plug-in creates a single hop (high resolution map over a large referencing map) 
without using a navigator plug-in or animation. This plug-in is used when creating a large map 
(reference map) with 3D Objects over it (roads, shapes, and so on). It enables the user to display a 
high resolution area of the large map without recreating the 3D objects when changing the 
displayed area.

4.10.1 Focus On Map Properties

Common Properties
• Geometry Offset X/Y (%): Offsets from the true position of the geometry in geometry units.
• Min/Max Distance: Sets the minimum/maximum distance from the camera to the map.
• Get Map: When clicked, the camera jumps to the defined area.
• ?: Displays help.

Position
The Position Tab enables the parameters for the requested map area where the Position Source 
defines the source of the viewed area.

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps
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• Map: Fits the selected map in the Focus On Map container to the screen according to the Fit 
To Screen By selection.

• Fit To Screen By: Sets the map attribute that is used to fit the map to the screen: 
Width, Height, Min (the minimum value of the map’s width and height), Max (the 
maximum value of the map’s width and height), Average (the average of the map’s 
width and height).

• Longitude Offset: Sets a longitude offset from the center of the selected map.
• Latitude Offset: Sets a latitude offset from the center of the selected map.
• Distance Offset: Sets a distance offset from the center of the selected map.
• Pan: Sets a pan value for the camera.
• Tilt: Sets a tilt value for the camera.

• Absolute: Enables the user to manually set the parameters for the viewed area.
• Longitude: Sets the Longitude of the viewed area (center).
• Latitude: Sets the Latitude of the viewed area (center).
• Distance offset: Sets a fixed distance offset from the selected map.
• Distance: Sets a distance from the map.
• Diameter: Sets the desired view as Diameter (and not distance).
• Pan: Sets a pan value for the camera.
• Tilt: Sets a tilt value for the camera.

• Geometry: The selected map in the Focus On Map container is fitted to the screen according 
to the Fit To Screen By selection.

• Fit To Screen By: Select the 3D Region attribute that is used to fit the map to the 
screen: Width, Height, Min (the minimum value of the map’s width and height), Max 
(the maximum value of the map’s width and height), Average (the average of the 
map’s width and height).

• Longitude Offset: Sets a longitude offset from the center of the selected 3D Region.
• Latitude Offset: Sets a latitude offset from the center of the selected 3D Region.
• Distance Offset: Sets a distance offset from the center of the selected 3D Region.
• Pan: Sets a pan value for the camera.
• Tilt: Sets a tilt value for the camera.
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Camera
The Camera Tab defines the camera parameters such as camera number and minimum and 
maximum distance of the camera from the map.

• Camera: Defines the camera number that is affected by the position parameters.
• Navigation Method: Allows you to select whether the camera or the container should also 

move when a map changes position. 
• Camera: Moves the camera when the map is repositioned, potentially moving other 

objects out of frame. 
• Container: Moves the container instead of the camera, keeping other objects in view 

as the camera is still. In other words, moving the base map instead of the camera to 
see other parts of the map. This setting also means you do not have to use the front 
layer using two cameras to achieve the same effect as when moving the container. 
Borders and other elements on the map can be preloaded once for the base map, but 
this can only be done with a flat map (not a globe).

• Clipping Plane Control: Defines the selected camera’s clipping plane. 
• Static (Viz): Draws objects within the clipping plane values defined in Viz. For Viz 3.x 

see Scene Settings > Renderer > Camera Clipping Plane. 
• Focus On Map: Adjusts the clipping plane values according to the camera position. 

This is automatically done by based on the Near Distance and Far 
Distance parameters.

• Near distance (%): Defines the minimum distance of the camera from the map.
• Far Distance (%): Defines the maximum distance of the camera from the map.

If Position Source is set to Absolute then the parameter Diameter can also be set here. If Position 
Source is set to Geometry then the parameters Geometry Offset X/Y and Min/Max Distance can 
also be set here.

Note: Pan and Tilt parameters are disabled unless the  Pan and Tilt 
Animation parameter in the  Navigator plug-in is enabled ( On).
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Labels
The Labels Tab defines label parameters for how labels should be displayed.

• Labels: Defines how the labels are displayed:
• Overlay: Displays labels as a layer on the screen, but the layer is not affected by the 

camera movement when a new area is selected.
• On Map: Displays labels on the map, moving with the map as the selected area is 

changed.
• On Map Scaling: Displays labels on the map

• Label Camera: Defines the camera number used for displaying the on screen labels.

If Position Source is set to Absolute then the parameter Diameter can also be set here. If Position 
Source is set to Geometry then the parameters Geometry Offset X/Y and Min/Max Distance can 
also be set here.

4.11 GeoDataReader

The GeoDataReader plug-in gets a geodata stream or file (.shp/.kml/.kmz/.gdb/.mdb) and inserts 
the data into Viz. The plug-in can use local scene containers or the global ones that were defined 
in the 3D Map Setting for the design and data. The shapes can be grouped into different 
containers, by their geometry, or grouped together in one container.
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The names of the available services can be found inside the Name tag under FeatureType:

<FeatureType> <Name>glacier_outlines</Name> ... </FeatureType>

For example:

http://nsidc.org/cgi-bin/atlas_south?
service=WFS&version=1.1.0&request=GetFeature&typename=glacier_outlines

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps_Adv
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4.11.1 GeoDataReader Properties

General

• Source Type: Sets whether the source is a local file or a web stream.
• <Geometry> Design and Holder

• Disabled: Does not add this type.
• Local: Takes the design and the holder containers locally.
• Global: Takes the design from Graphic Hub.

• Designs Path: Sets the path to a design folder that is placed inside the Graphic Hub.
• <Geometry> Styles Field Name: Determines the name of the field that contains the style 

name that each feature has.
• <Geometry> Split

• Disabled: Groups all features in one container.
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• On: Gives each feature its own container.
• By Style: Groups features by the style name.

• Clear Existing Features on Read
• Disable: Adds the features on each Read command.
• Enable: Erases the container that holds the source features, then adds the new 

features.

Proxy

• Use Proxy: Enables proxy configuration parameters when set to On. Use this option when 

working an a network with proxy:
• IP: Determines proxy server IP number.
• Port: Determines proxy port number.
• Username/Password: Sets the username and password.

• Read: Adds the features from the proxy.
• Read and Save As Viz World Binary (VWB): Adds the features from the proxy and saves them.

4.12 Geo Text

The Geo Text plug-in displays the longitude and latitude values received from a variety of sources. 
The geographic data is displayed in two text objects (or one) defined by the longitude and latitude 
containers.
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4.12.1 Geo Text Properties
The Source defines the source of the geographic data that is displayed in the defined containers 
under the Containers tab.

• Source: Defines the source of the geographic data that is displayed in the defined containers 
under the Containers tab.

• User: Sets the value manually in the Compass, Longitude and Latitude parameters for 
the position and range values. The Compass, Longitude and Latitude parameters are 
enabled only when Position is set to User.

• WPosition: Displays the values received from the World Position plug-in on the same 
container as the Geo Text plug-in in the defined Containers.

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps
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• Navigator: Receives the geographic data from the Navigator plug-in in the scene. The 
received data from the Navigator plug-in is the location of the center of the 
Navigator point of view and the difference between the edges of the current 
Navigator map. The Geo Text plug-in also has placeholders (all requiring a running Viz 
World server) for defining the administration levels:

• Country: Gets the current Country
• Admin 1: Gets the current administration level 1 (e.g. Region)
• Admin 2: Gets the current administration level 2 (e.g. Town)
• Location: Gets the lowest administration level (e.g. Place)

• WPoint: Displays the value received from the WPosition vmaps plug-in on the same 
container as the Geo Text plug-in in the defined Containers.

• Map: Sends the center of the map data to the Longitude and Latitude containers and 
the difference between the edges of the map to the range containers when placed on a 
map container.

• Line: Sends the center of the line data to the defined containers in the Containers tab 
when placed on a 3D Line container.

• Position: Defines the position text format. Select the required format from the Degrees 
Format list.

• Range: Defines the range text format. Select the units for the displayed values and 
select the required format from the Degrees Format list. If Kilometers, Miles or 
Nautical Miles are selected, Dot or Comma can be selected as a separator with a fixed 
decimal point.
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• Containers: Defines the font objects that display the longitude and latitude values of 
the position and range:

• Longitude Position: Links to the text object displaying the longitude position 
data received from the Geo Text plug-in.

• Latitude Position: Links to the text object displaying the latitude position data 
received from the Geo Text plug-in.

• Compass: Links to an object that is rotated to show the North (based on 
navigator direction).

• Longitude Range: Links to the text object displaying the longitude range data 
received from the Geo Text plug-in.

• Latitude Position: Links to the text object displaying the latitude range data 
received from the Geo Text plug-in.

• Legend: Scales view width and view height values based on the object used for 
the legend.

• Length: Links to the text object displaying the length of the line object as 
received from the Geo Text plug-in.

4.13 Hop It

The Hop It plug-in is a utility plug-in which connects the specific design with a hop. It is used when 
the designs (e.g. labels, regions etc) were not generated from the hop you want to connect them to 
(or from no hop at all).

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps_Adv
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4.13.1 Hop It Properties

• Hop Mode
• Automatic: Sets hop points automatically (based on searching all hops locations and 

connecting to the one which is closest).
• Manual: Sets hop points using the Hop Point parameter.

• Hop Point:  Sets the hop point in the hop sequence. Note that the animation is built in the 
same sequential order as the list of Hop Points (Map-Start, Destination-1, Destination-2, and 
so on). If two hops use the same Hop Point, the animation does not work properly.

The three plug-ins that are influenced are Hop Sync, 2D Label and Label It.

4.14 Hops Manager

The Hops Manager plug-in controls multiple instances of several plug-ins from one interface. The 
plug-in should only be used if all parameters for the control plug-ins are the same. If for any 
reason different values are needed, the plug-in should not be used.

The plug-in controls the CWMClient plug-in, Map Pyramid plug-in and NavFinder plug-in; however, 
only instances which are part of a hop are controlled. The plug-in has two main options; global 
values and hops.

4.14.1 Hops Manager Properties

Global Values
Global values are used in order to update values globally on all control plug-ins.

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps_Man



Viz World Plug-ins Guide - 17.0

Copyright © 2019  Vizrt                                                          Page  156

Under the global values tab all parameters are the same as those found in the actual plug-ins you 
want to control. For more information see:

• CWMClient
• NavFinder

Hops
Hops are used to jump to a specific hop. From this tab you can select and refresh a map and fine 
tune pan values from NavFinder.

• Multi Hop: Opens the Multihop Editor in the World Map Editor when the Multihop button is 
pressed.
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4.15 Hop Sync

The Hop Sync plug-in coordinates between labels and other 3D objects with built-in animations 
and hop animations. The Hop Sync plug-in is applied to the same container as the Label It plug-in, 
or to a container above the label design containers but below the top design container which is 
used to create the label merged object. To use Hop Sync plug-in, the label designs must include a 
merged object containing the design. The plug-in defines a point in the label animation that is 
matched with the hop point in the Navigator animation.

4.15.1 Hop Sync Properties

• Director: Defines to which director the label animation is copied to.
• Navigator: Copies the label animation to the Navigator director. This option is used 

when the label animation should end before or at the time the Navigator animation 
has reached a hop point. When the Navigator director reaches a hop point and 
Continue is pressed (or pause time ends) the label animation also continues, causing 
the label to disappear.

• Hop Director: Copies the label animation to a new director. This option is used when 
the label animation should end after the hops animation has stopped (or paused). If 
the label animation is copied to the Navigator director, the label animation stops 
before the entire label is revealed.

• Separate: Copies the label animation to a new director (not the Hop or 
Navigator director) to give you more options. Note that it does not perform animation 
offsets.

• Animation Start Time: Defines the point in the label animation that is matched to the hop 
point in the Navigator animation. The value is set by typing in a number (in seconds), or 
clicking and sliding the mouse over the parameter until the animation point is reached. 
Another option is to use the Set Highlight Time button. Play the animation and when 
reaching the requested point in the label animation, stop and click the Set Highlight Time. 
The current label animation value is copied to the Animation Start Time field.

• Order Offset: Enables/disables an offset between the animation of the objects.

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps
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• Animation Order Offset Time: Determines the offset for the animation, e.g when 
setting this value to 1.2, the third detail animation starts after 2.4 seconds after the 

animation has reached the destination.

4.16 KML Reader

The KML Reader plug-in adds objects from KML files to the scene. KML files are XML formatted files 
containing information about geographic objects: Labels, shapes, lines. The KML Reader plug-in 
reads the files and generates objects according to the file’s content.

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps_Man
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4.16.1 KML Reader Properties

General

• KML File: Defines the path to the KML file.
• Line Designs and Holder: Defines the graphic designs for lines.

• Disabled: Does not use line designs. Lines found in the file are not drawn.
• Local: Uses specific line design containers and holder container. When selected 

additional parameters are enabled: Line Designs and Line Holder. Assign the required 
designs and holder to the plug-in.
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• Global: Uses the global line designs and holder container. The global designs and 
holder are defined in the 3D Map Setting plug-in.

• Line Split
• Off: Places all lines go into one container.
• On: Places every line into its own container.
• By style: Places lines that share a style together in a container

• Connect Labels to Line: Creates a line by connecting all labels into a line.
• Update on Load: Sets whether the data is read when the scene is loaded.
• Label Designs and Holder: Defines the graphic designs for labels.

• Disabled: Does not use label designs. Labels found in the file are not drawn.
• Local: Uses specific label design containers and holder container. When selected 

additional parameters are enabled: Label Designs and Label Holder. Assign the 
required designs and holder to the plug-in.

• Global: Uses the global label designs and holder container. The global designs and 
holder are defined in the 3D Map Setting plug-in.

• Shape Designs and Holder: Defines the graphic designs for shapes.
• Disabled: Does not use shape designs. Shapes found in the file are not drawn.
• Local: Uses specific shape design containers and holder container. When selected, 

additional parameters are enabled: Shape Designs and Shape Holder. Assign the 
required designs and holder to the plug-in.

• Global: Uses the global Shape designs and holder container. The global designs and 
holder are defined in the 3D Map Setting plug-in.

• Maximum Number of Shapes:
• Georef Images: Defines whether georef images found in the KML file are used.

• Disabled: Does not draw images found in the file.
• Enabled: Draws images defined in the file and geographically references them. When 

selected an additional parameter is enabled: Georef Images Holder. Assign the 
required holder to the plug-in.

• Maximum Number of Labels:

Hop Control
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• Set Navigator Hops: Creates hop points based on the information in the KML file. Selects 
which information to use (line, shape, etc.).

• Exclude Hops: Excludes the hop animation for the following labels; None, First, Last, or First 
and Last. Manual Shift allows you to define which destination is the starting point (limited to 
a selection of 30 destinations).

• Start Hop: Determines the starting point for the hop.
• Point Data Diameter (km): Sets the diameter used for each hop point when creating hops 

based on labels.
• Set Navigator Hops: Enables the scene to do a hop animation between the labels.
• Print Debug Information: Prints debug messages to the Viz console when set to On.

• Read File: Triggers the plug-in to read the files and re-draw the objects.

Proxy

• Use Proxy: Defines the network uses a proxy server. When set to On, additional parameters 

are enabled:
• IP: Sets the IP address of the proxy server.
• Port: Sets the port number to be used.
• Username, Password: Sets the login credentials.

4.17 Label And Go Assistant

The Label and Go Assistant plug-in works in conjunction with the Label and Go plug-in to add or 
delete new labels. When working with streets it allows editing labels and replacing names and 
styles of roads. Changes can be saved in a CSV file that can be read afterwards by the Label and 
Go plug-in.

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps_Adv
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4.17.1 Label and Go Assistant Properties

• Label: Names the new label.
• Input Interface: Toggles whether to use interactive input (combined supports touch) or 

mouse only.
• Interactive Input: Toggles revert or replace (in roads mode).
• Action: Selects whether to replace name, style or both.
• Select Labels (WME): Adds user label from server (WPF).
• Select Labels (Classic): Adds user label from server (classic).

4.17.2 Adding User Labels
1. Add the Label and Go plug-in to the new container under the hierarchy.

2. In the Label and Go plug-in set: Data source to Local File, Edit Mode to be Stand by.
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3. There are three modes:
• Stand by: Allows you to select the place where you want to add or remove your labels.
• Active: Allows to add or remove labels depending in your selection.
• Modify: Allows you select a label and then you can move it or rename it.

4. Add the Label and Go Assistant plug-in in the same container that reside the Label and 
Go plug-in.

5. Select PQI-1 for Label number 1 Write the name of the Label. Select PQI-2 for Label number 2 
and change the name. You can create up to 20 Labels. 

6. Active set to On “0-9” means that hitting the actual number on the keyboard adds labels. 
You can toggle from 0-9 or from 10-20 by pressing control.

7. Set the Input Interface: Combined - Touch screen and Mouse - Only Mouse.

Tip: You can toggle between the Stand by Mode and the Active Mode by 
pressing  E  on the keyboard.
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8. Set the Interactive input: To Add labels, set to Add. To Delete Labels, set to Delete.
9. To Add Labels from group number 1: Navigate to the specific area, press 1 on the keyboard 

and click the left button on the mouse. Every time you click a label appears. To change to 
group 2: Press 2 and click on the mouse.

          

4.17.3 Deleting User Labels
1. Set the Interactive input to Delete.
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2. Select the group label and then select the Label that you want to remove.

3. In order to delete a group of Labels: Press the Label group number in the keyboard to select 
the all group, Press Shift to draw a rectangle around the labels that you want to remove.

4.17.4 Saving New Labels to a File
1. Enter to Folder: C:\ProgramData\vizrt\Viz3\Maps\L&GoAssistant/ 
2. Create a TXT document and change it to .CSV 
3. In File select the file in the folder and click Save To File. This file can be read by Label and 

Go plug-in.

Tip:  By pressing E in the keyboard you can switch from edit mode to none to see the 
actual results.
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4.17.5 Editing a Label Using the Label and Go Assistant Plug-in
1. We can change a name of a Road or a street. In the Label and Go plug-in set the Data Source 

to Streets. Set the Edit Mode to Stand By. Zoom to the area that you want to edit the Labels.

2. Change the Edit Mode to Active.
3. Select the Interactive Input: Replace Segment, Select the Action: Replace Name:Name of the 

segment, Replace Style: Primary, Main,Secondary, Replace Name & Style.



Viz World Plug-ins Guide - 17.0

Copyright © 2019  Vizrt                                                          Page  167

4. When you are in Active mode you have an information panel on the left side of the screen.

5. To revert the changes press Revert Segment Changes.

4.17.6 Saving the Label Changes to a File
1. Enter to Folder: C:\ProgramData\vizrt\Viz3\Maps\L&GoAssistant/.
2. Create a text file and rename it to .CSV.

Tip: You can toggle between the options pressing A in the keyboard.
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3. In the Label Changes File, select the file in the folder and click Save Label Changes.

By pressing the Clear All Label Changes, all changes are cleared, you can Load the file by 
pressing Read Label Changes.

4.18 Label AddOn

The Label AddOn plug-in assigns images, geometries and text based on label parameters. Labels 
can have up to four extra parameters.

• Label parents: Country, Admin1, Admin2 (see also Place Finder plug-in)
• Label type: Type

Based on the container name (case sensitive), the CWMClient plug-in updates the Value field in the 
plug-in with the correct value. For example, if you have selected London and you have a Label 
AddOn plug-in on a container named Country it receives the value of United Kingdom and if you 
have another Label AddOn plug-in on a container named Type It receives the value of Capital. A 
use case for this plug-in is whenever you want to have flags for all countries in the world in a 
folder and use the right flag based on the country. Another use case is having different images for 
different types and using the correct image based on the type.

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps_Adv
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4.18.1 Label AddOn Properties

• Type
• Images: Can be applied from the database on a local container.
• Geometries: Can be applied from the database on a local container.
• Text: Can be changed on the local container.

• Value: Provides values used to seraph the object or set the text. Can be edited for testing.
• Prefix: Sets the prefix used for searching the database. For example MyImages/Flags/

Suffix or _small.
• Hide if Empty: Hides the container if an object/image is not found.
• Update: Tests the prefix and suffix.

4.19 Label It

The Label It plug-in manages 3D labels and place indicators. The plug-in creates a hierarchy under 
its container for adding a caption, body and pointer objects.

4.19.1 Label It Properties

Caption
Caption defines the relation between the label components (text and pointer). When disabled, 
duplicated labels use the label design exactly. When enabled, the labels use the following options:

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps
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• Caption Pivot: Defines the connection point between the caption and the body when the 
caption is moved (rotated along the tip). There are two options, Fixed and Edge. 

• Fixed: Sets the connection point at the center of the caption. 
• Edge: Sets the connection point depending on the correct rotation. If the caption is 

above the tip, the connection point is at the middle lower side of the caption. If the 
caption is on the right side of the tip, it is on the left side of the caption. For example: 
A line moving from the tip to the center of the caption and where it crosses the 
caption bounding box is the connection point.

• Rotate Labels: Defines whether labels, created in Viz (3D labels), are rotated like the labels in 
the Map Editor. When set to Off, all labels are displayed horizontally. When set to On, labels 

that were rotated in the Map Editor are also rotated in Viz.
• Caption Source: The options Default Position, WME Directions, and Label Manager 

Presets include the properties described below.

Default Position
This is used when adding labels in WME when no direction is selected.

• Direction (deg): Sets the angle of the label in relation to its geographic position.
• Distance (cm): Sets the distance of the label from its geographical position.
• WME Offsets Distance: Enables the WME to offset the distance when set to On (default). When 

set to Off, only the direction offsets from WME are used and the distance is ignored.

WME Directions
This allows you to set and fine tune offsets for every direction available in WME. When selected, the 
labels are placed as they were placed on the map in the Map Editor. When manually set inside WME 
they always take priority over the presets and Default Position settings. The default pointer 
direction (angle) and default distance between the pointer and the label is set by the map label 
parameters and used by the Map Editor (WME). If the direction and distance are changed while 
using the WME, the Default Direction and Default Distance values are ignored.
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• WME Compass Rose: Corresponds to the available directions inside the WME, as shown in the 
following image.

• Direction Offset (Degrees): Determines direction offset for fine-tuning the position of the 
label.

• Distance (Viz units): Determines the distance offset for fine-tuning the position of the label.

Label Manger Presets
When this is selected, the Label Manager plug-in uses the defined presets to place the labels over 
the map. The Label Manager plug-in optimizes the label position such that the labels do not 
overlap.

• Number of Presets: Defines the number of label position presets available to the user (one to 
four presets). This parameter is only enabled when Caption Mode is set to Controlled.

• Current Preset: Selects the preset number to be configured, using the Direction and Distance 
parameters. Each preset should be selected and the label position should be adjusted.

• Direction (deg): Sets the angle of the label in relation to its geographic position.
• Distance (cm): Sets the distance of the label from its geographical position.
• Collision Mode: Defines how the labels are placed when an overlap or collision between two 

labels occur. With Tip, the pointers of overlapping labels can cross or touch, but no overlap 
of label bodies are allowed. With Bounding Box, a bounding box is calculated around the 
entire label (label body and pointer). An overlap between labels bounding boxes is not 
allowed.

Overlay
Navigator Overlay defines how the label is displayed over the map. Available options are Disabled, 
Fixed, Scaling, Near Scale and Far Scale.

• Disabled: Places the label on the map using its geographical referencing.
• Fixed: Places the label by keeping its geographical referencing, but using a different camera 

(either with dynamic image or with a front layer). The label size remains fixed.
• Scaling: Places the label by keeping its geographical referencing, but using a different 

camera (either with dynamic image or with a front layer). The label scales to imitate the 
camera movement.
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• Near Scale: Defines the maximum size of the label on the screen (the final size of the 
label when zooming in).

• Far Scale: Defines the minimum size of the label on the screen (the final size of the 
label when zooming out).

On Map Scale

• Static Map Scale: Defines a scaling factor for the duplicated labels on a static map without 
camera movement when set to On. When set to Off, no scaling is used.

Fade

Stand Alone

• Fade: Defines the fade effect parameters to be used with the duplicated labels. Available 
options are Stand Alone and Controlled. Stand Alone enables the user to define the fade 
parameters of the labels, while Controlled can be enabled to define the fade parameters 
when working with the Label Manager plug-in.

• Fade on Time: Defines a label fade effect, beginning at a relative point to the defined hop 
duration. An additional parameter is enabled, Time to Hop, defining when the fade occurs.

• Fade on Distance: Defines a label fade effect, beginning at a relative distance from the hop 
final location.



Viz World Plug-ins Guide - 17.0

Copyright © 2019  Vizrt                                                          Page  173

• Fade on Lat/Long: Defines a label fade effect, beginning at a Longitude and Latitude offset 
from the hop final location. An additional parameter is enabled, Lat/Long, defining the 
offset from in degrees.

Controlled

• Step: Controls when the label fades in and out in relation to an animation. In general the 
fade can be based on the camera distance (for example; capitals are in view when distance is 
below 1000KM) or on timing in relation to the hop:

• Auto: Fades in and out based on distance to hop when a label is of type point (added 
by the user). If the label is of type place/region, it fades in and out based on the 
distance set in the Label Manager plug-in. If the hop is not close enough for the label 
to show and the label was added by the user, it fades in based on hop timing and not 
distance.

• On Hop: Links the fade to the hop timing.
• Point 1/Point 2: Reserves labels where the distance is configured by the Label 

Manager plug-in.
• Hop and Above: Turns on at the hop and stays on thereafter.

• Selected Label Timings: Sets one of the timing options for the fade to occur:
• At End: Fades the label after the animation stops and before it continues.
• Close To End: Fades the label just before the animation stops and just after the 

animation continues.
• Ahead: Fades the label before the animation stops and after the animation continues.
• Well Ahead: Fades the label long before the animation stops and long after the 

animation continues.
• Label Priority: Sets the duplicated labels priority. This parameter is useful for a large number 

of onscreen labels and not all can be displayed. The priority levels define which labels are 
displayed and which labels are hidden.

• Auto: Allows the Label Manager plug-in to set priorities.
• Normal, High: Sets priorities to normal and high.
• Always: Displays labels every time.

Note: The Fade On Distance parameter is enabled only if Overlay is set to Scaling.
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Practical Use
When adding a Label It plug-in, three containers are added under the Label It container: CAPTION, 
BODY and TIP. Drag a text object under the CAPTION container. The BODY container is the 
pointer’s body and the TIP is the pointer’s end.

4.20 LatLongGrid

The LatLongGrid plug-in draws latitude and longitude lines on the map. The lines are generated 
using the 3D Line plug-in.

4.20.1 LatLongGrid Properties

• Spacing
• 20/10/5 Degrees: Spacing in degrees for each line in the grid.
• Manual: Defines the Spacing Units (Degrees or Meters) using manual input and defines 

separate spacing for longitude and latitude lines and the Origin Latitude/
Longitude (starting point for the grid).

• Prune Longitude Lines at Pole: Continues to draw lines at the poles instead of pruning 
(cropping) the geometry at the poles when Disabled.

• Latitude/Longitude Designs: When set to Single, both longitude and latitude lines are drawn 
using the same 3D Line plug-in. When set to Separate it allows using separate 3D Line plug-
ins for each to achieve a different look for latitude and longitude lines.

IMPORTANT! A text object under the label design must be named label to receive the name 
of the object from the CWMClient plug-in.



Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps
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4.21 Locator Control

The Locator Control plug-in links an object positioned on one map to another map, showing its 
position. The object marking the point on the linked map must reside under a geographically 
referenced map. The linked object shows the position of the linked map or object on the map its 
parent map.

4.21.1 Locator Control Properties
• Position Type: Defines the link between the object and the map. Available options 

are Map, Navigator, WPosition, WPoint and User.

Map
Map links the object to a map, showing its entire area over the parent map.

• Remote Container: Defines the linked map container.
• Control Size: Marks the entire area of the linked map on the parent map when set to 

Off. When set to On, the size of the marked area can be controlled.

• Basic Size: Defines the percentage of the linked map area to be marked.
• Min Size: Defines the minimum size of the linked map area to be marked.
• Max Size: Defines the maximum size of the linked map area to be marked.
• Shared Memory Link: Defines which is the master (source) and client (target) when the same 

Shared Memory Identifier is used.
• Type: Defines the accessibility of the shared memory.

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps
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• Global: Makes shared memory accessible to all scenes currently loaded in memory. 
This is useful when working with Transition Logic scenes where your Viz World map 
can be one scene and the locator a different one and data can easily be transferred 
between the two.

• Scene: Makes shared memory accessible locally and to the current scene. Every scene 
has one shared memory map that can be used to exchange data among the scripts in 
the scene.

• Distributed: Makes shared memory accessible to all computers connected to one Viz 
Graphic Hub.

• Identifier: Defines the identifier for the shared memory map.

4.21.2 Navigator
Navigator links the object to a Navigator plug-in, showing its position on the parent map. The 
plug-in locates the navigator container above it in the scene tree. The Navigator tab displays the 
same settings as Map with the exception of the Remote Container setting.

4.21.3 WPosition
WPosition links the object to a World Position plug-in, showing its position on the parent 
map. Remote Container defines the linked World Position container.

4.21.4 WPoint
WPoint links the object to a WPoint plug-in, showing its position on the parent map (the WPoint 
plug-in is used in Viz Weather). Remote Container defines the linked WPoint container.

4.21.5 User
User enables the user to position the object on the map.

• Map Center Longitude: Defines a Longitude value for the object.
• Map Center Latitude: Defines a Latitude value for the object.
• Tangent To Globe: Rotates the controlled object to match the globe surface when set to On.

 

Note: Tangent To Globe is only visible when the locator is under a globe object.
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4.22 Map Layers Control

The Map Layers Control plug-in controls map layers in an individual map and in map tiles (Pyramid 
or Map Tiler tiles). The plug-in should reside on the CWMClient container which generates the 
maps and tiles.

4.22.1 Map Layers Control Properties

Select an option to configure: Map or Tiles. Each can be enabled and configured separately.

• Control: Enables layer parameters when enabled. See Map Layers plug-in for the layers 
description.

4.23 Map Layers

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps
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The Map Layers plug-in exposes map layers to an external application. Map layers are labels, 
regions, and so on.

4.23.1 Map Layers Properties

• Mode: Defines the layer maps mode Static and Dynamic.
• Static: Enables maps to be imported to Viz Artist’s image library and saved with the 

scene.
• Dynamic: Enables pyramid maps to be loaded from the cache and temporary folder. 

When the CWMClient plug-in receives a new map, all layers are updated.
• Texture Compression: Sets the compression level for the texture (DTX5 is the highest 

compression level, which is less texture quality).
• Texture Quality: Sets linear for using the same image resolution in the entire zoom range, or 

Mipmap to change resolution according to the distance from the image (managed 
automatically in Viz Artist).

• Texture Mapping: Defines how the texture (map) is mapped.

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps
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• Texture Anisotropic Filter: Turns on the relevant anisotropic in the image on the same 
container with CWMClient (similar to Mipmap, above). Available settings are Off/2x/4x/8x/

16x.

• Edited Layer: Sets the layer number for editing. Each layer is then assigned map properties 
to display.

• Active: Activates or disables the selected layer.
• Container: Assigns the container for holding the created layer map.
• Flags:  Enables (On) the requested property to expose the map property or feature in the 

selected layer. Flags refer to all the settings from Base Map to Overlay Data.
• Build Tiles: Builds the map layers.

4.24 Map Tiler

The Map Tiler plug-in builds a set of map tiles for displaying an area in high resolution. The maps 
are created as GeoImage (flat map) or Globe objects and placed under a low resolution map of the 
entire area for geographical referencing. The Map Tiler plug-in is also used for managing Pyramid 
object maps when used in a scene.

4.24.1 Map Tiler Properties

Default

• Selected Region: Defines the area of the map for which the tiles are created.
• World: Creates tiles for the entire world.
• Selected Map: Creates tiles for the area of the selected map in the CWMClient plug-in 

attached to the Map Tiler container.

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps
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• Region List: Displays a list of regions. An item from the list can be selected to create 
map tiles for the selected area.

• Long Lat: Sets the Longitude and Latitude minimum and maximum values. The map 
tiles are created for the defined area. When Long Lat option is selected, additional 
fields are enabled.

• Map Status: Displays plug-in status messages. When configuring the tiles, the Map Status 
field displays the number of tiles required and tile size according to the current plug-in 
setup.

• Requested Number of Tiles (2K2K): Allows the user to set the number of tiles to create.
• Geometry Type: Selects the object type of the created tiles.

• Globe: Creates the tiles using the Globe plug-in.
• Flat: Creates the tiles the GeoImage plug-in.

Selected Map
• Texture Compression: Sets the compression level for the texture (DTX5 is the highest 

compression level which is less texture quality).
• Get Map Resolution/(Classic): Uses the WME Editor to zoom to the closest level you want the 

tiles to support. If you change the extent (in Selected Map mode) you need to set the 
resolution again.

Region List
• Region Area: Selects the region you want to build tiles for.

Long Lat
• West: Sets the Longitude value for the western edge of the map.
• East: Sets the Longitude value for the eastern edge of the map.
• South: Sets the Latitude value for the southern edge of the map.
• North: Sets the Latitude value for the northern edge of the map.
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Custom

The following additional parameters are available:

• Radius/Map Size: Sets the size (in Viz units) of the globe or map tiles (all together).
• Tessellation: Determines the number of polygons used in the object. The higher the number 

is, the smoother the object is drawn.
• Texture Quality: Uses the same image resolution in the entire zoom range when set to 

Linear. When set to Mipmap the resolution is changed according to the distance from the 
image (managed automatically in Viz Artist).

• Overlap (%): Determines the overlapping percentage for each tile.
• Build Terrain: Builds terrain data for the created tiles.
• Smooth Terrain: Smoothens terrain edges so they blend with the base map surface. When set 

to On, the Terrain Smoothing Factor is enabled.

• Terrain Smoothing Factor: Sets the percentage of the smoothed area.
• Terrain Height Scale: Sets the scaling factor for terrain height. The higher the factor is, the 

more extreme the terrain is.
• Terrain Resolution: Sets the total terrain resolution for all tiles. A high resolution 

value results in a more detailed terrain (affecting performance).

Buttons
• Build Tiles: Builds the geo-reference map and tiles.
• Change All Maps: Builds the geographical reference map, tiles and applies style changes 

made in the CWMClient plug-in to all child containers (recursively) under the Map Tiler 
container.
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• Build Tiles (Force New): Builds the geographical reference map and tiles without checking the 
cache for existing maps (from the server).

• Change All Maps (Force New): Builds the geographical reference map, tiles and applies style 
changes made in the CWMClient plug-in to all child containers (recursively) under the Map 
Tiler container, without checking the cache for existing maps (from the server).

• Calculate Tiles Info: Calculates the tiles information, without building the tiles, and displays 
it in the Map Status field.

4.25 Map Zoom

The Map Zoom plug-in builds single destination animated scenes. Because the scene is treated as 
an independent Map Object it can be added into any graphic including Transition Logic scenes. 
The map is created as GeoImage (flat map) and adds all necessary plug-ins to the hierarchy.

4.25.1 Map Zoom Properties

• Zoom: Defines the zoom in percent (0-100%), in order to animate to the final destination.

• Labels: Takes the size of the label from the original design when set to Fixed. When set 
to Auto Scale, the size is calculated based on the size of the map.

4.26 Mouse2Memory

The Mouse2Memory plug-in sends mouse events to shared memory.

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Tools
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4.26.1 Mouse2Memory Properties

Shared Memory

• Map Type: Defines the accessibility of the shared memory.
• Global: Makes shared memory accessible to all scenes currently loaded in memory. 

This is useful when working with Transition Logic scenes where your Viz World map 
can be one scene and the locator a different one and data can easily be transferred 
between the two.

• Scene: Makes shared memory accessible locally and to the current scene. Every scene 
has one shared memory map that can be used to exchange data among the scripts in 
the scene.

• Distributed: Makes shared memory accessible to all computers connected to one Viz 
Graphic Hub.

• Reset Before Change: Resets the data before sending (ensures the same data is not sent 
twice due to shared memory blocking it).

• Key: Defines the shared memory key name that receives the data field value.
• Value: Defines the data field value for the shared memory key.
• Execute: Sends data to shared memory.

Picking

• Camera: Determines the camera to use for the projection.
• Picking Active: Limits picking to a rectangle.
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• Position X (%): Determines X value of rectangle.
• Position Y (%): Determines Y value of rectangle.
• Width (%): Determines width of rectangle.
• Height (%): Determines height of rectangle.
• Preview: Displays the rectangle.
• Execute: Sends data.

4.27 Mute

The Mute plug-in determines if a container is drawn or not. The difference between using the Mute 
plug-in and setting the visibility off is that when using the plug-in only containers with the plug-in 
are not drawn, but all child objects are drawn and the geometry properties are used in the 
hierarchy (geographical reference, and so on). When setting the visibility off, the entire container 
and its child containers are disabled and not used in any way.

4.27.1 Mute Properties

• Draw Geometry: Draws geometry when enabled (On). When disabled (Off), the geometry is 

not drawn, but its child containers are drawn.

4.28 NavCom

The NavCom plug-in controls the Navigator plug-in. The plug-in is an example showing how to 
externally control the Navigator plug-in when special applications should be used to control the 
scene. An example for a special case where external control of the Navigator plug-in is required is 
Elections. When using Viz 3.x scripting, complicated logics and commands can be used with the 
NavCom plug-in.

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Tools

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps_Adv
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4.28.1 NavCom Properties

Commands
The Commands tab is used for communicating with the Navigator plug-in in means of sending 
formatted commands and receiving formatted responses from the Navigator plug-in.

The Command text field is where you enter the command. The NavCom plug-in receives 
predefined, fixed syntax, commands and returns a reply from the Navigator plug-in. The Response 
field contains the reply returned from the Navigator plug-in. The format of the reply is defined in 
the Advanced tab. The Immediate Response option defines whether the command is sent while 
typing (every change to the command field sends the command to Navigator), or only after 
pressing the Execute Command button.

The following is a list of commands, example commands and return values:

• Mouse To Lon Lat: Converts screen coordinates to Long/Lat values from the map. This needs 
the Navigator plug-in.

• Command: MTLL x y
• Response: lon lat

MTLL 360 288 -116.998 38.088

• Mouse To Region: Returns the region name in which the given screen coordinates reside. 
This command requires the Navigator plug-in.

• Command: MTR x y
• Response: CountryID "Country Name" RegionID "Region Name" SubRegionID "Sub Region 

Name"
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MTR 360 288 1000000000003600 "United States of America" 1000000000038901 
"Texas" 1000000000111302 "Atascosa County"

All Fly To commands require the Navigator and the NavFinder plug-in. Also set the 
Navigator plug-in’s Interactive Anim setting to On.

• Fly To Region ID: Triggers a Navigator animation from the current location to the sent region 
(RegionID).

• Command: FTRID RegionID

FTRID 81000000000F8285

• Fly To Country: Triggers a Navigator animation from the current location to the sent country 
(country name).

• Command: FTC "country name"

FTC "united states of America"

• Fly To Region: Triggers a Navigator animation from the current location to the sent region 
(Region name).

• Command: FTR "country" "Region"

FTR "united states of America" "Texas"

• Fly To Sub Region: Triggers a Navigator animation from the current location to the sent sub 
region (by name).

• Command: FTSR "country" "Region" "Sub Region"

FTSR "united states of America" "Texas" "young county"

• Fly To Lon Lat Level: Triggers a Navigator animation from the current location to the sent 
level area (country, region, or sub region) that the long/lat data resides in.

• Command: FTLLL lon lat level

FTLLL -116.998 38.088 1

• Search database: Searches the map database and as a response generates an XML. This 
command requires a running Viz World server.

• Command: SMDB <query>

Note: Levels are: 0 = Country, 1 = Region, 2 = Sub Region
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• Search web: Searches the web and as a response generates an XML. This command requires 
a running Viz World server.

• Command: SWEB <query>
• Search All: Searches both resources (map database and web) and as a response generates an 

XML. This command requires a running Viz World server.
• Command: SALL <query>
• Shared memory reply: WS_REPLY 

• Nearby: Searches locations in the vicinity of the coordinates of your “mouse” and as a 
response generates an XML. This command requires a running Viz World server. This 
command requires the Navigator plug-in.

• Command: NEARBY [mouse-x] [mouse-y]
• Shared memory reply: NAV_NEARBY_REPLY 

Shared Navigation memory of the Navigator plug-in can be activated by setting Publish 
Geo Data to Bounding box or Location. If Bounding box is selected you get, in addition 
to Bounding box data, Center and Distance data. If Location is selected you get, in 
addition to the Location data, all the others. If None is selected, no data is shared. All 
can be used with scripting to define e.g. the administration levels the script should 
fetch from the shared data and consequently display it on screen. For interactive 
scenes such as touch screens this can be used for adding graphics to maps based on 
your selection (thereby avoiding over-populating the map with information). For 
testing you can enable the interactive mode by clicking the E button in Viz Artist’s 
Scene Editor.

• Navigation location: Shared data holding the current geographic location(s) of the Navigator 
plug-in. To enable it, select Publish Geo Data’s Location option. The data is updated when 
the camera is not moving. Navigation location also generates an XML with the current 
geographic location(s) (in the same format as SMDB, SWEB, SALL and NEARBY). This requires a 

running Viz World Server.
• Name: NAV_LOCATION_DATA

• Navigation bounding box: Shared memory data holding the current (frame by frame) 
geographic bounding box (lat lon) of the Navigator plug-in. To enable it, select Publish Geo 
Data’s Bounding box or Location option.

• Reply: NAV_BB_DATA 

• Navigation center: Shared memory data holding the current (frame by frame) geographic 
center of the Navigator plug-in. To enable it, select Publish Geo Data’s Bounding box or 
Location option.

• Reply: NAV_CENTER_DATA 

• Navigation distance: Shared memory with the current distance to world of 
the Navigator plug-in. To enable it, select Publish Geo Data’s Bounding box or Location 
option.

• Reply: NAV_DISTANCE_DATA 

• Navigation direction: Shared memory with the current pan and tilt direction of 
the Navigator plug-in. To enable it, select Publish Geo Data’s Bounding box or Location 
option.

• Reply: NAV_DIRECTION_DATA
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Control
The Control tab is used to directly control the Navigator plug-in by changing the values of the 
parameters.

• Longitude: Sets the longitude value for the Navigator plug-in. The Navigator camera moves 
to the specified longitude value.

• Latitude: Sets the latitude value for the Navigator plug-in. The Navigator camera moves to 
the specified latitude value.

• Distance: Sets the Navigator distance from the map. The Navigator camera moves to the 
specified distance value.

• Pan: Sets the pan value of the Navigator camera.
• Tilt: Sets the tilt value of the Navigator camera.
• Interactive Mode: Defines the interactive behavior of Viz. 

• None: Disables interactive mode.
• Editor: Enables interactive mode during scene editing.
• On Air: Enables interactive mode when Viz Engine is in On Air mode.
• Always: Enables interactive mode during scene editing and when Viz Engine is in On 

Air mode.
• Minimum Distance: Sets the minimum distance from the map in Viz units.
• Zoom Center: Used in interactive mode.

• Position: Zooms the map to center on the position of the fingers.
• Center: Zooms to the center of the map.

• Momentum Mode: Sets how much friction should be applied to the momentum when set to 
Linear.

Note: The Navigator control parameters affect the Navigator immediately.
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Advanced
The Advanced tab is used for defining the NavCom plug-in’s general behavior patterns.

• Shape File Support: Defines whether the NavCom plug-in includes shape objects information 
in the response. The Shape objects must reside under the NavCom container. 

• Disabled: Does not return shape object information.
• Limited: Scans the shape files below the container. When a command is received, the 

NavCom plug-in returns information about the shapes that overlap the requested data 
in the command in the response string. 

• Only: Scans the shape files below the container. When a command is received, the 
NavCom plug-in returns only the information about the shapes that overlap the 
requested data in the command in the response string.

• Limit Picking: Limits the geographical area that the NavCom plug-in performs any of the 
commands on. When Limit Picking is enabled the Limit to Country parameter is enabled.

• Limit to Country: Sets the country name. If the requested data in the command does 
not exist for the defined country area, the command is not executed. Only commands 
relating to points within the country area are executed.

• Shared Memory Prefix: Distinguishes between the data sent to each plug-in when using more 
than one NavCom plug-in in the scene, and when using scripting to send and receive 
information from these plug-ins. In each NavCom plug-in, set the Shared Memory Prefix to a 
different prefix (up to four).

• Protocol Mode: Defines the data displayed in the Response field.
• Full: Includes data on names and IDs for countries, regions and sub-regions.
• Name: Includes data on names for the countries, regions and sub-regions.
• ID: Includes only ID data (as defined in the Viz World Server) for the countries, regions 

and sub-regions.
• Protocol Separator: Defines the separating character between the Response data. The 

defined separator is used between country and region, region and sub-region, and so on.
• Use Quotes: Defines whether the response string is quoted or not.
• Suffix FIPS: Used for USA regions and sub-regions.
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• Publish Geo Data: Allows you to publish navigation data to shared memory based on your 
interaction with the graphics scene (e.g. touchscreen or mouse). Shared Navigation memory 
can be activated by setting to Bounding box or Location. See the available Navigation data 
under the Commands section.

• Bounding box: Sends Center and Distance data in addition to Bounding box data. 
• Location: Sends all the others in addition to the Location data. 
• None: Does not share data.

• Execute Command: Executes the defined command when pressed.
• Initialize: Rescans the shape objects if the shape objects under the NavCom container are 

changed. This button is used when using shape file support.

NavCom Scripting
Viz 3.X scripting ability is a powerful tool for implementing complex logic into a scene. In a 
Navigator scene, NavCom can be used in the scripts to enable such advanced 
Navigator operations. The following script example demonstrates how to send and receive data 
from the Navigator plug-in through to the NavCom plug-in.

Example: Script example: main.txt
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dim level as Integer
dim ignore as Integer
dim CurCountry as string
dim CurCountryId as string
dim CurState as string
dim CurStateId as string
dim CurCounty as string
dim CurCountyId as string
 
Sub UpdateCurrent(temp As String)
    dim position as Integer
    dim temp2 as String
    println temp
    CurCountryId = temp.left(16)
    position = temp.Find("\"")
    temp = temp.GetSubstring(position+1,temp.Length-(position+1) )
    temp2 = temp    position = temp2.Find("\"")
    CurCountry = temp2.Left(position)
    println "<" & CurCountryId & "><" & CurCountry & ">"
    position = temp.Find("\"")
    temp = temp.GetSubstring(position+2,temp.Length-(position+2) )
    CurStateId = temp.left(16)
    position = temp.Find("\"")
    temp = temp.GetSubstring(position+1,temp.Length-(position+1) )
    temp2 = temp
    position = temp2.Find("\"")
    CurState = temp2.Left(position)
    println "<" & CurStateId & "><" & CurState & ">"
     position = temp.Find("\"")
    temp = temp.GetSubstring(position+2,temp.Length-(position+2) )
    CurCountyId = temp.left(16)
    position = temp.Find("\"")
    temp = temp.GetSubstring(position+1,temp.Length-(position+1) )
    temp2 = temp
    position = temp2.Find("\"")
    CurCounty = temp2.Left(position)
    println "<" & CurCountyId & "><" & CurCounty & ">"
End Sub
 
Sub OnInit()
    ignore = 0
     level = 1
     if Scene.Map.ContainsKey("MTR") = false Then
        Scene.Map.CreateKey("MTR")
    End If
    if Scene.Map.ContainsKey("FTRID") = false Then
        Scene.Map.CreateKey("FTRID")
    End If
    if Scene.Map.ContainsKey("FTC") = false Then
        Scene.Map.CreateKey("FTC")
    End If
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    if Scene.Map.ContainsKey("FTR") = false Then
        Scene.Map.CreateKey("FTR")
    End If
    if Scene.Map.ContainsKey("FTSR") = false Then
        Scene.Map.CreateKey("FTSR")
    End If
    if Scene.Map.ContainsKey("FTLLL") = false Then
        Scene.Map.CreateKey("FTLLL")
    End If
    if Scene.Map.ContainsKey("MTR_REPLY") = false Then
        Scene.Map.CreateKey("MTR_REPLY")
    End If
    if Scene.Map.ContainsKey("FTRID_REPLY") = false Then
        Scene.Map.CreateKey("FTRID_REPLY")
    End If
    Scene.Map.RegisterChangedCallback("MTR_REPLY")
    System.Map.RegisterChangedCallback("REGION_L")
 End Sub
 
Sub OnSharedMemoryVariableChanged(map As SharedMemory, mapKey As String)
     println mapKey
    dim temp as String
    If mapKey = "REGION_L" Then
       println "ignore pre"
       ignore = 1
    else If mapKey = "MTR_REPLY" Then
       temp = Scene.Map["MTR_REPLY"]
       UpdateCurrent(temp)
       println System.Map["REGION_L"]
          if System.Map["REGION_L"] = "1" then
          Scene.Map["FTRID"] = CurCountryId
       elseif System.Map["REGION_L"] = "2" then
          Scene.Map["FTRID"] = CurStateId
       elseif System.Map["REGION_L"] = "3" then
          Scene.Map["FTRID"] = CurCountyId
       End If
    End If
    If mapKey = "MTLL_REPLY" Then
        println    Scene.Map["MTLL_REPLY"]
    End If
 End Sub
 
sub OnLButtonDown()
    dim temp as String
    if System.MouseX < (System.RenderWindowWidth: 120 ) then
       Scene.Map["MTR"] = (String)
 System.MouseX & " " & (String)System.MouseY
    end if
end sub
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4.29 NavFade

The NavFade plug-in defines the visibility of an object that the NavFade is attached to in 
a Navigator scene. The Navigator point of view (distance from the map) determines when the 
object becomes visible. The NavFade uses an alpha plug-in to control the object’s appearance. The 
alpha plug-in is added automatically when adding NavFade to the container.

4.29.1 NavFade Properties

Height

The object fades in or out depending on camera height (above the map).

• Fade Invert: Fades starting at 100% alpha to 0% alpha, instead of from 0% alpha to 100% 
when set to On.

• Fade Time: Defines the fade transition duration in fields.
• Visibility Range: Defines how the fade point is calculated.

• Below: Makes the object visible when the defined height is higher than the 
current Navigator distance from the map.

• Above: Makes the object visible when the defined height is lower than the current 
Navigator distance from the map.

• Range: Makes the object visible when the defined height is between the defined low 
and high values.

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps
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Below or Above
When Visibility Range parameter is set to Below or Above:

• Height: Defines the height value that the NavFade plug-in uses as the show/hide point of the 
object when Visibility Range parameter is set to Below or Above.

• Set Height: Inserts the current camera height into the height field when clicked.

Range
When Visibility Range parameter is set to Range:

• Low/High: Sets the lowest/highest value of the height range that the object is visible in. If 
the current Navigator height is between the low and high values, the object is visible.

• Set Range High/Low: Copies the current Navigator height value to the High/Low parameter.

Hops
The object fades in or out depending on the defined hop point and the animation time to/from the 
selected hop point.

• Fade Invert: Fades starting at 100% alpha to 0% alpha, instead of from 0% alpha to 100% 
when set to On.

• Fade Time (fields): Defines the fade transition duration in fields.
• Time to Hop (%): Sets the point in which the object appears/disappears. The time is set as a 

percentage of the hop duration.
• Hop Mode: Defines whether the NavFade plug-in affects the manually selected hop or if the 

hop is auto selected when the designs copied by CWMClient.
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• Hop to Link: Sets the number of the hop points that NavFade uses as a reference. When 
animating to and from the selected hop, the object appears/disappears.

• Hop and Above: Considers all hops with a higher number than the selected hop when 
enabled. When enabled, all hops which number is higher than the selected hop is considered 
as the selected hop. Defines whether the NavFade plug-in affects the manually selected hop 
or if the hop is selected by the NavFade plug-in. The Constant option causes the object to 
fade on at Hop to Link and stay on from that point onwards. The Related option allows you 
to relate hops to a set of containers. You can for example use the NavFinder plug-in to 
define three hops, and then add three text containers as sub-containers of a container 
holding the NavFade plug-in. Setting NavFade to Related allows the NavFinder hops to relate 
to the text containers found under the NavFade container and fade them in and out as part 
of the hop animation.

Distance

 
The object fades in or out depending on the distance from the map.

• Fade Time: Defines the fade transition duration in fields.
• Visibility Range: Defines how the fade point is calculated. Available options are Below, Above 

and Range.
• Below: Makes the object visible when the defined distance is higher than the 

current Navigator distance from the map.
• Above: Makes the object visible when the defined distance is lower than the 

current Navigator distance from the map.
• Range: Makes the object visible when the defined distance is between the defined low 

and high values.

Below or Above
When Visibility Range parameter is set to Below or Above:

• Distance: Defines the distance value that the .NavFade vmaps plug-in uses as the show/hide 
point of the object.

• Set Distance: Copies the current Navigator distance value to the Distance parameter.
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Range
When Visibility Range parameter is set to Range:

• Low/High: Sets the lower/higher value of the distance range that the object is visible in. If 
the current Navigator distance is between the low and high values, the object is visible.

• Set Range High/Low: Copies the current Navigator height value to the High/Low parameter.

Angle

 
The object fades in or out depending on the angle between the camera and the map.

• Fade Invert: Fades starting at 100% alpha to 0% alpha, instead of from 0% alpha to 100% 
when set to On.

• Fade Time: Defines the fade transition duration in fields.
• Visibility Range: Defines how the fade point is calculated. Available options are Below, Above 

and Range.
• Below: Makes the object visible when the defined angle is higher than the 

current Navigator angle between the camera and the map.
• Above: Makes the object visible when the defined angle is lower than the 

current Navigator angle between the camera and the map.
• Range: Makes the object visible when the defined angle is between the defined low 

and high values.

Below and Above
When Visibility Range parameter is set to Below or Above:

• Angle: Defines the angle value that the .NavFade vmaps plug-in uses as the show/hide point 
of the object.

• Set Angle: Copies the current Navigator angle value to the angle parameter.

Range
When Visibility Range parameter is set to Range:
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• Low/High: Sets the lowest/highest value of the angle range that the object is visible in. If the 
current Navigator angle is between the low and high values, the object is visible.

• Set Range High/Low: Copies the current Navigator height value to the High/Low parameter.

Movement

 
Alpha values fade on/off based on if Navigator is currently moving or stationary.

4.30 NavFinder

The NavFinder plug-in sets hop points over a given map. The NavFinder must reside under a 
Navigator plug-in container and a map.

4.30.1 NavFinder Properties

Common Properties
• Hop Point: Sets the hop point in the hop sequence. Note that the animation is built in the 

same sequential order as the list of Hop Points (Map-Start, Destination-1, Destination-2, and 
so on). If two hops use the same Hop Point, the animation does not work properly.

• Position Source: Defines how the hop location is set. Available options are Map, Absolute, 
Geometry and Link.

Buttons
• Goto Map: Jumps to the defined hop point on the map.
• Take Current Values: Takes the current position and uses that as the hop position. This 

option is normally used with interactive mode in the Navigator plug-in. The user moves the 
object to the required position and sets the values for the NavFinder.

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps
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• Fly to Map: Creates an instant animation and run from the current map location to the 
current hop point defined by the NavFinder plug-in. This feature is active only if 
the Interactive Anim parameter in the Navigator plug-in is enabled (On).

• Get Map: The user can navigate manually to any destination and by pressing the Get Map 
button, the currently viewed map is used. CWMClient must be on the same container and if a 
pyramid plug-in is used, the pyramid layers are built.

• Add Linked Hop: Adds a hop (container with NavFinder set to Link) under the current 
NavFinder container. See Link tab description for more information.

Map
The Position Source Map uses the current location from the map (center of the screen values) and 
adds offsets for fine tuning.

• Fit To Screen By: Defines what the end frame of the animation (hop) is. When the hop is 
defined as a 3D Region object on the map, the animation ends when the bounding box of 
the object fills the frame. Available parameters for defining how the bounding box is 
calculated are Width, Height, Min, Max and Average.

• Width: Uses the width of the object’s bounding box to calculate the last frame of the 
hop animation.

• Height: Uses the height of the object’s bounding box to calculate the last frame of the 
hop animation.

Tip: Take Current Values can be used in interactive mode. The user can position 
itself using the mouse and then tell NavFinder to use the current values.





Viz World Plug-ins Guide - 17.0

Copyright © 2019  Vizrt                                                          Page  199

• Min: Uses the minimum value between the width and the height of the object to 
calculate the last frame of the hop animation.

• Max: Uses the maximum value between the width and the height of the object to 
calculate the last frame of the hop animation.

• Average: Uses the average value between the width and the height of the object to 
calculate the last frame of the hop animation.

• Longitude offset: Defines Longitude offset based on the current position.
• Latitude offset: Defines Latitude offset based on the current position.
• Distance offset (%): Changes the distance zoom from the map (zoom in or out).
• Pan: Sets a pan value for the camera.
• Tilt: Sets a tilt value for the camera.

Absolute
Absolute sets the Longitude and Latitude values of the hop point location. Changes the Distance 
and Distance Zoom parameters:

• Longitude: Defines the longitude for the hop position.
• Latitude: Defines the latitude for the hop position.
• Distance Offset (%): Sets an offset to the distance of the camera from the destination.
• Distance: Changes the distance from the map.

Note: Pan and Tilt parameters are disabled unless the Pan and Tilt Animation
parameter in the Navigator plug-in is enabled (On).
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• Diameter: Sets the desired view as diameter (and not distance)
• Pan: Sets a pan value for the camera.
• Tilt: Sets a tilt value for the camera.

Geometry
Geometry uses the current location from the 3D Region plug-in (center of the region values). Add 
offsets for fine tuning. See the Map and Absolute sections for descriptions of the parameters.

Link
The Link mode is used when one hop resides as a child of another hop. the child hop is set to link. 
When changing the top hop, the child hop changes accordingly, maintaining the same animation 
that was created during the design.

Note: Pan and Tilt parameters are disabled unless the Pan and Tilt Animation
parameter in the Navigator plug-in is enabled (On).



Note: Pan and Tilt parameters are disabled unless the Pan and Tilt Animation parameter in 
the Navigator plug-in is enabled (On).
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In Country and Region mode the navigator position is based on the country or region where the 
destination (link source) is, whereas in Level up mode the navigator position is one administration 
level (e.g. Place is leveled up to Town) above the destination (link source). In Country, Region and 
Level Up mode you have the following settings:

• Distance Offset: Sets an offset from the calculated distance after the top hop was changed.
• Pan Offset: Sets an offset from the calculated pan after the top hop was changed.
• Tilt Offset: Sets an offset from the calculated tilt after the top hop was changed.

Interpolation mode has the following setting:

• Interpolation:Interpolates navigator position between the gap above and below (useful for a 
drill down with a pause in the middle)
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Offset mode has the following settings:

• Longitude Offset: Sets an offset from the calculated hop longitude location after the top hop 
was changed.

• Latitude Offset: Sets an offset from the calculated hop latitude location after the top hop was 
changed.

• Min Distance/Max Distance: Sets the minimum and maximum distance from the map. Using 
the same parameters for both settings gives you a fixed distance. See the Map and Absolute 
sections for descriptions of the other parameters.
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Frame

• Source <#>:
• Source <#> Active:

4.31 Navigator

The Navigator plug-in enables the user to create realistic animations from one point to another on 
the map (for example fly over a flat map or globe). It is also used for navigating on a map (moving 
the camera) to a defined location using pan and tilt values.
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4.31.1 Navigator Properties

Camera

Position
The Position button displays the camera position parameters.

• Camera: Defines the camera that is affected by the position parameters.
• Longitude: Defines the Longitude camera position on the map/globe.
• Latitude: Defines the Latitude camera position on the map/globe.
• View: Defines the Camera’s view distance from the map.
• Pan: Defines the Camera’s pan value.
• Tilt: Defines the Camera’s tilt value.

Advanced
The Advanced button displays the advanced camera parameters.

Note: Only containers with a NavFinder plug-in are refreshed.

Note: Orthographic cameras are not currently supported by Viz World.

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps
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• Roll: Sets the roll value of the camera. This parameter is enabled only if the Keep The 
Horizon Horizontal parameter is set Off.

• Keep The Horizon Horizontal: Maintains the horizon and disables roll movement when set to 
On.

• View Units: Sets the way the number entered in the View field (see Position) is 
treated. Distance defines the number of Viz units from the camera to the map. Visible 
View is based on the view (i.e. how many km/miles and so on) you see in units defined by 
the 3D Map Setting plug-in.

• Clipping Plane Control: Defines the distance range that is drawn by the camera. Objects 
located closer to the camera than the _Near _parameter and objects located farther that the 
_Far _parameter is not drawn.

• Static (Viz): Draws the objects within the clipping plane values defined in Viz. For Viz 
2.x see Setup > Camera > Camera Clipping Plane. For Viz 3.x see Scene Settings > 
Renderer > Camera Clipping Plane.

• Navigator: Adjusts the clipping plane values according to the camera position. This is 
automatically done by the Navigator plug-in based on the Near Distance and Far 
Distance parameters.

• Near Distance (%): Defines the percentage of the camera distance from the map, which is 
used as the Near distance of the clipping plane.

• Far Distance (%): Defines the percentage of the camera distance from the map, which is used 
as the Far distance of the clipping plane.

• Navigation Method: Allows you to select whether the camera or the container should also 
move when a map changes position. 

• Camera: Moves the camera when the map is repositioned, potentially moving other 
objects out of frame. 

• Container: Moves the container instead of the camera, keeping other objects in view 
as the camera is still. In other words, moving the base map instead of the camera to 
see other parts of the map. This setting also means you do not have to use the front 
layer using two cameras to achieve the same effect as when moving the container. 
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Borders and other elements on the map can be preloaded once for the base map, but 
this can only be done with a flat map (not a globe).

• Update from Container Transformations: Updates the values (lat, long, distance) in the 
Navigator plug-in when the navigator container is moved or scaled when enabled. Used in 
interactive mode. 

Animation
The Animation button displays the camera animation parameters. There are two parameter tabs: 
Basic and Advanced.

Basic

• Number of Hop Points: Sets the number of key frames (hops) used in the animation.
• Hop Duration Mode: Defines the time gap between two key frames.

• Fixed: Uses the same duration as set in the Hop Duration parameter for all hops.
• Auto: Calculates the duration of the animation between hops automatically. minimum 

hop duration is based on the Hop Duration parameter and the Hop Min Time 
parameter.

• Manual: Disables the Hop Duration parameter. Enables the user to set hop duration 
manually in the stage editor.

• Hop Duration: Sets the animation length, between one hop to another, in seconds.
• Hop Min Duration (%): Sets a minimum time for each hop when Hop Time Mode is set to 

Auto.
• Stop Type: Defines the animation behavior at each hop.

• Disabled: Enables the animation to only use stage properties.
• Stop Points: Enables the animation to stop at each hop point and wait for a continue 

command.
• Pause Points: Adds a pause point to each hop. An additional parameter, Pause Time, is 

added to define the pause length in seconds.
• Flyover: Simulates a flight pass over the hop points in a spline path, using the Flyover 

minimum Height parameter. When selected, additional parameters are enabled.
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• Per Hop: Sets the hop stop type in the NavFinder plug-in. Different stop types can be 
set for each hop.

• Stop at First Hop: Defines whether a stop point is added to the first hop (the beginning of 
the animation). The parameter is enabled only when using Stop Points or Pause Points as the 
Stop Type value.

• Pan and Tilt Animation: Enables or disables the pan and tilt values of the camera of each hop 
in the animation. When set to On, this setting enables the Pan and Tilt values for 

the NavFinder plug-in.
• Progress Profile: Defines timing profile between stop points of animation. Smooth option 

causes the animation to ease in and out of hop points.

Basic - Flyover

• Flyover Path Profile (Stop Type is set to Flyover): Defines flying curve profile (curvature) of 
animation path.

• Lag On Point: Defines timing profile of the flyover animation (similar to Flyover Path 
Profile button).

• Flyover Min Height: Sets the minimum flyover height in centimeters.

Advanced

• Preferred Flight Height: Defines the camera height that is used in the animation between the 
hops.

• Preferred Flight Style: Defines the camera movement between the hops.
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• Zoom: Enables linear movement from hop point to the high point and back into the 
next hop point.

• Auto: Calculates the movement according to distance, height, and so on.
• Flyover: Enables a smooth movement from one hop to another.

• Preferred Landing: Defines the animation behavior when approaching the hop points.
• Helicopter: Uses a steeper approach to the hop point.
• Auto: Calculates the approach according to distance, height, and so on.
• Airplane: Uses a flatter approach to the hop point.

• Pan/Tilt Drifting (deg): Defines the amount of pan/tilt change for each cycle. The cycle is 
defined by the parameters Drifting Pan Time (Frames) and Drifting Tilt Time (Frames).

• Drifting Pan Time (frames): Defines the time to complete a full turn of the pan.
• Drifting Tilt Time (frames): Defines the time to complete a full turn of the tilt.
• Drift Phase Shift (%): Defines the offset between the pan movement and the tilt movement.
• Drifting Pause: Defines whether the drifting should stop at the start point or during stop 

points. If Never is selected, drifting does not stop.
• Flight Direction: Forces the direction of the flight. Default is the shortest route to the next 

hop. If East or West is selected, flight route is set according to the selected option.

Miscellaneous
The Miscellaneous button displays the editor view for setting interactivity and label related 
parameters.

Interactive

Note: The drifting options allow camera pan and tilt drifting during the 
animation. This option is used to give the animation movement a kind of 
satiate feeling.
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• Interactive Mode: Defines the interactive behavior of Viz. Available modes are None, Editor, 
On-Air, Always Fly To and On 'i'.

• None: Disables interactive mode.
• Editor: Enables interactive mode during scene editing.
• On Air: Enables interactive mode when Viz Engine is in On Air mode.
• Always: Enables interactive mode during scene editing and when Viz Engine is in On 

Air mode.
• Fly to: Defines destination properties. Available Fly To options in Interactive mode are 

Country, Region, Sub Region and Home. Country makes the camera animate to the 
country in which the mouse was clicked. Animation stops when the camera reaches a 
distance from the country as defined by the Extra Zoom 
Country parameter. Region makes the camera animate to the region in which the 
mouse was clicked. Animation stops when the camera reaches a distance from the 
region as defined by the Extra Zoom Region parameter. Sub Region makes the camera 
animate to the sub region in which the mouse was clicked. Animation stops when the 
camera reaches a distance from the sub region as defined by the Extra Zoom Sub 
Region parameter. Home makes the camera animate to the position defined by 
the Home Lan, Home Lat and Home Distance parameters.

• On 'i': Enables interactive mode during scene editing and when Viz Engine is in On Air 
mode, when pressing the i key while using the mouse to navigate.

• Interactive Animation: Enables user activated animation from the current map position to the 
current selected hop when set to On. This animation is triggered by the user in 

the NavFinder plug-in, by pressing the Fly To Map button. The Fly To option enables the user 
to select a point on the map, by clicking the mouse, and the animation runs from the current 
camera position to the selected point.

• Extra Zoom Country: Defines the extra zoom value added to the camera animation when 
animation destination is a country. The camera zooms in to the selected country until the 
bounding box of the country fills the render window. The extra zoom defines an additional 
zoom value to the final camera position calculations.

• Extra Zoom Region: Defines the extra zoom value added to the camera animation when 
animation destination is a region. The camera zooms in to the selected region until the 
bounding box of the region fills the render window. The extra zoom defines an additional 
zoom value to the final camera position calculations.

• Extra Zoom Sub Region: Defines the extra zoom value added to the camera animation when 
animation destination is a sub region. The camera zooms in to the selected region until the 
bounding box of the sub region fills the render window. The extra zoom defines an 
additional zoom value to the final camera position calculations.

• Home Lon: Defines a longitude value for a home point.
• Home Lat: Defines a latitude value for a home point.
• Home Distance: Defines a distance from a home point.
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Labels

• Labels: Defines the label behavior. The Labels setting overrides all labels (in all levels of the 
hierarchy) under the navigator container.

• Overlay: Places labels on a plane in front of the map (see Label It for description). 
When this mode is selected an additional parameter is enabled, Label Camera, which 
defines the camera to be used for the labels.

• On Map: Places labels on the map.
• On Map Scaling:

Advanced
The Advanced button displays additional animation parameters.

• Helicopter Lift Duration: Sets the time, in seconds, for the helicopter to go out from a hop 
point to the high point in the middle.

• Helicopter Smooth Level: Sets the animation smoothness between one hop to another. This 
parameter affects the animation path when a helicopter flight is simulated.

• Airplane Smooth Level: Sets the animation smoothness between one hop to another. This 
parameter affects the animation path when a Airplane flight is simulated.

• Tilt Smoothing: Sets the required smoothing value for the tilt animation. This parameter is 
enabled when the Pan and Tilt parameter in the animation tab is enabled. When set to On, an 

additional parameter, Tilt Smoothing Rate, is enabled. 
• Distance Mode: Defines how the camera distance from the map during the animation and at 

the hop points are calculated:



Viz World Plug-ins Guide - 17.0

Copyright © 2019  Vizrt                                                          Page  211

• Regular: Sets the distance that is calculated by the Navigator plug-in based on the hop 
locations and distance from map as set by the user.

• Fixed: Sets a fixed distance for the camera while animating between the hops and at 
the hop point. When set to fixed, User selected distance at the hop point is ignored.

• minimum: Sets the minimum distance to which the camera descends at the hop points 
and during the animation. If the calculated distance is larger than the minimum value, 
the camera uses the calculated distance.

• Boundaries: Enables you to define a minimum and maximum distance.
• Min Distance: Sets the minimum distance value.
• Max Distance: Sets the maximum distance value.
• Face North: Faces the camera towards the map’s north.
• Update Stage in On Air: Defines whether the stage jumps to the hop position when updating 

a map in On Air mode.
• World Center Mode: Offsets the world center to use the values entered instead of the center 

of the base map.
• World Center Longitude/Latitude: Sets the world center at the values provided.
• Update World Center: Updates all plug-ins when pressed after values are changed.
• Use Current Values: Takes the current values from current camera position and use 

them.

Common Buttons
• Calculate Animation: Re-builds the animation between the hops using the parameters 

defined in the plug-in.
• Center Map: Aligns the center of the map with the center of the screen.
• Refresh All Maps: Makes the Navigator plug-in search its sub-tree for containers with 

CWMClient and NavFinder and refreshes the CWMClient maps.

Known issues
• Rotation, scaling and translation above the Navigator container might affect the plug-in 

behavior. Do not apply any rotations above the container in the hierarchy and use only the 
pan/tilt parameters of the plug-in to control the orientation of the camera.

4.32 NavScale

The NavScale plug-in maintains the scale of an object, related to the screen, during 
the Navigator animation. The plug-in is placed on a child container under the Navigator plug-in, 
and it maintains the defined scaling throughout the animation.

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps
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4.32.1 NavScale Properties

• Scale on Distance Factor: Sets the value to the required number by modifying the scale 
factor and checking the result in the renderer. 

4.33 NavSlave

The NavSlave plug-in creates a relation between its container and a Navigator plug-in container in 
the scene. This plug-in locks the NavSlave container to the longitude and latitude values of 
the Navigator plug-in. The plug-in searches the hierarchy above it for the navigator container.

4.33.1 NavSlave Properties

• Altitude: Defines the altitude of the object in relation to the Navigator container.
• Tangent to Globe: Sets the object to move over the globe surface when set to On.

4.34 Place Finder

The Place Finder plug-in generates a map or map animation without having to actually select the 
map, but uses rules to define what map is generated. There are two ways of selecting a map 
location. The first is simply by entering longitude and latitude values, the second is based on 

Note: This factor does not use any measurement units, but it calculates the object’s 
scaling using a number of parameters from the Navigator plug-in.



Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps_Adv
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searching the map database for the location and using the first value (that was ranked the 
highest). Since a user cannot select the final location from a list, it is important to enter more 
information to make sure the correct location is found.

If you are looking for Paris, Texas in USA, entering Paris results in Paris, France because the 
capital of France is ranked the highest. Searching for Paris USA provides results for towns named 
Paris in the USA; however, searching for Paris TX USA or Paris Texas provides a more specific 
result.

4.34.1 Place Finder Properties

Location

• Longitude: Provides map center Longitude. Changing the value does not affect the map until 
you hit Take.

• Latitude: Provides map center Latitude. Changing the value does not affect the map until you 
hit Take.

• Long/Lat Format: Sets the format of the incoming data as either Long/Lat or Lat/Long.
• Longitude/ Latitude: Provides the map center Longitude and Latitude as one field (very 

useful for external control). Changing the value does not affect the map unless the last 
character is a semi-colon (;).

• Search: Determines the map location to search for. Click the Take button to perform the 
search.

• Frame by Search Result: Frames the location from the result of the search when set to On.

• Zoom level: Determines how the map should be framed. This option is relevant if the map 
center is based on longitude and latitude values (and not a search location), or if the Frame 
by Search Result is disabled.

• Default Size frames the map based on Default Map Size.
• Country, Admin1, Admin2 is first trying to find the relevant information (e.g. country 

and so on) and fails for example if map center is in the sea. Next it uses the bounding 

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps
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box of the user selection (please read about the Texas example in the Place 
Finder introduction section).

• If the user selects Admin2 the map’s frames are based on Lamer County which is 
Admin2 in that specific Longitude and Latitude.

• If user selects Admin1 the map’s frames are based on Texas which is Admin1 in that 
specific Longitude and Latitude.

• If user selects Country1 the map’s frames are based on USA which is the country for 
that specific Longitude and Latitude

• Map Center: Centers the map based on a point or a frame. If you search for Beijing, China, 

the map can be centered around the point identified as Beijing. This may, depending on your 
zoom level, leave parts of Beijing out of the frame. Alternatively, you can center your map 
based on the frame that captures the entire Beijing area in view.

• Default Map Size (deg): Defines a default map size for those areas that cannot be framed 
using predefined administration levels (e.g. international waters).

• Extra Zoom: Adds an extra zoom to the map in percentage (0.001-100%).

Labels

• Add Search Result Label: Adds a label based on the search result.
• Add Region Label: Adds a region label based on the selected zoom level.

• Add Event Label: Adds event based labels (e.g. floods, fire, festival). To use different 
designs, a pipe symbol (|) can be used as separator (for example, Fire|Fire in LA uses a 
design named Fire and the text is Fire in LA. Changing the value does not affect the map 
unless the last character is a semi-colon (;).

• Label Designs: Determines the location for Label designs. Normally, the plug-in resides next 
to the CWMClient plug-in and it uses its designs, or the global designs.

• Label Holder: Determines the location for Label holder. Normally, the plug-in resides next to 
the CWMClient plug-in and it uses its holders, or the global holders.

• Auto Labels Holder: Defines the location of the Automatic Labels Holder. Automatic labels 
are labels generated based on the boundaries of the map.

Note: Short only adds the location name, while  Long adds more information (e.g. 
country and so on).
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Regions

• 3DRegions: Determines whether 3D Regions are added. Relevant only when Zoom level is set 
to one of the region types (i.e. Region/Country/Admin1/Admin2/Sub_region).

• 3DRegion Designs: Determines the location for 3D Region designs. Normally, the plug-in 
resides next to CWMClient plug-in and it uses its designs, or the global designs.

• 3DRegions Holder: Determines the location for 3D Region holder. Normally, the plug-in 
resides next to CWMClient plug-in and it uses its holders, or the global holders.

Advanced

• Search: Defines which server data to search in (i.e. map data base, street data (map data 
base + street data), or Web) This works the same way as in the Classic client.

• Immediate Response
• Disabled: Needs a user action to initiate the search: Either type the term with a semi-

colon (;) at the end or press the Take button. Disabled is the default setting.
• Enabled: Changes the search so that every letter typed initiates a search.

• Status: Provides the status of the search.

4.35 Publish To Design

The Publish To Design plug-in enables updated parameters to be set directly to the design they 
came from (either container hierarchy or object pool) by pressing Publish To Design or create a 
new design out of modified data by assigning a new name under the New Design tab.
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4.35.1 Publish To Design Properties

• Publishing Target: Publishes using the original design or creates a new design.
• Design Name: Sets the new name for the new design or selects a design from the Designs 

list.
• Publish to Design: Sends the label back to where it came from, but it does not refresh the 

scene.
• Publish and Refresh: Sends the label back to where it came from and refreshes the scene.

4.36 Region To Texture

The Region To Texture plug-in simulates shadow effects for 3D Regions. This is achieved by 
creating a texture of a region’s contour. The plug-in works in two modes: By creating a single 
texture that applies to all regions in the scene or by creating multiple textures that applies to each 
individual region.

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps_Adv
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To work with a single texture, the plug-in must be placed on the Region Holder container.

 
To work with multiple textures, the plug-in must be placed on a container above the 3D 
Region container.

4.36.1 Region To Texture Properties

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps
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• Dynamic Shift: Shifts shadow texture more when Navigator is farther away. This could be 
used to better see the shadow from farther distances.

• Dynamic Shift Amount: Sets the extent of the Dynamic Shift.
• Attach to Light: Considers light direction according to the positioning of the shadow texture 

when set to On. When set to Off, Shift Direction allows you to manually set the direction of 

the shadow.
• Light ID: Sets the ID of the light to be considered.
• Texture Size: Sets the size of the shadow texture. The larger the texture, the better is the 

visible quality; however, it also requires more rendering time.
• Blur Amount: Determines the extent to which the texture is blurred to resemble the 

appearance of a shadow.
• Shift Direction: Sets the shift direction of the shadow manually and according to the region. 

This setting can only be used if the Attach To Light setting is disabled (Off).

• Shift Amount: Sets the amount of shift.

4.36.2 Working with Region to Texture

To Create a Simple Region to Texture Scene

1. Add the Map Builder plug-in to the Scene Settings.
2. Save the scene.
3. Open the Map Builder editor and click Launch Wizard. This opens the Map Builder. Note that 

it may open behind Viz Artist.
4. From the Choose Scene Type dialog box select Navigator.
5. Click the Base Map. This opens the Viz World Maps Editor.
6. Select a stylesheet for your map and click OK.
7. Click the map for Destination 01. This opens the Viz World Maps Editor.
8. Click the Browse Map button (see Map Tool Bar) and select two regions (e.g. Trentino-Alto 

Adige and Lombardia in Italy) and click OK.
9. Click Build.

10. Save the map template file to your desired location (e.g. C:\Temp\Maps). Once saved, the map 
scene is generated.
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11. For creating a single texture do the following:

a. Navigate the scene tree to the Region-Holder container found under Object > 
MapAndHops > GeoReferenceMap > Holders.

b. Add the Region to Texture plug-in to the Region-Holder container.
12. For creating multiple textures do the following:

a. Navigate the scene tree and split the Region__<name> container found under Object > 
MapAndHops > GeoReferenceMap > Holders > Region-Holder > Destination-n.

b. Add a new group as a sub-container of the Region__<name> container.
c. Add the Region to Texture plug-in to the new group container.

13. Open the Publish To Design editor and click the Publish and Refresh button.
14. To adjust the textures, split the merged region containers and adjust the settings available 

in the Region to Texture editor.

4.37 Trace It
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The Trace It plug-in places the 3D object it is attached to over a line, created with the 3D 
Line or Shape to Spline plug-in, and follows the line’s end point. The object follows the line 
animation as the object with the Trace It plug-in move with the 3D Line/Shape to Spline end point.

4.37.1 Trace It Properties

General

• Progress: Indicates the animation position of the 3D Line/Shape to Spline object. When 
using Shape to Spline, Trace It uses the ShapeToSpline field Trim End to control the 
progress. Trim Start and Trim Offset must be 0. If the data originates from a KML file, the 

progress is calculated in geographic units, otherwise viz units.
• Smooth Direction (%): Defines the object’s motion behavior when changing direction. When 

set to a low value, the direction changes faster.
• Quality: Tells the plug-in which resolution to track when tracing a border that by default has 

three levels of detail (LOD). Available options are High, Medium and Low.
• 3DLine: Defines the 3D Line/Shape to Spline container that the Trace It plug-in follows.

• Previous: Follows the animation of the 3D Line/Shape to Spline plug-in in the previous 
container.

• Above: Follows the animation of the 3D Line/Shape to Spline plug-in in the above 
container.

• Container: Follows the animation of the 3D Line/Shape to Spline plug-in in the 
container dragged to its container place holder.

• Progress Control: Defines how the object’s progress is controlled:
• None: Uses the progress ID manually created by the user (stage animation).
• Navigator: Follows the animation of the Navigator plug-in.
• Slave: Follows the source of the trace from the 3Dline plug-in.
• Master: Controls the 3D line plug-in progress, which is the source of the trace.

Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps
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Camera
The Camera tab defines the mode for camera tracking.

• Progress: Indicates the animation position of the 3D Line/Shape to Spline object.
• Trace Camera: Controls a navigator’s animation between a specified hop and the 

corresponding one, or manually driven (standalone). Available options are Off, Navigator, 
Standalone, General and Locks.

• Off: Does not trace camera animation.
• Navigator: Traces the camera animation between the selected hop and the following 

hop.
• Standalone: Traces the camera animation between the selected hop and the following 

hop.
• General: Defines the tracing parameters.

• Smooth Camera Position (%): Smoothens camera position path.
• Smooth Camera Direction (%): Smoothens camera direction path.
• Start Hop: Selects a hop in the Navigator animation. The camera trace is inserted 

between the selected hop and the next one.
• Update Hop Data: Updates data in NavFinder plug-ins where the camera trace is 

inserted (actually sets start and end values of the tracing route to insert camera trace 
smoothly to the Navigator animation).

• Locks: Enables the user to lock camera animation parameters:
• Lock Pan: Makes the camera pan to follow the path direction when set to On. When set 

Off, pan animation uses the Navigator parameters.

Note: When using Shape to Spline, no tracing is possible in non-geo mode, either 
with camera or without.
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• Pan Offset: Sets the pan offset to path directions.
• Lock Tilt:  Makes the camera tilt follow the path direction when set to On. When set 

Off, tilt animation uses the Navigator parameters.

• Tilt Offset: Sets the tilt offset to path directions.
• Lock Distance: Uses the Distance parameter value to set the camera distance from the 

map during the animation when set to On. When set to Off, the distance during the 

animation uses the Navigator parameters.
• Distance: Sets the distance to use during the animation.

Advanced

• Segmentation: Tells the Trace It plug-in what segment to track when a line is split into 
different segments (for example a region might have several islands) when tracking. 
Available options are Auto, Largest, Sectioned and All.

• Overlay: Transfers the object from a position on the actual map to a position in a different 
camera (similar to the Label It plug-in’s Overlay options).

4.38 World Position

The World Position plug-in places an object over a geographically referenced map by setting the 
Longitude, Latitude and Altitude parameters. When the object is moved over the map, the current 
values of Longitude, Latitude and Altitude are updated in the World Position plug-in. The object 
with the World Position plug-in must be placed under a map in the hierarchy.

IMPORTANT! Maximum number of line segments are 10000. Shape files that exceed 
this limit results in lines not being drawn.



Note: Shape to Spline has no button for controlling splitting dateline (whereas  3D 
Line uses  Enable World Periodicity).



Note: This plug-in is located in: Built Ins -> Container plug-ins -> Maps
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4.38.1 World Position Properties

Simple

• Longitude: Sets the parameter to the requested longitude. The object moves over the map to 
the requested location. Another option is to move the object and read its longitude value 
from this field.

• Latitude: Sets the parameter to the requested latitude. The object moves over the map to the 
requested location. Another option is to move the object and read its latitude value from this 
field.

• Altitude Units: Selects the units that the altitude parameter uses.
• Altitude: Sets the parameter to the requested altitude. The object moves over the map to the 

requested location. Another option is to move the object and read its altitude value from this 
field.

• Move to Map Center: Moves the object to the center of the parent map when clicked.
• Update Lat/Long From Container Position: Updates the latitude and longitude position 

parameters when clicked.

Advanced
In addition to the fields in the Simple tab, the Advanced tab has the following fields:



Viz World Plug-ins Guide - 17.0

Copyright © 2019  Vizrt                                                          Page  224

• Tangent to Globe: Keeps the object parallel to the globe surface when set to On. The 

parameter is enabled when the World Position plug-in is placed in a child container of a 
container with a Globe plug-in.

• Update Long/Lat from Position: Gets the current container location and updates the 
longitude, latitude and altitude parameters:

• Auto: Updates the longitude and latitude values once when a new position is dragged 
over the container and never again.

• Never: Updates the longitude and latitude values, but never updates the object's 
position.

• Always: Updates the World Position when it changes and always checks the object's 
position.

• Follow Terrain: Reads the height (Altitude) from the terrain in case of a terrain geometry.
• Longitude/Latitude: Determines the position in degrees:minutes:seconds format.
• Long/Lat Format (Long/Lat)(Lat/Long): Sets the format of incoming data.
• Lat/Long (+/-dd:mm:ss.xx): Sets both latitude and longitude values in a single string.
• Offset/Fine Tuning

• Longitude/Latitude Offset: Positions the object at a given offset from the actual 
longitude/latitude when Offset is selected. 

• Longitude/Latitude Seconds: Provides fine tuning values in seconds when Fine 
Tuning is selected.
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5 Scene Plug-Ins
This chapter describes all scene plug-ins. The container plug-ins are found in five plug-in folders:

• Maps: Contains standard plug-ins.
• Maps-Adv: Contains advanced plug-ins.

See the following sections for more information:

• 3D Map Setting
• Label Manager
• Light On Globe
• Map Builder
• Traffic Manager

5.1 3D Map Setting

The 3D Map Setting plug-in manages border data from the server. The border data is retrieved 
from the Viz World Server (WoS), according to the setting in the 3D Map Setting plug-in, and is 
used for applying a graphic design to the borders in the map, drawn by the 2D Label plug-ins.

This section contains information on the 3D Map Setting plug-in properties:

• 3D Map Setting Properties
• General
• Border Data
• Window
• GUI
• Advanced

• Buttons

Note: This plug-in is located in: Built Ins -> Scene plug-ins -> Maps
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5.1.1 3D Map Setting Properties

General

• Geographic Container: Draws the border of the selected map. Drag the CWMClient container 
that defines the map area to the container place holder.

• 3D Global Designs Path: Sets the path to a Viz folder containing the global designs.
• 3D Global Designs: Holds the place for global designs container.
• 3D Global Holder: Defines the container that holds all the global 3D objects created from the 

global designs.
• On Screen Global Holder: Defines the container that holds all of the on-screen global 3D 

objects created from the global designs.
• Units: Defines the type of units used to measure how many degrees, kilometers, miles or 

nautical miles are seen. The selection made here affects Navigator’s Height Units setting and 
the label appearance Units in the Label Manager plug-in (see Definitions section).



Viz World Plug-ins Guide - 17.0

Copyright © 2019  Vizrt                                                          Page  227

Border Data

• World: Defines whether the border data is fetched for the entire world (country borders) or 
other data as defined in the Additional Region Data parameter.

• None: Retrieves the border data as defined in the Additional Region Data parameter.
• Full: Retrieves the country borders data for the entire world (country borders only).

• Additional Region Data: Defines additional border data that is retrieved from the server with 
the data defined in the World parameter. The additional data is limited to the selected region 
in the Region List parameter. This parameter cannot be changed without an instance of Viz 
World Server (WoS).

• None: Does not use additional data.
• Country: Uses country border data in the selected region.
• Region: Uses region border data in the selected region.
• Sub Region: Uses sub-region border data in the selected region.

• Region List: Defines an area of the world for which the additional region data is retrieved 
from the server. The parameter limits the data size retrieved from the server.

• Country Borders: Creates country borders for the selected region in the region list property.
• Rebuild: Retrieves the information from the Viz World Server (WoS).
• Rebuild (Force New): Recreates the data on the Viz World Server (WoS) and saves it to the 

cache folder, even if cached data already exists.
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Window

• Window Active: Enables user definition of an area in the renderer as an active window. All 
maps data created by the Viz World Client is redrawn to fit into the defined window. When 
set to On additional parameters are enabled:

• Effect Culling: Defines whether the window affects the culling of the vector data (streets, 
borders, etc.).

• Effect Position: Offsets the map either by (1) Using the window width and height and window 
center X and Y properties, or (2) By turning On container mode and dragging a container to 

the Window Container parameter, which is used to track the size and position for offsetting 
the map camera.

• Window Mode: Defines the source of the window aspect: Manual sets the window aspect to 
be user defined, Camera sets the window aspect to be the same as the render window, and 
Image sets the window aspect to be the same as the image aspect of the map.

• Window Units: Defines the units used to set the window size and position. When set to 
Percents, the window size is calculated as the defined percentage of the Viz render window 
size. The window position is calculated as the defined offset percentage of the render 
window.

• Window Container: Allows tracking a container from the scene tree that affects the size and 
position of the window.

• Window Width: Defines the width of the window in percents or pixels.
• Window Height: Defines the height of the window in percents or pixels. This parameter is 

enabled only if window mode is set to Manual.
• Window Center Offset X: Defines the X position (percents or pixels) of the window in relation 

to the render window (center to center).
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• Window Center Offset Y: Defines the Y position (percents or pixels) of the window in relation 
to the render window (center to center).

• Control Win Mask: Defines whether a WindowMask plug-in (added to the map) is controlled 
by the 3D Map Settings plug-in to mask the defined window.

• Window Mask Scale: Defines the scale of the mask over the defined window.
• Show Debug Window Mask: Displays a red rectangle around the defined window when set to 

On.

GUI
GUI defines general parameters for controlling container names and container colors in the Viz GUI 
(effecting the Viz scene tree display), and the creation of Control Channels from added Viz World 
Client objects. The Control Channels in Viz are displayed under the Control tab and serve as an 
index for the scene tree. For additional information about Control Channels please refer to the Viz 
Artist User Guide.

• Hops: Defines GUI parameters for hop containers in the scene tree:
• None: Does not apply control channel or name conversion to the hop containers.
• Control: Adds only a control channel for the hop containers.
• Name: Names the created hop containers Hop-1, Hop-2, etc., according to the hop 

point selected in the NavFinder plug-in. No control channel is added.
• Full: Adds a control channel for every hop container and the hop containers are 

renamed Hop1, Hop2, etc.
• Designs: Defines GUI parameters for any design containers (region designs, road designs, 

label designs, and so on) in the scene tree:
• None: Does not apply control channel or name conversion to the design containers.
• Control: Adds only a control channel for the design containers used in the scene. The 

containers are not renamed.
• Name: Renames the design containers (dragged to the CWMClient plug-in) Label-

Designs, Region-Designs, and so on. No control channel is added.
• Full: Adds a control channel for every design container and the design containers are 

renamed.
• Holders: Defines GUI parameters for any object holder containers (regions, roads, labels , 

and so on) in the scene tree:

http://docs.vizrt.com/viz-artist
http://docs.vizrt.com/viz-artist
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• None: Does not apply control channel or name conversion to the holder containers.
• Control: Adds only a control channel for the holder containers used in the scene. The 

containers are not renamed.
• Name: Renames the holder containers (dragged to the CWMClient plug-in) Label-

Holder, Region-Holder, and so on. No control channel is added. If the holder container 
is dragged to a hop CWMClient, it is suffixed indicating the hop number: Label-Holder-
H1, Label-Holder-H2, and so on.

• Full: Adds a control channel for every design container and the Holder containers are 
renamed.

• Hops Color: Sets the color index, as defined in the User Interface parameter in Viz Config 
(Viz 3 only) that is used for the Hop containers in the scene tree.

• Design Color: Sets the color index, as defined in the User Interface parameter in Viz Config 
(Viz 3 only) that is used for the design containers in the scene tree.

• Holder Color: Sets the color index, as defined in the User Interface parameter in Viz Config 
(Viz 3 only) that is used for the generated objects holder container in the scene tree.

Advanced

• Culling Threshold: Sets the size of polygons to be culled (not rendered). It is generally better 
to cull small polygons, as they may not look good when rendered.

• Polygon Quality: Defines the quality of the drawn border lines. The higher the quality, the 
smoother the line is.

• Polygon Quality Factor (%): Enables the user to change the automatic polygon quality levels 
by setting a factor that changes the border quality. Values under 100% decrease the quality of 

the lines. Values above 100% increase the quality of the lines.
• Language: Allows the user to set the language of labels for the scene. 

5.1.2 Buttons
• Reset Design Holders: Cleans up all design holders (labels, regions, borders and so on).

Tip: For more information about Viz Config and its configuration options, see the Viz 
Engine Administrator Guide.



http://docs.vizrt.com/viz-engine
http://docs.vizrt.com/viz-engine
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• Update Project List: Updates the list of Viz World map projects available to the designer. By 
default, Viz Artist always checks the Viz World Server for a list of projects and if a a scene is 
opened and its project does not exist an error message is displayed. However, if a project is 
added after Viz Artist is started you can click the Update Project List button in order to 
update Viz Artist and to avoid the error message.

• Update All Map Elements: Checks all map elements in the scene (CWMClients, Place Finder
and so on) and refresh them.

• Sync Local Cache Folders: Synchronizes the local cache folder with the primary cache folder. 
• Start Logging: Logs all map related activities into a file.
• End Logging: Saves the log file under C:\Program Files (x86)\vizrt\Common\Maps\logs.

5.2 Label Manager

The Label Manager plug-in retrieves label information from Viz World Server and control the label’s 
appearance when working in an automatic label mode. The Label Manager generates labels, based 
on the defined label designs, according to parameters defined in the Navigator plug-in, Label 
It objects and 2D Label objects in the label designs.

For the Label Manager to resolve conflicts, it needs different presets to work with. The more 
presets and the bigger difference between them, the better chance overlaps are resolved. When 
working with Label Manager, pay attention to and check all presets it uses to make sure that they 
are acceptable for the plug-in. Do not create a preset where the label is under the marker if you do 
not want to see it. Labels without markers (e.g. country) can have presets as well, which means 
their position can change slightly.

Label Manger basically has two ways of detecting conflicts:

1. Based on the marker (zero size) labels (bounding box) and the line between them. You set 
this for the 2DLabel (see Special section, Collision Mode = Tip Based) and when used with 
good and different presets it solves almost any problem, but if a you have a big marker 
there is always a chance of a marker overlap.

2. Based on the bounding box, the entire (square) bounding box is calculated and used. In this 
case, there is less chance of resolving conflicts, but it has no overlaps.

This section contains information on the Label Manager plug-in properties:

• Label Manager Properties
• Map Data
• Auto Labels
• Definitions
• Shadows

Note: This plug-in is located in: Built Ins -> Scene plug-ins -> Maps
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5.2.1 Label Manager Properties

Map Data
The Map Data tab defines settings for the label types received from the Viz World Server (WoS). 
These settings are used when calculating label appearance in automatic mode. For every type of 
label selected in the list, set the required parameters.

• Type: Sets the type of labels data to display.
• Start View: Defines the map size from which the labels of the selected type appears during 

the Navigator animation. Parameter units are defined in the Definitions tab’s Units
parameter.

• Life Span: Defines the duration of the label appearance on screen. Note that this setting is 
most useful for country and region types.

• Full: Displays the label at the defined Start View and remains on screen throughout the 
entire animation.

• Long: Displays the label on screen for a long period of time.
• Regular: Displays the label on screen for a medium period of time.
• Short: Displays the label on screen for a short period of time.
• Manual: Displays the label on screen until the defined End View value is reached.

• End View: Defines the map size at which the labels of the selected type disappears. This 
parameter is only enabled if the Life Span is set to Manual. Parameter units are defined in 
the Definitions tab’s Units parameter.
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Auto Labels
The Auto Labels tab defines whether automatic labeling is enabled and the label designs used for 
automatic labeling.

Auto Labels can be limited to specified countries and/or regions. The format of valid input is:

• A semi-colon (;) between locations.
• A backslash (/) or slash (\) to specify the path to the regions.

Some examples:

• USA;Mexico
• USA\TX;Mexico;Canada
• United States of America\Florida;United States of America\Georgia;USA\NY

• Auto Labels: Sets the auto labels mode to disabled, enabled or interactive.
• Disabled: Does not use automatic labeling in the scene.
• Enabled: Uses automatic labeling in the scene based on the defined designs and labels 

holder container.
• Interactive: Enables the Auto Labels Quantity.

• Auto Labels Quantity: Allows you to set the amount of labels that should be shown. Few 
show approximately 75 labels (or less), Average 100 labels (or less) and Many 150 labels (or 
less). Manual sets the distance where the labels should appear (see Start View under Map 

Note: The Label Manager plug-in controls and manages the automatic labels 
appearance, using various parameters from different plug-ins. The Life span and 
Auto Label parameters vary between labels during the animation (hop), to optimize 
labels display.



Note: Abbreviations can be used (after defining such list in the WoS)
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Data) providing a consistent behavior (e.g. Town 1K always appears/disappears at the same 
distance).

• Manual Labels: Defines whether manual labels, defined for the map, are displayed with the 
auto labels. When Enabled is set, the Select Manual Labels button appear at the bottom of 
the editor. When clicked, WME opens, enabling the user to set manual labels.

• Road Labels: Defines the level (number) of road labels that are displayed. Select the required 
option, ranging from 0-None to 5-All.

• Street Labels Style: Defines the label style of the scene. Options are Viz Design and Internal 
(Open GL) labels.

• Viz Design: Allows user definition of Viz labels. Note that this limits the number of 
labels that can be used in Viz. Depending on your system, 300-500 labels may cause 
Viz Engine to not render in real time. Using Viz Design also gives the option to set 
other parameters such as the visibility of the label and local and global placeholders 
for the label design (see 3D Designs & Holder).

• Internal (Open GL): Allows using up to 100.000 labels; however, this limits design 
options to the font used and relative position and scale. When used with the Street 
Labels plug-in, this setting only works for Navigator scenes.

• Labels Visibility (%): Used when calculating size of street labels for the final map.
• Gap for Same Street Name (%): Used when calculating the minimum distance between two 

street labels of the same name.
• 3D Designs and Holder:

• Designs (text field): Defines a path in Viz’s objects database that contains label 
designs. Automatic label designs are based on 2D Label and Label It plug-ins.

• Designs (place holder): Displays the selected (drag and drop) top container holding 
the label designs.

• Holder (place holder): Displays the selected (drag and drop) container that resides 
under the map. This container is used by the Label Manager plug-in to store the 
scene’s generated labels.

• Limit Auto Labels: Defines whether the auto labels are limited to a defined region/s or not. 
When enabled, the Limit To Region text field is enabled.

• Limit to Region: Defines the region to which the auto labels are generated.

Definitions
The Definitions tab is used to set general parameters for Label Manager behavior.
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• Intersection Mode:
• Full: Selects the best preset for each label and when labels intersect, one of them is 

turned off.
• Offsets: Selects the best preset for each label.
• None: Creates auto labels only. No intersections are calculated.

• Screen Culling Mode: Defines whether a label is drawn when it is outside the Viz renderer’s 
scope/view.

• Center: Fades out the label object when the center of the object is outside the Viz 
renderer’s scope/view.

• Anything: Fades out the label object when any part of the object is outside the Viz 
renderer’s scope/view.

• Complete: Fades out the label object when the entire object is outside the Viz 
renderer’s scope/view.

• None: Does not use culling. The labels are drawn according to the map data 
parameters only.

• Map Culling Mode: Defines whether a label is drawn when it is outside the map area but 
inside Viz renderer’s scope/view.

• User Labels Ignore Distance Rules: Ignores the distance rules that apply to labels associated 
with a hop when enabled.

• Intersection Distance: Determines the distance to be used when calculating the best label 
setup to be used to avoid collision:

• Max distance: Calculates labels at the max distance defined for the label type.
• Distance: Uses the final hop position.
• 2/4/8* Distance: Uses the hop position area multiplied by the selected value.

• Scene Type: Determines which algorithm to use for a scene. Label Manager uses different 
algorithms for an interactive scene or a regular one. User should declare the scene type to 
get best results.

• Units: Defines the units used to calculate map size for the Start View and End View 
parameters. Available options are Degrees, Kilometers, Miles and Nautical Miles, where the 
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default measurement unit is Kilometer. Note that this setting is also affected by the Units 
option in the 3D Map Setting plug-in (see General).

• Fade Time (fields): Defines the label’s fade duration in fields.
• Labels Draw Style: Determines where labels are drawn.

• On map: Draws on the map layer.
• Overlay: Draws on a different layer (dynamic image/layer).
• On map scaling: Draws on the map layer, but maintains the same size (avoid NavScale 

plug-in).
• Label Camera: Defines the camera that is used to draw the labels (normally camera two).
• Debug Info Mode: Shows different levels of debug information regarding the auto layout.

Shadows

• Cast Shadows: Turns option to cast label shadows on/off.
• Light Type: Simulates different light types to cast the shadows.
• Horizontal Angle: Defines the horizontal angle position of the light.
• Vertical Angle: Defines the vertical angle position of the light.
• Distance: Defines light distance.
• Shadow Plane: Casts planar shadows on an imaginary plane and this option defines the 

spatial rotation of such a plane. Select one of the options:
• Straight: Casts the plane parallel to the screen.
• Up Tilt: Tilts the casted plane 45 degrees up from the screen.
• Down Tilt: Tilts the casted plane 45 degrees down from the screen.
• Manual: Allows the pan and tilt values of the casted plane to be set manually.
• World: Casts the plane tangent to the world.

• Tangent Point: Sets the pivot point for connection shadow to the object.
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• Shadow Pan: Determines a manual Shadow Pan.
• Shadow Tilt: Determines a manual Shadow Tilt.
• Shadow Distance: Determines the distance of the shadow plane from the object.
• Shadows Camera: Selects a camera for rendering the shadows. Since shadows are done by 

first rendering objects in a distant place and then overlaying their black silhouettes on the 
screen, this option defines the camera that looks at such distant place where objects are 
rendered. (Actually this camera is used for overlay).

• Show Light Direction: Visualizes light direction on screen. The light direction is visualized by 
showing a lit ball or an arrow.

5.3 Light On Globe

The Light On Globe plug-in applies light sources to a globe object. The plug-in is required when 
designing a hops scene and the animation is going from the lighted area of the globe to the dark 
area of the globe. When using the Light On Globe plug-in, the lights follow the camera animation. 
The light sources are Viz lights, and the lighting parameters should be adjusted in the Viz light 
editor. The Light On Globe plug-in locks the light sources to the selected camera in the plug-in 
parameters.

Note: This plug-in is located in: Built Ins -> Scene plug-ins -> Maps
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5.3.1 Light On Globe Properties

• Camera: Sets the camera number for setting the light sources. The light sources are locked 
to the selected camera number.

• Key Light Type: Sets the main light source type. Available types are Local, Spot, Infinite or 
None.

• Key Light Angle: Sets the angle of the key light source, which is the longitude value for the 
center of the light projected on the globe.

• Key Light Elevation: Sets the elevation of the key light source, which is the latitude value for 
the center of the light projected on the globe.

• Distance Scale: Sets a scale value on the globe distance so the light can be closer or further 
away.

• Attenuation: Sets the level of light attenuation.
• Back Light Type: Sets the back light source type. Available types are Local, Spot, Infinite or 

None.
• Back Light Angle: Sets the angle of the back light source, which is the longitude value for the 

center of the light projected on the globe.
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• Back Light Elevation: Sets the elevation of the back light source, which is the latitude value 
for the center of the light projected on the globe.

• Distance Scale: Sets a scale value on the globe distance so the light can be closer or further 
away.

• Fill Light Type: Sets the fill light source type. Available types are Local, Spot, Infinite or None.
• Fill Light Angle: Sets the angle of the fill light source, which is the longitude value for the 

center of the light projected on the globe.
• Fill Light Elevation: Sets the elevation of the fill light source, which is the latitude value for 

the center of the light projected on the globe.
• Distance Scale: Sets a scale value on the globe distance so the light can be closer or further 

away.
• Camera Light Type: Sets the camera light source type. Available types are Local, Spot, 

Infinite or Off. The camera light follows the camera movements.
• Camera Light Horizontal Shift: Sets the horizontal shift of the light source in relation to the 

camera location.
• Camera Light Vertical Shift: Sets the vertical shift of the light source in relation to the camera 

location.
• Toggle Mode: Sets the lights behavior mode during camera movement:

• Static: All light sources, except for the camera light, remain in a fixed location in 
relation to the globe.

• Dynamic: All light sources maintain a fixed location in relation to the defined camera 
(that is it moves with the camera).

5.4 Map Builder

The Map Builder plug-in builds a scene from a map template (*.mtpl) file, and saves the map scene 
changes to the map template file.

5.4.1 Map Builder Properties

Note: This plug-in is located in: Built Ins -> Scene plug-ins -> Maps
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• Map Template Filename: Sets the name of the scene template file or click the browse (...) 
button to select a file.

• Rebuild Scene: Updates the scene tree with changes from the Map Builder.
• Launch Wizard: Runs the Map Builder application.
• Clean Scene: Cleans the scene hierarchy.
• Build Scene from Scratch: Cleans the scene tree and rebuilds the scene hierarchy using the 

defined map template file.

5.5 Traffic Manager

The Traffic Manager plug-in connects to DataHub for traffic flow and routing information.

5.5.1 Traffic Manager Properties

• DataHub Host: Sets the hostname of the DataHub to use.
• DataHub Port: Sets the port number to use.
• Source Name: Defines the name of the source.
• Update from DataHub: Updates from DataHub.
• Flow Data: Defines the location of the traffic flow data.
• Flow and Routing Shape File: Defines the location of the traffic flow and routing shape file.
• Build Flows Data and Update Flows: Builds flows data and updates traffic flows (calls 3D Line 

Manager).
• Update Flows: Updates the traffic flows.

Note: This plug-in is located in: Built Ins -> Scene plug-ins -> Maps_Adv
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6 Shader Plug-Ins
This chapter describes shader plug-ins. The shader plug-ins are found in two plug-in folders:

• Default: Contains the Rebound plug-in.
• Maps: Contains standard plug-ins.
• Maps-Adv: Contains advanced plug-ins.
• Maps-Lab: Contains experimental plug-ins. Since these plug-ins are experimental and not 

supported, they are not documented here.
• Maps-Obs: Contains obsolete plug-ins, installed only for backward compatibility. These plug-

ins should not be used when designing new scenes. Since these plug-ins are obsolete and 
not supported, they are not documented here.

• Texture: Contains the FadeTexture plug-in.

See the following sections for more information:

• 3D Line Shader
• C3D Terrain Shader
• FadeTexture
• GeoChart Shader
• Rebound

6.1 3D Line Shader

The 3D Line Shader plug-in is used by the 3D Map Setting plug-in to draw the borders using the 
parameters set in the various 2D Label plug-ins. It is added automatically when adding a 2D 
Label object to the scene tree.

6.1.1 3D Line Shader Properties

This plug-in has no parameters.

6.2 C3D Terrain Shader

The C3D Terrain Shader plug-in is added automatically when using the Atlas plug-in.

Note: This plug-in is located in: Built Ins -> Shader plug-ins -> Maps
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6.2.1 C3D Terrain Shader Properties

This plug-in has no parameters.

6.3 FadeTexture

The FadeTexture plug-in applies soft edges to a texture and to crops the texture.

6.3.1 FadeTexture Properties

• Curve: The plugin has three plug-in editor views that enable different curve control options.
• Constant: Controls texture edges separately, but no softness is applied to the texture 

edges.
• Crop Top: Sets the crop value for the top of the texture.
• Crop Bottom: Sets the crop value for the bottom of the texture.
• Crop Left: Sets the crop value from the left of the texture.
• Crop Right: Sets the crop value for the right of the texture.

• Spline: Controls texture edges separately and a common softness value is applied to 
all edges. Spline has the same parameters as Constant.

• Fade: Sets the softness value for the edges of the texture.
• Uniform: Controls all texture edges together with a fixed softness value applied.

• Uniform Crop: Sets the crop value for all edges of the texture (fixed softness is added 
to all edges).

Note: This plug-in is located in: Built Ins -> Shader plug-ins -> Maps

Note: This plug-in is located in: Built Ins -> Shader plug-ins -> Texture

Note: If an edge is not cropped, the softness affects the edge.
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6.4 GeoChart Shader

The GeoChart Shader plug-in is the shader for the GeoChart plug-in.

6.4.1 GeoChart Shader Properties

This plug-in has no user interface.

6.5 Rebound

The Rebound Shader plug-in stops shader inheritance. By default, all shader behavior is shared by 
all siblings of the container where the shader resides. The Rebound shader stops this inheritance. 
It should be placed below the shader you would like to avoid inheriting from.

6.5.1 Rebound Properties

This plug-in has no user interface.

Note: This plug-in is located in: Built Ins -> Shader plug-ins -> Maps_Adv

Note: This plug-in is located in: Built Ins -> Shader plug-ins -> Default
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